PrintSmith™ Vision
User Guide

2 ⚫ EFI Productivity Suite | PrintSmith Vision User Guide

Copyright © 1997 - 2019 by Electronics for Imaging, Inc. All Rights Reserved.
EFI PrintSmith Vision User Guide
October 2019 Version 4.5.0
Document Version 1.0
This publication is protected by copyright, and all rights are reserved. No part of it may be reproduced or transmitted in
any form or by any means for any purpose without express prior written consent from Electronics for Imaging, Inc .
Information in this document is subject to change without notice and does not represent a commitment on the part of
Electronics for Imaging, Inc.
Patents
This product may be covered by one or more of the following U.S. Patents: 4,716,978, 4,828,056, 4,917,488, 4,941,038,
5,109,241, 5,170,182, 5,212,546, 5,260,878, 5,276,490, 5,278,599, 5,335,040, 5,343,311, 5,398,107, 5,424,754,
5,442,429, 5,459,560, 5,467,446, 5,506,946, 5,517,334, 5,537,516, 5,543,940, 5,553,200, 5,563,689, 5,565,960,
5,583,623, 5,596,416, 5,615,314, 5,619,624, 5,625,712, 5,640,228, 5,666,436, 5,745,657, 5,760,913, 5,799,232,
5,818,645, 5,835,788, 5,859,711, 5,867,179, 5,940,186, 5,959,867, 5,970,174, 5,982,937, 5,995,724, 6,002,795,
6,025,922, 6,035,103, 6,041,200, 6,065,041, 6,112,665, 6,116,707, 6,122,407, 6,134,018, 6,141,120, 6,166,821,
6,173,286, 6,185,335, 6,201,614, 6,215,562, 6,219,155, 6,219,659, 6,222,641, 6,224,048, 6,225,974, 6,226,419,
6,238,105, 6,239,895, 6,256,108, 6,269,190, 6,271,937, 6,278,901, 6,279,009, 6,289,122, 6,292,270, 6,299,063,
6,310,697, 6,321,133, 6,327,047, 6,327,050, 6,327,052, 6,330,071, 6,330,363, 6,331,899, 6,340,975, 6,341,017,
6,341,018, 6,341,307, 6,347,256, 6,348,978, 6,356,359, 6,366,918, 6,369,895, 6,381,036, 6,400,443, 6,429,949,
6,449,393, 6,476,927, 6,490,696, 6,501,565, 6,519,053, 6,539,323, 6,543,871, 6,546,364, 6,549,294, 6,549,300,
6,550,991, 6,552,815, 6,559,958, 6,572,293, 6,590,676, 6,606,165, 6,633,396, 6,636,326, 6,643,317, 6,647,149,
6,657,741, 6,662,199, 6,678,068, 6,707,563, 6,741,262, 6,748,471, 6,753,845, 6,757,436, 6,757,440, 6,778,700,
6,781,596, 6,816,276, 6,825,943, 6,832,865, 6,836,342, RE33,973, RE36,947, D341,131, D406,117, D416,550,
D417,864, D419,185, D426,206, D439,851, D444,793.
Trademarks
The APPS logo, AutoCal, Auto-Count, Balance, Best, the Best logo, BESTColor, BioVu, BioWare, ColorPASS,
Colorproof, ColorWise, Command WorkStation, CopyNet, Cretachrom, Cretaprint, the Cretaprint logo, Cretaprinter,
Cretaroller, DockNet, Market Direct StoreFront, DirectSmile, DocBuilder, DocBuilder Pro, DocStream, MDSFdesign
Studio, Dynamic Wedge, EDOX, EFI, the EFI logo, Electronics For Imaging, Entrac, EPCount, EPPhoto, EPRegister,
EPStatus, Estimate, ExpressPay, Fabrivu, Fast-4, Fiery, the Fiery logo, Fiery Driven, the Fiery Driven logo, Fiery
JobFlow, Fiery JobMaster, Fiery Link, Fiery Prints, the Fiery Prints logo, Fiery Spark, FreeForm, Hagen, Inktensity,
Inkware, Jetrion, the Jetrion logo, LapNet, Logic, MiniNet, Monarch, MicroPress, OneFlow, Pace, PhotoXposure,
PressVu, Printcafe, PrinterSite, PrintFlow, PrintMe, the PrintMe logo, PrintSmith, PrintSmith Site, Printstream, Print to
Win, Prograph, PSI, PSI Flexo, Radius, Rastek, the Rastek logo, Remoteproof, RIPChips, RIP-While-Print,
Screenproof, SendMe, Sincrolor, Splash, Spot-On, TrackNet, UltraPress, UltraTex, UltraVu, UV Series 50, VisualCal,
VUTEk, the VUTEk logo, and WebTools are trademarks of Electronics For Imaging, Inc. and/or its wholly owned
subsidiaries in the U.S. and/or certain other countries.
All other terms and product names may be trademarks or registered trademarks of their respective owners and are
hereby acknowledged.

Table of Contents | ⚫ 3

Table of Contents
Introduction ........................................................................................................................ 9
What is new in this release ............................................................................................................. 9
About PrintSmith Vision ................................................................................................................. 9
About Estimates and Invoices ........................................................................................................ 9
About Estimating History .............................................................................................................. 10
About Cash Register ..................................................................................................................... 10
About Post Payments ................................................................................................................... 10
About Journal Entries ................................................................................................................... 10
About Register Tape ..................................................................................................................... 11
About Closeout ............................................................................................................................. 11
About Pending Documents........................................................................................................... 11
About Web Product Templates ..................................................................................................... 11
About Purchase Orders and PO History ...................................................................................... 11
About Quick Access Panel ........................................................................................................... 12
About Work in Progress................................................................................................................ 12
About Accounts............................................................................................................................. 12
About Contacts ............................................................................................................................. 12
About Account History.................................................................................................................. 12
About Stock import ....................................................................................................................... 12
About Stock Definitions ................................................................................................................ 12
PrintSmith Vision: EFI-Hosted vs. Customer-Hosted .................................................................. 13
EFI-hosted ................................................................................................................................ 13
Customer-hosted ...................................................................................................................... 13

Contact Information ........................................................................................................ 14
System Requirements .................................................................................................... 14
PrintSmith Vision Basics .............................................................................................................. 15
How PrintSmith Vision Works .................................................................................................... 15
Keyboard Shortcuts................................................................................................................... 15
Searching ................................................................................................................................. 16
Navigation ................................................................................................................................. 16
Template List ............................................................................................................................ 20
Template Category.................................................................................................................... 20
Web Product Templates ............................................................................................................ 21
Email Templates ....................................................................................................................... 23
Customize e-mails..................................................................................................................... 24
Table Editor > Vendor ............................................................................................................... 26
Table Editor > Reasons ............................................................................................................. 27
Preferences > CardConnect® Setup and Credit Card manager ................................................. 27
Stock and Sizes ........................................................................................................................ 27
Logging in to PrintSmith Vision .................................................................................................. 27

Defining Sales Tax or Value Added Tax ....................................................................... 29

4 ⚫ EFI Productivity Suite | PrintSmith Vision User Guide

About Taxes in PrintSmith Vision ................................................................................. 29
Default tax table ............................................................................................................................ 29
Product-level taxation ................................................................................................................... 29
Line-item taxation.......................................................................................................................... 29

Setting Up the Default Sales Tax Table ........................................................................ 29
Editing Tax Tables......................................................................................................................... 34
Using Tax Codes to Differentiate the Same Tax Rate .................................................................. 35
Tax Exemptions............................................................................................................................. 35
Including More Than One Tax Element on a Document .............................................................. 36
Hiding Taxes in Prices .................................................................................................................. 36
Using Product-Level Taxation ...................................................................................................... 36
Setting up product-level taxation ............................................................................................... 37
Taking advantage of product-level taxation ................................................................................ 37
Line item taxation ...................................................................................................................... 38
Enabling line-item taxation ........................................................................................................ 38
Taking advantage of line-item taxation ...................................................................................... 38
Hide Line Item tax on Invoice Summary .................................................................................... 39

Quick Access Panel ........................................................................................................ 40
Getting Ready to Use the Quick Access Panel ............................................................................ 42
Set your Quick Access Panel preferences ................................................................................. 42
Understand the Taken by field ................................................................................................... 43
About the Quick Access Panel Contents.................................................................................... 43

Estimating ........................................................................................................................ 48
Creating Estimates .......................................................................................................... 48
Create New Job (Job Methods)..................................................................................................... 50
Printing Job............................................................................................................................... 50
Roll-fed Job............................................................................................................................... 63
B&W or Color Digital Job ........................................................................................................... 64
Large Format Job...................................................................................................................... 66
Charges Only Job ..................................................................................................................... 67
Job for Blank Stock ................................................................................................................... 67
List Based Job .......................................................................................................................... 68
Outside Service Job .................................................................................................................. 71
Merchandise Job....................................................................................................................... 72
Multi Part Job ............................................................................................................................ 73
Free Style Job ........................................................................................................................... 74
Create Job from Account History ................................................................................................. 74
Create Job from Templates........................................................................................................... 75
Account information ..................................................................................................................... 77
Account Status and Type .......................................................................................................... 77
Invoice and Delivery Address .................................................................................................... 77
Internal Information ................................................................................................................... 79
Missing Information Warning ..................................................................................................... 80

Table of Contents | ⚫ 5

Estimate Summary .......................................................................................................... 80
Adding Free Style Items, Jobs or Charges to an Estimate .......................................................... 80
Add Free Style Item .................................................................................................................. 80
Add job ..................................................................................................................................... 81
Add Charges ............................................................................................................................. 81
Create Account from a Document.............................................................................................. 82
Save as a Template .................................................................................................................. 82
Copy to a new estimate ............................................................................................................. 83
Email Estimate .......................................................................................................................... 83
Estimating Notes ....................................................................................................................... 83
Print Estimate ........................................................................................................................... 84
Change Account ....................................................................................................................... 84
Special Instructions ................................................................................................................... 85
Sales Categories....................................................................................................................... 85
Dates ........................................................................................................................................ 86
Price Information ....................................................................................................................... 86
Command line option ................................................................................................................ 88
Specifying multiple quantities with different job specifications .................................................... 88
Cost Tab ........................................................................................................................................ 90
Entering actual costs ................................................................................................................. 90
Saving an estimate.................................................................................................................... 91

Invoicing ........................................................................................................................... 92
Creating Invoices ............................................................................................................ 92
Invoice Summary ............................................................................................................. 92
Copying purchase orders when copying invoices....................................................................... 92
Raise a PO ..................................................................................................................................... 93
Tax ........................................................................................................................................... 95
Invoice Notes................................................................................................................................. 97
Email Invoice ................................................................................................................................. 97
Print job Ticket for invoice. ........................................................................................................... 97
Resequencing line items............................................................................................................... 97
Sales Format.................................................................................................................................. 98
Price Information ........................................................................................................................... 99
Command line option .................................................................................................................. 102
Saving an invoice ........................................................................................................................ 103
Delivery Ticket ............................................................................................................................. 103
Recording Notes About Orders .................................................................................................. 106

Cash Register ................................................................................................................ 107
Settings ........................................................................................................................... 107
Customer Payment Options........................................................................................................ 107
Credit Card Surcharge ................................................................................................................ 109

Receiving Payment ....................................................................................................... 110

6 ⚫ EFI Productivity Suite | PrintSmith Vision User Guide

Payment by Check .................................................................................................................. 111
Payment by Cash.................................................................................................................... 111
Payment by Credit Card .......................................................................................................... 112
Charge Accounts .................................................................................................................... 112
Department Charges ............................................................................................................... 112

Post Payments ............................................................................................................... 114
Applying Payments to Invoices .................................................................................................. 114
Why posting payments is important ......................................................................................... 114
Posting payments ................................................................................................................... 114
Selecting Invoices for Payment ............................................................................................... 114
Payment Method ..................................................................................................................... 115
Notify Customer ...................................................................................................................... 116

Journal Entries .............................................................................................................. 118
General procedure for making journal entries ........................................................................... 118
Originating journal entries from the Post Payments window.................................................... 119
E-mailing credit memos .............................................................................................................. 119
Journal entry examples............................................................................................................... 120
Writing off an invoice as un-collectable .................................................................................... 120
Handling a bad check.............................................................................................................. 121
Giving a dollar discount ........................................................................................................... 121
Removing tax from a posted invoice ........................................................................................ 122
Adding tax to a posted invoice ................................................................................................. 122
Issuing a refund ...................................................................................................................... 122
Adjusting sales categories ....................................................................................................... 123
Notify Customer ...................................................................................................................... 123

Register Tape ................................................................................................................. 125
Voiding entries on the register tape ........................................................................................... 125
Opening old tapes ....................................................................................................................... 126

Closeout ......................................................................................................................... 127
Daily closeout .............................................................................................................................. 127
Monthly closeout ......................................................................................................................... 127
Manual vs. automatic closeouts ................................................................................................. 127
Manual closeouts .................................................................................................................... 127
Automatic closeouts ................................................................................................................ 128
Closeout Steps ............................................................................................................................ 129
Productivity Data ..................................................................................................................... 129
Balance the Cash Drawer........................................................................................................ 130
Review Sales Summary .......................................................................................................... 132
Verify Reports ......................................................................................................................... 132

Pending Documents...................................................................................................... 134
The Pending Documents Window............................................................................................ 134
Web Orders ............................................................................................................................ 140

Table of Contents | ⚫ 7

Work in Progress (WIP) ................................................................................................ 141
WIP Mode..................................................................................................................................... 141
Report Mode ................................................................................................................................ 147
Report types ........................................................................................................................... 148

PO History ...................................................................................................................... 151
Duplicate a PO........................................................................................................................ 152
Print PO .................................................................................................................................. 153
Tax ......................................................................................................................................... 153
Shipping Address .................................................................................................................... 154

Accounts ........................................................................................................................ 155
About Customer Accounts .......................................................................................... 155
About Master Accounts ................................................................................................ 155
General Guidelines for Working with Accounts ....................................................... 155
Understanding the Customer Window ....................................................................... 156
Deleting Accounts ....................................................................................................................... 156
Adding Contacts to Accounts or Prospects .............................................................................. 157

Creating Accounts ........................................................................................................ 158
General procedure for creating accounts .................................................................................. 158
Contact and Address............................................................................................................... 160
Credit/Tax Control ................................................................................................................... 162
Settings................................................................................................................................... 164
Marketing ................................................................................................................................ 165
Sales Info................................................................................................................................ 170
Sales Dates ............................................................................................................................ 172

Contacts ......................................................................................................................... 174
Understanding the Contact Window........................................................................... 174
Deleting Contacts.................................................................................................................... 175
Editing Contacts ...................................................................................................................... 175
General procedure for creating contacts ................................................................................... 176
Contact Address tab ................................................................................................................... 176
Contact Detail and Communication Address ............................................................................ 176
Shipping Address .................................................................................................................... 177
Marketing tab............................................................................................................................... 178
Credit Info tab .............................................................................................................................. 179
Using the Web tab for a contact ................................................................................................. 179

Register Accounts and Contacts to Market Direct StoreFront ............................... 180
Understanding the relationship between accounts, contacts and MDSF ................................. 180
Registering accounts and contacts to MDSF............................................................................. 180

8 ⚫ EFI Productivity Suite | PrintSmith Vision User Guide

Method 1: Register a contact and automatically register the account ....................................... 180
Method 2: Register individual accounts and their contacts ....................................................... 182
Method 3: Register multiple accounts in one step .................................................................... 183
Updating accounts and contacts ................................................................................................ 185
Unregistering accounts and contacts ....................................................................................... 185

Account History ............................................................................................................. 186
Copy an Invoice ...................................................................................................................... 188
Editing Account History ........................................................................................................... 188

Estimating History ......................................................................................................... 189
Reasons ................................................................................................................................. 190
Changing the Status of an Estimate ........................................................................................ 190
Copying an estimate ............................................................................................................... 191
Changing an Estimate Title ..................................................................................................... 191

Import Stock ................................................................................................................... 193
Importing Stock Catalogs ............................................................................................ 193
Stock import file format .............................................................................................................. 193
Fields in import file .................................................................................................................. 193
Manually Mapping to MDSF .................................................................................................... 201
Import procedure..................................................................................................................... 203
Import Settings........................................................................................................................ 203
Adjust Price Brackets By ......................................................................................................... 204
Mapping the import file ............................................................................................................ 204
Managing the Import Rules ..................................................................................................... 205
Export Report .......................................................................................................................... 206

Stock Definition ............................................................................................................. 208
Stock List Window ........................................................................................................ 208
Stock Definition Window .............................................................................................. 211
Specification Tab......................................................................................................................... 212
Pricing Tab .................................................................................................................................. 214
Definition Tab .............................................................................................................................. 215
Inventory Tab............................................................................................................................... 216
Defining rigid substrates on the Specification and Pricing tab .................................................. 216
Defining roll stock on the Specification and Pricing tab ............................................................ 217
Defining large format stock on the Specification and Pricing tab .............................................. 218
Fiery Paper Catalog Tab.............................................................................................................. 218
Web Tab ....................................................................................................................................... 220
Register Stocks in Market Direct StoreFront ............................................................................ 220
Updating stocks ...................................................................................................................... 223
Unregistering stocks................................................................................................................ 224

Introduction | ⚫ 9

Introduction
What is new in this release
•
•
•

Work in Progress Reports (See Page 147)
You can now select to calculate and display taxes in purchase orders. (See pages 95 and 153)
Stock Definitions (See page 208)

About PrintSmith Vision
PrintSmith™ Vision is a browser-based print management system for commercial printers, trade printers, copy
shops, and quick printers. To help you run your business efficiently and profitably, PrintSmith Vision combines
estimating, invoicing, billing, point of sale, and accounts receivable in a single product.
PrintSmith Vision supports commercial printers, trade printers, copy shops, and quick printers. It provides the
features needed in commercial printing (like support for web presses, digital presses, and large format presses)
without requiring that you use or understand features that do not apply to your business. As your business grows
and changes, however, PrintSmith Vision is flexible enough and powerful enough to grow with you.

About Estimates and Invoices
Estimates are quotes you give to prospective customers indicating what you will charge for the work they want
you to perform.
Invoices show the actual price of the job and then serve as a bill for the work you performed.
Note

Because estimates and invoices in PrintSmith Vision are so similar, this manual often uses the
term document to refer to them.
An estimate or invoice may include more than one job, and typically also includes some charges related to the
work involved, for example, a charge for design work, ink, cutting, or boxes.
In many situations estimates are unnecessary. If you know you have the job, you can just create an invoice for
the customer. For complex work, however, estimates help you determine an accurate selling price as well as
give you a way of submitting bids based on different quantities and different stock. If the customer accepts your
quote, you convert the estimate to an invoice, meaning the estimate is won; If the customer rejects the quote, the
estimate is archived (as part of the customer’s estimate history) and considered a loss.
Tip
For small simple jobs, you can use POS (point of sale) in PrintSmith Vision to record a sale and print out
a cash register style receipt. In this case, you typically bypass invoices altogether since the cost of
preparing the invoice could exceed the amount of the order.
The content of estimates and invoices is very similar, as is the procedure for creating them. Estimates and
invoices each have their own numbering system, however, and they are handled differently in the system.
Warning If you use pre-printed forms for your estimates or invoices, they should not be numbered; PrintSmith
Vision automatically assigns numbers to both estimates and invoices.
Accurate estimating is a key part of the sales cycle. In PrintSmith Vision, you can create a simple quote quickly,
as well as perform sophisticated estimating when you are bidding for jobs.
PrintSmith Vision comes with a completely defined pricing system with definitions and functions for everything
from prepress to packaging. This pricing system can be adapted to your business so you are not defining the
system from scratch.
You can price products, services, or materials using any combination of pricing methods such as flat rate, cost
plus markup and/or rate, hourly rates, variable markups, and price lists. You can use the pre-press and bindery
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charges supplied by EFI, adapt them, or create your own. Likewise, you can use or adapt the stock, press, digital
definitions, and price schedules supplied by EFI or create your own.

About Estimating History
The Estimate History report provides a record of the estimate activity for each customer or prospect. Use this
report to answer questions about past estimates, to determine when a particular estimate was entered, to see
whether an order was won or lost, or to open an old estimate and re-use its information in a new estimate or
invoice.

About Cash Register
If your shop does walk-in business that does not require invoices, you record the work and payment for it in the
Cash Register window. You can use this window for any work that does not require an invoice.
Cash Register in PrintSmith Vision provides all the functions you normally expect of a dedicated cash register.
You can enter sales and payments, keep a record of each transaction, print receipts, process credit cards, and
open a cash drawer.
Note Integrated credit card processing, the cash drawer, and the receipt printer are optional purchases.
Because the cash register is part of PrintSmith Vision rather than a dedicated machine, PrintSmith Vision can
provide a detailed breakdown of each transaction by date/time, the person who performed it, what was done, and
the account to which the transaction was posted. If you have an external cash register, you can use POS to enter
the totals from the register into PrintSmith Vision; this information then becomes part of the detailed sales
analysis that is typically performed each day.
Even if you have no need for a cash register, the cash register program serves as a link between estimating and
accounts receivable by tracking each estimate and the status of all jobs in progress and those awaiting pickup or
delivery. When an invoice is delivered to a customer and picked up in PrintSmith Vision, it is automatically posted
to accounts receivable and added to the full account history for each customer.

About Post Payments
When you post invoices and charge them to an account you are creating an account receivable for that account.
When the customer pays what was charged, you must apply the payments against the invoices so they are
recorded as Accounts Receivable receipts. This process reconciles the money you received with the money that
was due (as recorded in your invoices). In PrintSmith Vision this is known as posting payments.

Why posting payments is important
A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up
invoices without applying them to invoices. This has some undesirable side effects:
•
Invoices that were paid are still shown as open and may cause the account to become past due when it
really is not.
•

Customers may not understand statements that include invoices they think they paid.

•

The receipt is considered “on account,” and is not included as a taxable cash receipt in Accounts
Receivable.

About Journal Entries
A journal entry is a new transaction that counteracts or reverses the original transaction. Journal entries result in
debit or credit memos. They are used to adjust the total due on an invoice, add or remove tax from an invoice
after posting, write off bad debts, adjust account balances, and so on.
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About Register Tape
PrintSmith Vision keeps a detailed record of all transactions for each sales “day” on an electronic register tape. A
sales day ends when you perform a closeout and a new tape is started. The register tape records significant
events such as deposits, document voids, posted payments, finance charges, and journal entries. When you
post transactions in the Cash Register window they are recorded on the register tape.

About Closeout
A closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or
month. They can also be set up to do manually or automatic.

About Pending Documents
When you first create a new document, PrintSmith Vision puts it on the pending list. This list includes all the
“active” invoices and estimates in your shop and is displayed in the Pending Documents window. This window
is your “command center” in PrintSmith Vision for working with active documents.
Tip

You can also view a summary of the pending list from a mobile device.

Eventually, each document in the Pending Documents window is removed as follows:
•
•

You convert estimates to invoices if you get the job, or void (cancel) or archive them if you do not get
the job. You can track archived estimates in estimate history.
As work on invoices is completed, you pick up the invoices and indicate they were paid. You can track
picked up and paid invoices in the history that PrintSmith keeps for accounts.

The documents in estimate or account history are “locked” since they form part of the audit trail PrintSmith
Vision maintains. All details in the document are retained, however, and you can copy these documents to new
estimates or invoices. You can update the pricing with the latest prices when you copy a document, but all the
descriptive information and notes you made on the job (the location and condition of the artwork, special
pricing instructions, and so on) are retained.
When you copy a document from history, PrintSmith Vision keeps track of the source document. For example,
the old document number is displayed in the document window and printed on job tickets. If you file artwork by
document number, and get a repeat order, the job ticket has the old document number so you can locate the
artwork.

About Web Product Templates
Web products templates are set up under the Template section. You can create web product templates and map
them to Market Direct StoreFront products. When your customer purchases a MDSF product the information
from that mapped template is used to create an invoice document.

About Purchase Orders and PO History
Many jobs require items such as paper or ink that you must purchase. To help you manage the purchasing
process, you can create purchase orders in PrintSmith Vision for the kinds of supplies or outside services that
you typically need for the jobs you produce. Purchase orders can be created in the Invoice program and in PO
history.
The PO history will show you the current and closed purchase orders. Here you can view a specific purchase
order and modify or change the status. There are several column headers that can be used to filter or search
for purchase orders.
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About Quick Access Panel
Quick Access panel not only provides shortcuts to your most commonly used features, it provides a view of the
status of orders taken by the logged in user or for the entire plant. Quick Access includes:
•

Estimate, invoice totals and total orders for the previous day and current day.

•

Year to date and month to date totals of orders, sales, and journal entries.

•

Lists of invoices due today, overdue, and optional custom field.

•

A list of estimates still in a pending state, with the ability to open and review them. When an estimate
is open, you can convert it to an invoice so you can go ahead and produce the job and bill the customer.

•

A log of the communication that has taken place with customers, with the ability to follow up on issues.

About Work in Progress
Work in Progress displays the open jobs or documents. There are several options to filter the documents
including those that are outsourced and for Fiery production. You can set up new filters or use the ones already
setup based on due date. The jobs and documents can be set up by color to identify past due, pickup ready, hold
or those with a firm wanted by date.
From here you can access the jobs and documents and see the detail. You can also send jobs to Fiery
production if that is part of your workflow.
The Work in Progress reports, as their name suggests, help you track your orders – as represented by the
invoices and estimates on the pending list – in various ways.

About Accounts
Accounts are a key part of your PrintSmith Vision system. Invoices are assigned and posted to accounts,
payments are made for accounts, account histories are tracked, and sales statistics are kept for each account.
In PrintSmith Vision, you can define accounts for both prospects and customers. Prospects have not yet done
business with you, but you hope to turn them into customers. Customers have done business with you, and
invoices have been created for them. Once you create an invoice for a prospect, that prospect is automatically
converted to a customer. If customers become inactive, they can be turned into prospects again.

About Contacts
Contacts are the people associated with an account, for example, those who receive statements or invoices or to
whom you send promotional mailings. An account may have a single contact or may have many; it depends on
the account.

About Account History
The Account History report provides a historical record of all accounting activity for a customer or prospect and is
a powerful tool for managing your business. For example, you can use the history to answer specific questions
about payments, determine when a particular order was placed, examine the unpaid (open) invoices on the
account, print a detailed account activity report, and open an old invoice so you can copy it (and re-use it).

About Stock import
The Stock Import feature allows you to import stock definitions and update prices from an electronic price catalog
from a vendor.

About Stock Definitions
The stock definitions window gives you a stock list where you can see a list of all of the stock. It includes stock
that is in inventory as well as stock that is registered with MDSF. You also have the stock definition screen where
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you enter all of the information about your stock. That would include specifications, pricing, definition and
inventory. You may also see tabs for information on Fiery Paper Catalog and web, if applicable.

PrintSmith Vision: EFI-Hosted vs. Customer-Hosted
PrintSmith Vision can either be hosted by EFI (cloud-based) or hosted by you at your facility.

EFI-hosted
When EFI hosts PrintSmith Vision for you, PrintSmith Vision is installed on a server in the EFI hosting center, not
in your facility. This cloud-based option means that EFI takes care of the hardware and software infrastructure for
you, as well as the installation of PrintSmith Vision, updates, backups, and so on.

Customer-hosted
If you are hosting PrintSmith Vision, the PrintSmith Vision server is at your facility, so you control the hardware
and software infrastructure and are responsible for installing and updating PrintSmith Vision, performing
backups, and so on.
Most PrintSmith Vision procedures are the same whether EFI is hosting PrintSmith Vision or you are hosting it,
but some procedures are different and some apply only to EFI-hosted or only to customer-hosted installations.
PrintSmith Vision - EFI-Hosted Guide explains what is different in EFI-hosted installations. If EFI is hosting
PrintSmith Vision, be sure to use this guide together with other guides like this PrintSmith Vision – Setup and
User Guide. Other guides will indicate when a feature or procedure applies only to customer-hosted installations
(not EFI-hosted).
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Contact Information
EFI Support
Web Site:

https://customer.efi.com/support

US Phone:

1.855.EFI.4HLP
480.538.5800

UK Phone:

+44 (0) 800.783.2737

EU Phone:

+49.2102.745.4500

E-Mail: Printsmith.support@efi.com
Regular US Service Desk hours are 7 A.M. to 5 P.M. Mountain Standard Time, Monday – Friday
Regular UK Service Desk hours are 8 A.M. to 5 P.M. Greenwich Mean Time, Monday – Friday
Regular EU Service Desk hours are 9 A.M to 6 P.M. Central European Time, Monday – Friday
Outside of these hours, you may leave a voice mail message and an on-call support representative will be
paged. Response time is based on the severity of the issue.8
Note

For problems involving infrastructure (i.e., computers, networks, operating systems, backup software,
printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of
issues.

EFI Professional Services
US Phone:

651.365.5321

US Fax:

651.365.5334

US E-Mail:
Outside US E-Mail:

ProfessionalServicesOperations@efi.com
EMEAProfessionalServicesOperations@efi.com

EFI Professional Services can help you perform EFI software installations and upgrades. This group can also
help you implement, customize, and optimize your EFI software, plus offers a range of training options.

System Requirements
System requirements can be found in the Release Document for the current release. You should review that
document and confirm your equipment meets those requirements.
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PrintSmith Vision Basics
How PrintSmith Vision Works
The computer where PrintSmith Vision and its database are installed is known as the server. If EFI is hosting
PrintSmith Vision for you, the server is in the EFI hosting center; if you are hosting PrintSmith Vision, the server
is at your location.
To run PrintSmith Vision, you use a browser from a client computer. For information about supported browsers
and client computers, see the PrintSmith Vision – Release Notes or the PrintSmith Vision - Installation and
Upgrade Guide.
Important When PrintSmith Vision is customer-hosted, the server computer must be configured not to go to
sleep. If the server goes to sleep, users who are running PrintSmith Vision from other computers will get a
“server down” message and will be unable to use PrintSmith while the server is in sleep mode.
When PrintSmith Vision is customer-hosted, you can also run PrintSmith from the server itself.

Keyboard Shortcuts
If you like to use the keyboard to accomplish tasks, several keyboard shortcuts are available. A keyboard
shortcut is a combination of keys that you press at the same time, for example, CTRL+C means you press the
CTRL key and c at the same time.
Note
On a Macintosh computer is the equivalent of CTRL on a Windows computer, and OPTION is the
equivalent of ALT.
When a keyboard shortcut is available for a command on a menu, it is displayed next to the command, for
example, CTRL+ALT+I for Invoice > Create Invoice.

Here is where you can logout or go to the Legacy UI version. When you go to the Legacy version from the HTML
5 version it will open in a new window, which will allow you to tab from one version to the other.
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Searching
For each program there is a search feature. You can search for different documents by using the dropdown.

Navigation

When you see three dots in the program it indicates that there is more than one option listed there.
Any field that is underlined is editable.
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This navigation panel is displayed in each application and allows you to access the other applications.
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History
PO History (See page 151)
Account History (See page 186)
Estimate History (See page 189)
Pricing
Stock Definition (See page 208)
Import Stock (See page 193)
Accounting
Accounts Receivable
•
•
•
•
•
•

Accounts (See page 155)
Contacts (See page 174)
Post Payment (See page 114)
Journal Entry (See page 118)
Register Tape (See page 125)
Closeout (See page 127)

POS (Point of Sale)
•

Cash Register (See page 107)

Configuration
Settings
Template List (see page 20)
Email Template (see page 23)
Table Editor
•
Vendor (see page 26)
•
Reasons (See page 190)
Preferences
•
CardConnect® Setup (see Document PrintSmith Vision CardConnect®)
•
Credit Card Manager (see Document PrintSmith Vision CardConnect®)
•
Stocks and Sizes

User Preferences
You can modify the shortcuts that are displayed in the quick access panel by changing their location in the panel
or removing them from the panel completely. To do this use the option under settings User Preferences. You
access User Preferences in the same drop down as log off.

User Preferences consist of two sections, Menu Configuration and Summary Configuration.
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To move the shortcuts click and drag on the three lines to the left of the one you want to move. Use the slider to
remove the item from the panel.

Under Summary configuration you have the option to expand the Estimate/Invoice Summary or not. The estimate
summary and invoice summary screens have a portion of the screen that is collapsed. If you check this box then
it will open the summary screens expanded and if unchecked the summary screens will open with it collapsed.
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Template List
Templates List will display all existing templates. The list includes Invoice, Estimated, Job and Product
templates. Product templates are handled differently and will be discussed in another section. For information on
Product Templates see page 21.
You can narrow the search to just a type of template by selecting the appropriate icon across the top of the page
or you can choose to view all templates.
Note

the quantity of templates in the all tab does not include the number of product templates.

Create
New
Product

Template
Categories

Invoice, Estimate and Job templates are all handled the same way. You have the same filtering options and the
same processes. You can filter this templates by using any of the column headers. Just start typing and the
program will filter the templates. You can also change the direction the templates or displayed by using the icon
in the upper right-hand corner of each column heading field. Using the 3 dots you also have the option of
duplicating or deleting the template. From here you can create template categories.

Template Category
If you select Template Category you will be taken to a screen that list the categories. Here you can search for a
specific category using the columns at the top. Also, you can delete or duplicate the categories using the three
dots next to the check box. As with other column headers you can search or sort the information.
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You can create a new category by selecting the + Category button. That will take you to a new screen where you
can add a category. You can add an image to the category or a layout. If user selects “Do not show in template”
when creating a new template category, that category will only be available with Web products not with Invoice,
estimate and job templates.
Note

Flex Categories that are associated with Web Product will not get carried forward to HTML

If user does not select this check box while creating Template category, that category will be available with Web
products, Invoice, estimate and job templates.

Web Product Templates
Web Product Templates are created and mapped to Direct Market StoreFront products. When your customer
places an order for a product the mapped template becomes the job information for that product and the invoice
is placed in Pending Documents.
Web products can also be used for Four51 integration, API integration, MDSF legacy integration. For these
integrations Map to MDSF option will not be available.
Product template will not be included in All Type Tab. For product templates there are different columns

When eFlow based MDSF integration is enabled, then product list will display the product name, SKU, category,
status, date modified and the MDSF Product Name columns
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Note
visible).

For other integrations (i.e Four51, API, MDSF Legacy) MDSF Product Name column won’t be

On this page you can select the category for the template. The status will show you if a Product has been linked
to a template or not. From this screen you can select the option map MDSF product(s) with PrintSmith product by
clicking on Map to MDSF. From here users also have provision to edit Product detail. To edit Product detail, you
have to click Product name, this action will redirect you to another screen where you will see other options
depending on the status of the product. If the product is not linked to a template, then you will see the option to
either select a template from the library or Set a New Template. If the product already has a template, then those
buttons will be inactive and you can review the information or use Map to MDSF to map PrintSmith product with
MDSF product(s). User can delete or duplicate web products using three dots icon in first column

You can also select the Map to MDSF from the first screen. Using either method will take you to another screen
where you can map the web product to a MDSF product.

The MDSF products will be listed at the bottom of the screen. You can map the specific MDSF products by
checking the box to the left and they will be removed from the bottom of the screen and moved to the top of the
screen to show you that they have been mapped.
Note
You can map more than one MDSF product(s) to the same PrintSmith web product, but only one
job can be linked to a web product.
To link a template to a product you can Select from Library or Set New Product. Select from Library takes to a list
of existing templates. You can select from Job, Estimate or Invoice templates. If you select Job Templates, you
will see a list of them. If you select Estimate or Invoice templates, you will need to enter the appropriate estimate
or invoice number and then select Proceed.
If you use Set New Product, then you will need to create the template by entering the job information just as you
would for add new job. For information on creating a new job see page 50.

If the user selects a Product that does not have a Template linked to it, you will be taken to the same new
screen. The only difference is that if you are creating a new product you will need to enter the name. The SKU
will be automatically entered. The SKU number consist of fixed prefixes and a number, the number is what
makes the SKU unique and is incremented with each new SKU. The program will also not allow duplicates SKU.
With the name and SKU entered you have the choice of adding a template from the library or creating a new
template to link to the product.
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If you choose using a template from the library the user has the option to select template from Job Template list
or from Invoices or Estimates.
1.

When job Template is selected the user has the option to add an existing template from Job Template
List for the Web Product.
2. When Invoice is selected the user has the option to search invoices with an invoice number and select
job from the invoice to add an existing template for the web product.
3. When Estimate is selected the user has the option to search estimates with an estimate number and
select job from estimate to add as template for web product.
Note
If invoice/estimate contains multiple jobs, user will be able to select only one job for job template.
4.
5.
6.
7.
8.

To add template to Web Product, select templates or job from the list and click on Add.
If you need to edit the template, you need to select the edit button in the template row and you will be
taken to the template screen where you can modify the template.
Save the template
Save the product
If you want to delete the template associated with Web Product you could do so by clicking on delete
button present under Action Column.

If you choose to create a new template, you will be taken to the template creation page where you enter the job
information for the template. Once that is done:
1.
2.

Save the template
Save the product.

If you have set the program up to integrate with MDSF then when you look at a product you will have the option
to map that product to a MDSF product.
Tip
After you associate a template with a Web Product, you can later edit the template (by clicking Edit
template) or remove it altogether (by clicking Remove template).

Email Templates
Use the E-Mail preferences to configure your e-mail account with PrintSmith Vision so that you can e-mail
various documents, for example, estimates, invoices, purchase orders, statements, and credit memos. As part of
configuration you can specify what the body of each type of e-mail includes.
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To set up the email you must go to the Legacy version and then go to Preferences > System > Email.

Customize e-mails
By default, the recipient, subject, PDF file name, and body in an e-mail message are as follow:
•

Recipients For a document to be mailed, the default recipient must have an e-mail address defined:
o For estimates and invoices, the default recipient is the invoice contact.
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•

•

•

o

For credit memos, the default recipient is the invoice contact.

o

For statements, the default recipient is the account statement contact or invoice contact
(depending which is being used for the statements).

o

For purchase orders, the default recipient is the supplier specified in the purchase order.

Subject
The subject of the e-mail is Company Name: Document Type #xxx, for example, Vermont
SuperPrints: Estimate #323. The company name is taken from the first line (Company) of the
Address in your Company preferences.
If, however, you select the Use log text as subject and file name check box in these E-Mail
preferences, the log text you specify is used for the subject line instead.
PDF file name
The name of the PDF attachment is Document Type #xxx.pdf, for example, Estimate #234.pdf or
Statement #432.pdf.
If, however, you select the Use log text as subject and file name check box in these E-Mail
preferences, the log text you specify is used for the file name instead.
Body
The body of the e-mail is defined in these E-Mail preferences (see step 3 below).

To customize e-mails
1.

To allow users to customize certain types of e-mail messages before they are sent, select the Customize email fields before sending check box.
When the Customize e-mail fields before sending check box is selected, each time users click the E-Mail
button in the Invoice or Estimate window or in the Purchase Order window, they can add recipients, change
the subject of the e-mail, and edit the body.
Important
The Customize e-mail fields before sending check box does not apply when you e-mail
invoices from the Cash Register or Post Payments window, e-mail credit memos from the Journal Entry
window, or e-mail statements (AR > Generate Statements). In these situations the e-mails are sent without
any input from users – the e-mails cannot be changed.
2. To send a copy of the e-mail to the sender, select the Include sender on CC line check box.
3. For the E-Mail Body, click each tab (Invoice, Estimate, Credit Memo, Statement, and Purchase Order)
and enter the message you want the e-mail to include.
Note
The body specified on the Invoice tab applies to e-mails sent from the Invoice window, the Cash
Register window (for posted invoices), and the Post Payments window (for paid and posted invoices).
The body of the e-mail can include:
•
Text
Text can be anything you want. For example, depending on the e-mail being sent, you may want to include
text such as Your invoice is attached or We hope to do business with you again.
o Enter the text and use the formatting toolbar to change the font, point size, style, color, and
justification of text.
Note
You can only select a font from the list; you cannot add your own fonts to the system.
Currently extra spaces between characters are not preserved when you send e-mails.
•

Place holders
Place holders are replaced with actual data when the e-mail is sent. For example, [DocumentNumber]
is replaced with the number of an invoice or estimate; [AccountName] is replaced with the name of the
account; [Supplier] is replaced with the name of the supplier for purchase orders; and so on. The
available choices depend on the type of e-mail you are sending.
[FirstName], [LastName], [JobTitle], [UserName], and [EmailAddress] always come from the user
definition of the logged-in user so are helpful if you want to identify the user who sent the e-mail in the
e-mail itself.
o To enter a place holder, select it in the Place Holder field and click Insert.

Note
Place holders are always added at the end of the e-mail body, not where the pointer is. Once a
place holder is added, cut it and paste it where you want it.
You may want to include text next to some place holders to explain what the data represents, for example,
precede [DocumentNumber] with Estimate Number or [DocumentTotal] with a currency symbol.
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•
Images
You can include an image such as your logo in the e-mail. To do so, click Add Image and locate and select
the graphic you want to use. The name of the image (not the image itself) is displayed.
Notes
Make sure the image is the correct size before you add it; you cannot resize images in PrintSmith
Vision. The image is always added at the end of the e-mail body, not where the pointer is. Once it is added,
cut the image (meaning IMAGE SOURCE=‘image name’) and paste it where you want it.
•
Hyperlinks
To include a hyperlink in the e-mail body:
o Enter the text for the link. For example, this could be a URL such as http://w3.efi.com/ or text such
as Click here for more information or Visit the EFI web site. You can also hyperlink an image
such as the Facebook or LinkedIn icon.
o Select (highlight) the text of the link or name of the image (meaning IMAGE SOURCE=‘image
name’).
o Enter the URL in the http:// field. (The http:// field is unavailable until the hyperlink text is selected.)
The link (text or image) can now be clicked to take you to the specified site.
4. To see what the e-mail will look like (together with any images you added), click Preview and then close
the preview window. (Place holders will be replaced with real data when the e-mail is sent.)

Table Editor > Vendor
Beginning with version 4.1.0 the vendor and supplier table are merged and displayed as one table in HTML,
labeled Vendor. Going forward the supplier table will be listed as Vendor table in purchase order in HTML. A user
using HTML will not be able to edit/delete the vendor details and supplier details in Flex.
Table Editor will take you to a short cut menu where you can enter or edit vendor information. Selecting the plus
+ will allow you to add a vendor or you can select an existing vendor from the drop down.
NOTE
vendors.

You can only add vendors from this screen. The user must have access to suppliers to edit or add
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Opening other portions of the screen will allow you to enter contact detail or miscellaneous information. You can
enter up to 4 contacts on the contact screen. On the Miscellaneous screen you can enter information about the
vendor such as the material they supply, tax ID, payment terms, etc. You can also identify when you need to
send the vendor a tax exemption notice
Note
You must check the box “Use in Purchase Order” in order for this vendor to be displayed on the
vendor list in the purchase order program

Table Editor > Reasons
This is where you set up reasons for lost estimates. (See Estimate History for more information on Reasons).

Preferences > CardConnect® Setup and Credit Card manager
This is used only if you are using CardConnect® to process you credit card transactions. For information on
setting up and managing CardConnect® see the CardConnect® Integration document.

Stock and Sizes
When creating an estimate or invoice and you go to the Job Detail tab there is a field where you can select the
stock for the job. Normally the stock name is displayed in the search but using the stock and sizes feature you
can select what you want to display in that search. In the example below the search has been set up to display
the stock name, type and color.

You can select the information you want to see on the search display and how you want the information divided.
By checking the box, you can also display the chain of customer for the stock.

Logging in to PrintSmith Vision
When you log into PrintSmith Vision you will be given the option of using the Legacy version or HTML5 version
which is referred to as Fast-track. For some functions you can still use the Legacy version. When you log in to
PrintSmith you will first see this screen.
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Selecting the option to “Login to Legacy” will take you to the Legacy version. If you select “Continue to the Fasttrack version you will be taken to this sign in screen. You can use the “Don’t show this on every login check box if
you only use one version.
NOTE

You can still move from Fast-track to Legacy from each program.
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Defining Sales Tax or Value Added Tax
About Taxes in PrintSmith Vision
In order to properly calculate and report your sales taxes, you need to set up tax tables in PrintSmith Vision to
define your tax rates. If you do not charge and collect sales tax, you should ensure that no (zero) tax is being
calculated.
Where you sell determines how many tax tables you need. For example, if your business sells exclusively in a
single tax jurisdiction, you only need one tax table. If, however, your business sells in multiple tax jurisdictions, or
is international, you need to account for all these different taxes by setting up several tax tables. For example,
international customers may require tax on tax and variable tax rates. Canada has a GST/HST tax. Chile also
has special tax verification procedures. You must account for all these different tax situations.

Default tax table
One tax table is always identified as the default tax table. This may be the only tax table you use. If, however,
you have multiple tax tables, the default tax table should typically be for your most commonly-used sales tax.
The default tax table is automatically used for all taxable customers and invoices unless another tax table is
assigned to an account or invoice.

Product-level taxation
In some locations tax is based on the type of product you are selling, for example, brochure versus business
card. For information about product-level taxation, see “Using Product-Level Taxation” on page 36.

Line-item taxation
You may find it necessary to tax individual line items in an invoice independently. For example, in some tax
jurisdictions an item that involves just labor (such as folding) may be taxed differently from an item that involves
both labor and materials (such as printing). In addition, jobs in an invoice may be delivered to different locations
that are subject to different taxes. When using line-item taxation you can have up to five different tax tables per
invoice. For information, see “Using Line-Item Taxation” on page 38.

Setting Up the Default Sales Tax Table
EFI recommends that you start by defining your default tax table. This may be the only tax table you need, but if
you plan to define additional tax tables, use the default tax table for your most commonly-used sales tax.
1. Select Pricing > Sales Tax. The Sales Tax window opens with no tax table displayed. The Default tax table is
listed under Current at the bottom of the window (as are any other tax tables that were already created).
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2. Click (highlight) the Default table (under Current at the bottom of the window) to display its contents.
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Click to
add a new
tax
element

Effective Tax
Rate is based
on Tax Rate
defined for
line times

3. If necessary, change the name of the default tax table. (Once the table is saved, you can no longer change its
name.)
Tip Any tax table can be your default tax table; just select the check box in Default column next to the tax table
you want to be the default table. You can also name the default tax table whatever you want, although Default
as the name makes the purpose of the table clear.
4. Enter one or more tax elements. For example, you may need to account for both a city and state tax. The tax
elements result in the Effective Tax Rate. Each tax element consists of Description and Tax Rate fields as well
as Ship and Show check boxes to control whether the tax is applied to shipping and/or is identified on an
invoice, estimate, or receipt.
a. Click
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b. In the Description column, select the name of the tax element. (These are defined in the Tax Tables
Elements table; use Table Editor to maintain this table.)
c. Enter the Tax Rate as a percentage (up to three decimal places).
d. Select the check box in the Ship column if the tax should be applied to shipping. This check box is available
only if the Tax Shipping and Separate Shipping check boxes are selected (see step 6).
e. Select the check box in the Show column if you want the tax shown on invoices and estimates, as well as on
receipts for POS (cash register) transactions.
Note To remove a tax element, select it and click
5. If necessary, set the Minimum Taxable Amount.
6. Select or clear the following check boxes:
Tax Shipping
Select this check box if you need to tax the amount you are charging for shipping (which is common in Canada).
When the Tax Shipping check box is selected, all the check boxes in the Ship column are selected
automatically so that all the tax elements in the table are used to calculate taxes on shipping.
If you want to choose which tax elements to apply to shipping, select the Separate Shipping check box and then
clear the check boxes in the Ship column for the tax elements you do not want to use in the calculation. For
example, in the figure below, the city tax is not applied to shipping.

Tax on Tax
Select this check box if one tax must be applied to another. Normally, the rates in the tax table are added
together to produce the effective tax rate. If you select the Tax on Tax check box, the effective tax rate is
calculated differently. Suppose the first tax rate is 8% and the second rate is 2%. In this case, the 2% rate is
applied to the 8% rate. An additional 0.16% (2% of 8%) is therefore added to the effective tax rate, and the result
is 10.16%.
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Build tax in price
(For future use) Select this check box if you want to hide the tax in the price for items and never show it
separately.
Round tax up
Select this check box if you want to round up all the tax rates in the table. Generally, this check box should be
cleared. The only case where EFI recommends selecting the Round tax up check box is in the state of Florida
which has a sales taxing system that uses a table to look up actual tax amounts instead of calculating with a
formula. The closest PrintSmith could get to matching their system by formula exactly (based on the unofficial
recommendation of the State of Florida tax departments) is to round up all taxes.
7. Verify the Effective Tax Rate. This rate is calculated based on the tax elements you entered. If this rate is not
correct, adjust the tax elements.
Tip

If you make changes, but want to return to the original settings, click Revert on the toolbar.

8. Click Save on the toolbar to save the tax table.
Note
If you no longer want to use a particular tax table, select the Disable check box when the details of
the tax table are displayed. You cannot disable the default tax table, however.

Creating Tax Tables for Different Tax Jurisdictions
If you have to account for more than one tax jurisdiction in your business, you must create additional tax tables.
Also, if a customer has special tax requirements, create a special tax table and assign it to the customer account.
For example, a California business has taxable and non-taxable customers. Some taxable customers have
different tax rates due to their government status or other special circumstances. The business is based in Los
Angeles, and when it delivers jobs to customers in Orange County, a different rate must be charged. To use
different tax rates, you could create an OC (Orange County) tax table and assign it to customers in Orange
County. You would also be able to use this tax table for walk-in customers who resided in Orange County.

To create a tax table
1.

Select Pricing > Sales Tax and click New on the toolbar.
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2. In the Tax Table field, enter a name for your table. (After you save the tax table, you will no longer be able to
change this name.)
3. In the Abbreviation field, enter a unique shortened version of the table name.
4. Enter the tax information as described in “Setting Up the Default Sales Tax Table” above.
5. Click Save. The new tax table is listed under Current at the bottom of the Sales Tax window.
Once the new tax table is created, you can assign it to each customer who uses this tax rate. To do this, select
the tax table in the Tax Table field on the Settings tab in the Customer window (see page 164).
Note
In many places in PrintSmith Vision you will see Tax Table set to Use Parent Tax Table. This
means that the tax table assigned to the customer account is being used, unless this was overridden in the
invoice, parent job, or cash register.

Editing Tax Tables
If the tax rate changes, for example, the state sales tax increases, you can edit the tax table to change the rate.
When you make a change to a tax table that affects the tax calculation, PrintSmith Vision creates a new version
of the tax table but leaves the original intact and lists it under Historic in the Sales Tax window.

You cannot edit historic tax tables. If you select a historic tax table, the tax items are displayed in red to warn you
that you are looking at historic, not current tax data.
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Using Tax Codes to Differentiate the Same Tax Rate
If you find that you have several taxes that use the same rate but are for different institutions, counties, or other
organizations, you can use Table Editor to define tax codes to track the different organizations.
For example, you have three counties in your state that collect 8% tax. You could create one tax table at 8% but
define different tax codes (in the Tax Codes table) for the three counties. You can then assign the same tax table
but different tax codes to customers and documents. The code then indicates who is collecting the 8% tax. (You
select tax tables and tax codes for customer accounts on the Settings tab under Tax Setup. For more
information, see page 164).

Tax Exemptions
If some customers or orders are not subject to sales tax, EFI does not recommend that you set up tax tables with
tax rates of 0% to handle these tax-exempt accounts or documents.
Note If do you set up tax table with a 0% tax rate, the amounts are still considered taxable even though no tax is
calculated. This makes sales analysis less accurate because the sales are considered taxable, except at a zero
tax rate.
Instead, for an account, select the Tax-Exempt check box on the Credit/Tax Control tab in the account window.

For a document, select the NO TAX check box in the Document Totals window.
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Including More Than One Tax Element on a Document
When a tax includes more than one element and you want to include all the tax element in documents, select the
check box of each element in the Show column in the Sales Tax window. For example, you may want to break
down the tax by state and city. The Show column also affects printed receipts. Any additional taxes that do not
have Show selected are grouped together in the standard tax amount.

Hiding Taxes in Prices
If you do not want to break out the tax, but want to include it in your prices in the documents that customers see,
do the following:
1. In your document preferences:
a. Select Admin > Document Preferences.
b. Click the Page tab and select the Remove tax line check box.
c. Click the Body tab and select the Hide tax in line items check box.
d. Click OK.
2. In your receipt preferences:
a. Select Admin > Preferences > POS > Receipt.
b. Select the Hide tax in line items check box so that receipts have the tax hidden in the price.
c. Click OK.

Using Product-Level Taxation
In some locations tax is based on the type of product you are selling, for example, brochure versus business
card. To accommodate this type of taxation, you can associate tax tables with product types as described next.
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Setting up product-level taxation
1. Use Pricing > Sales Tax to define the tax tables for products that require different taxation. For example, you
may need one tax table for brochures and another for posters.
2. Select Admin > Table Editor and select Products in the Tables field.
By default, the Tax Table for a product in the Products table is set to Use Parent Tax Table. This means that
the tax table associated with the estimate or invoice will be used for the product.
3. To use a different tax table for a product, select it in the Tax Table column.
4. Repeat step 3 for all the products that require separate taxation.
Note
The Key (Alpha) field in the Products table is required only if you are using the e-commerce API
(separately licensed) and want to assign or use a product type (category) when importing or exporting invoices.
The value in this field must be unique, but it can be anything you want. For information about this API, see the
PrintSmith Vision – e-Commerce API Integration Guide.
5. Click Save on the toolbar.

Taking advantage of product-level taxation
When you add a job to an estimate or invoice and select a Product for the job, the tax associated with the
product (in the Products table) is automatically set in the Tax Table field.

The tax rate defined in the tax table is then applied to the subtotal of the invoice.
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Unless you are also using line-item taxation (see page 38), only one tax table can be associated with an estimate
or invoice. If you have multiple jobs on a single estimate or invoice, they cannot be for products that are
associated with different tax tables. What this means:
• When you add a job to an estimate or invoice for a product that has an associated tax table, that tax table is
used for the entire estimate or invoice.

Note
If you then try to change the tax table at the estimate/invoice level (in the Document Totals
window, the system will prevent you. If you want to apply a different tax table to the invoice, you must change
Tax Table for the job in the estimate/invoice to Use Parent Tax Table.
• After you add one job to an estimate or invoice for a product that has an associated tax table, you cannot add
more jobs for products with different tax tables. The Tax Table field for those jobs must be set to Use Parent
Tax Table (which means the job inherits that tax table from the estimate or invoice).

Line item taxation
You may find it useful to tax individual line items in an invoice independently. For example, in some tax
jurisdictions an item that involves just labor (such as folding) may be taxed differently from an item that involves
both labor and materials (such as printing). In addition, jobs in an invoice may be delivered to different locations
that are subject to different taxes (such as county or city tax in addition to state tax). When using line-item
taxation you can have up to five different tax tables per invoice.
Important: Before enabling and using line-item taxation, read the material below to make sure you understand
how line-item taxation works and find out if it is a good solution for your business.

Warning: Once you enable line item taxes you cannot disable it.

Enabling line-item taxation
To take advantage of line item taxation:
1. Go to Legacy version > Preferences > Under System select Behavior.
2. Select the Enable line-item taxes check box and click Save.

Taking advantage of line-item taxation
When line-item taxation is enabled, you can indicate that a tax table should be “inherited” from its parent (which
is the default behavior) or you can select a different tax table (so it is not the same as the parent). Whenever a
Tax Table field is set to Use Parent Tax Table, the tax table is inherited. The order of inheritance is as follows:
customer account > invoice/estimate > jobs > job charges (or subjobs in a multi-part job). If you select different
tax tables for items in an invoice, they are taxed differently from their “parents.”
When line-item taxation is enabled, you can do the following:
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• Have up to five different tax tables per invoice.
• In the Document Totals window for an invoice, select a tax table to apply against the invoice, as well as any of
its charges or jobs that have Tax Table set to Use Parent Tax Table.
• Select a specific tax table for a job in an invoice. This tax table w ill also apply to any job charges or parts of a
multi-part job that have Tax Table set to Use Parent Tax Table.
• Include jobs for products that are taxed differently (see “Product-level taxation” on page 36).
• Associate individual charges with specific tax tables in the Preset Info window.
• Use EFI-supplied reports (such as EFI_DefaultInvoice_TaxLedger.rpt or EFI_DefaultInvoice_TaxDetails.rpt) to
create document formats that include tax distributions. As with other invoice and estimate reports suppl ied by EFI
you can customize these documents to include your logo and so on.

Hide Line Item tax on Invoice Summary
You have the option to not display the line item tax amount on the Invoice Summary screen. This is set up in the
Legacy version Preferences > HTML View.
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Quick Access Panel
Quick Access panel not only provides shortcuts to your most commonly used features, it provides a view of the
status of orders taken by the logged in user or for the entire plant. Quick Access includes:
•
•
•
•
•
•

Estimate and invoice totals for the previous day and current day.
Year to date and month to date totals of orders, sales, and journal entries.
Lists of invoices due today, overdue, and optional custom field. To change the custom field you must go
to the Legacy version Preferences > System > Dashboard. This allows you set the location to be used
to filter jobs.
A list of estimates still in a pending state, with the ability to open and review them. When an estimate is
open, you can convert it to an invoice so you can go ahead and produce the job and bill the customer.
A log of the communication that has taken place with customers, with the ability to follow up on issues.
Quick access to other applications.

NOTE
The user has the option of displaying their user information or the information for the entire ship.
This is controlled by the Show Only My Records slide bar. If it is on, then the widgets will only display the users
information and if it is off then the display will be of the entire shop. The headings for the widgets will indicate if
you are seeing the shops information or the users.

Search
Options
Quick Access
Buttons for
Other
Applications
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“Show only my records” changes the display for Due Today, Ordered, On Proof, Pending Estimates and
Customer Log to display only items for the logged in user.
“Customize Mode” allows you to remove Quick Access buttons or displays. Remove items by selecting the red X
that is displayed when in the customize mode.
“Add/Remove Options” allows you to change the display to only show the items you want to see by checking or
unchecking the appropriate boxes. The display for the quick access buttons is limited to 12 items. You can use
the Add Remove Options to select the items you want to be displayed.

“Restore Default” changes the display back to the original default status.
In addition to the Customize Mode and the Add Remove Options you can remove individual panes by selecting
the Remove Widget feature
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Note
If you have made changes to Quick Access those changes will still be in effect after the update. If a
user does not have permission for a feature the feature will still be displayed but will be grayed out.

Getting Ready to Use the Quick Access Panel
A few steps are necessary to get Quick Access ready for use:
1.
2.
3.

Set your Quick Access Panel preferences.
Decide which access groups should have permission to view the Quick Access.
Understand the Taken by field.

Set your Quick Access Panel preferences
Note
1.
2.
3.

The setup is done in the Legacy version
Click Preferences in the Quick Access panel (or select Admin > Preferences).
Under System, click Dashboard
Set the preferences as described below and click Save

Dashboard preferences
Use the Dashboard preferences to control some aspects of the Dashboard.

Defined in
Production
Locations
Table

1.

2.
3.

To remind users after they log in that they have some number of items to follow up, select the Show
follow-up count at user login check box.
When this check box is selected, if a user has follow-up items that are either due today or past due, a
message is displayed after the user logs in and gives the user the option to open the Dashboard right
away
By default, the sales and journal entry numbers in the Dashboard include tax. To omit tax from the
totals, select the Exclude tax from Sales and Journal Entries check box.
The On Proof pane in the Dashboard lists all the invoices with jobs currently going through proofing. For
invoices to be listed in the On Proof pane, in the Pick ‘Proof’ production location field, select the location
that corresponds to proofing in your organization, for example, Proof. (These locations are defined in
the Production Locations table, which you can edit with Table Editor.) The name of your proofing
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4.

location is then used in the title of the On Proof pane, for example, if the location is Proofing, the pane
will be named On Proofing.
When the location of a job is set to the proofing location defined in the Dashboard preferences, the
invoice will be listed in the On Proof pane

Give access to the Quick Access Panel
You can control access to the Quick Access through security settings. Any user who is part of an access group
with Help > My Dashboard selected in the Security Setup window (Admin > Security Setup) can open and view
Quick Access. Quick Access is identified as Dashboard in the security setup.
To prevent the users in a particular access group from seeing all the customer log information in the shop, make
sure the Help > Quick Access Show All Customer Logs permission in the Security Setup window is not selected.
As a result, the All button is unavailable on the Customer Log tab.
Also, if you want to prevent the users in a particular access group from seeing YTD and MTD total order, sales,
and journal entry numbers, do not select the Help > Dashboard Show Sales Values setting in the Security Setup
window. As a result, dashes instead of numbers are displayed.
Note Users who do not have permission to review a document (Invoice > Review Any Document) or open a
document from the pending list will also be prevented from opening a document from the Quick Access.

Understand the Taken by field
When you create an estimate or invoice, the Taken by field in the Account Info window (see page 77) is
automatically set to your user (login) name, but this field can be edited.
Note

The Taken by field is case insensitive (Dhina and dhina are the same).

When you open Quick Access, the orders that you see are those that you took – they have your user name in the
Taken by field. You can, however, see orders taken by all other users (but not specific users) by clicking All in
some of the panes of Quick Access.
Web orders, for example, orders coming from PrintSmith Site, Market Direct StoreFront, and Four51 are not
taken by a particular user, however. In this case, the information in the Taken by field in the Account Info window
comes from the Taken by field on the Site tab of the Web Administration window (Admin > Web Administration)
and is used for all incoming Web orders.
If you are integrated with PrintSmith Site, Market Direct StoreFront, or Four51, EFI recommends that you set the
Taken by field on the Site tab of the Web Administration window to the user (perhaps admin) who is most likely
to want to track these Web orders in the Quick Access. Whoever opens the Web orders, however, can still edit
the Taken by field in the Account Info window and enter a different user name there.

About the Quick Access Panel Contents
Some information in the Quick Access applies to the logged in user (whose name is in the Taken by field in the
Account Info window as described above). In the descriptions of the Quick Access that follow, “you” refers to the
currently logged in user. Other information in the Quick Access applies to the entire shop. You can view your
own information (for example, see orders that you have taken) or view information for the entire shop, but you
cannot view information for another user. Likewise, another user cannot see your information.
Note
As described in “Give access to the Quick Access” above, you need permission to view all
customer logs.
Tip

Quick Access Panel is updated automatically every 5 minutes.

The sections that follow describe the different parts and features of the Quick Access Panel.
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Total Widget

The Total Widget summarizes the estimates and invoices that were created on the previous and current day, as
well as year-to-date and month-to-date totals for orders, sales, and journal entries. It shows those that came from
the shop and those that came in over the web.
Notes Unless you selected the Exclude tax from Sales and Journal Entries check box in the Quick Access
preferences the Sales and Journal Entries numbers include tax.
The totals exclude any voided estimates or invoices.

Estimates
•
•

The Estimates section shows the total dollar amount of the estimates that were created on the previous
day. The number of estimates is shown in parentheses.
The Invoices column shows the total dollar amount of the invoices that were created on the previous
day. The number of invoices is shown in parentheses.

Invoices
•
•

The Invoices section shows the total dollar amount of the estimates that were created so far on the
current day. The number of estimates is shown in parentheses.
The Invoices column shows the total dollar amount of the invoices that were created so far on the
current day. The number of invoices is shown in parentheses.

Total Orders
The Total Orders columns provide information about invoices that were created for orders. Total Orders include
invoices that are still on the pending list, as well as invoices that were picked up. Total Orders do not include
voided invoices.
If you do not have permission to see company sales numbers dashes are displayed instead of numbers under
Total Orders.

Sales
The Sales columns provide information about all the invoices that were picked up (meaning invoices that were
charged or paid for by cash, check, or credit card).
Note Unless the Exclude tax from Sales and Journal Entries check box is selected in the Quick Access
preferences the Sales numbers include tax.
•
•

The “This Year” column shows the total dollar amount of invoices picked up so far during the current
year. (The current year is based on the fiscal year set in your Business Calendar preferences and the
range is displayed in the bottom left corner of the Quick Access.)
The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of invoices picked
up so far during the current month.

Journal Entries
The Journal Entries columns provide information about journal entries that were recorded and posted. These
numbers may be negative. Voided journal entries are not included.
Note
Unless the Exclude tax from Sales and Journal Entries check box is selected in the Quick Access
preferences the Journal Entries numbers include tax.
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•
•

The “This Year” column shows the total dollar amount of journal entries posted so far during the current
year. (The current year is based on the fiscal year set in your Business Calendar preferences and the
range is displayed in the bottom left corner of the Quick Access.)
The “This Month” column (for example, MTD Mar-16) shows the total dollar amount of journal entries
posted so far during the current month by the shop as a whole and by you.

If you do not have permission to see company sales numbers, dashes are displayed instead of numbers under
Journal Entries.
Note

The sum of the Sales and Journal Entries numbers represents actual sales for the period.

Note
The displayed information for each widget depend on if you have selected to “Show only my
Records” or not.

Due Today Widget

•
•
•

To help you track what needs to be done today, the Due Today widget lists invoices that are due today.
The total number of the invoices due today is shown at the top of the pane.
If the list is long, click Show All to open a window that shows all your invoices that are due today. This
will open Pending Documents in a new windows and display invoices.
To open an invoice and review its details, double-click it.

Overdue Widget
The Overdue widget lists all your invoices that have a due date in the past. The total number of these late
invoices is shown at the top of the pane.
Note
If an invoice is due today at 12:00 PM, it will be considered overdue any time after 12:00 PM, but it
will still be listed in the Due Today pane.
•

If the list is long, click Show All and the pending documents window will display in a new window all
overdue invoices.
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•

To open an invoice and review its details, double-click it.

On Proof Widget

The On Proof widget lists all your invoices that have jobs out for proof. The total number of these invoices is
shown at the top of the pane. The Item# column identifies the job in the invoice that is out for proof.
Note
For invoices to be listed in the On Proof pane, the location of a job in an invoice must be set to the
proof location specified in your Dashboard preferences.
The title of this pane will match the name of the location you selected in your Dashboard preferences, for
example, if the location is Proofing, the title of the pane will be On Proofing.
The Show all option will open the Work In Progress page in a new window.

Pending Estimates Widget
The Pending Estimates tab at the bottom of Quick Access lists all your active estimates – these are quotes that
either were not yet accepted by customers or were accepted but have not been converted to invoices yet. The
value of those estimates is displayed at the top of the tab.
If a customer accepts an estimate and gives you the go-ahead to proceed with the job, you can open the
estimate from the Dashboard and convert it to an invoice. An invoice includes the agreed-upon price and details
of the work to be performed and then serves as a bill for this work.

Quick Access Panel | ⚫ 47

If the list is long, click Show All to open a Pending Documents window that shows all your pending estimates.
From the Pending Documents window you can open and edit an estimate.
•
•

To open an estimate and review or edit its details, double-click it or click Open.
To convert an estimate to an invoice when the customer has accepted your quote:
1. Double-click the estimate or click Open.
2. Make any necessary changes to the estimate. For example, if the estimate includes multiple
quantities, select the one the customer wants.
3. Select Invoice > Convert to Invoice.
4. When asked about recalculating the document, click Yes to ensure the invoice has the latest
pricing information.
5. When the Account Info window opens, make any necessary changes and click OK.
6. Click Save to save the invoice.

Customer Log Widget
The Customer Log widget at the bottom of Quick Access lists all customer issues that you logged with a followup date of today or in the past.
Tip
You can log entries and enter follow-up reminders in the Notify Customer window. This window can
be opened by clicking a Notify button in the following windows in PrintSmith Vision: Pending Documents,
Contacts, Customer History, Work in Progress, Post Payments, and Journal Entry.
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Estimating
Creating Estimates
Several of the options and steps to create an estimate are the same for creating an invoice.
From the estimating application you can create new estimates or update an existing estimate.
When you first open the estimating application you will see the screen where you identify the customer, contact
and how you want to create the estimate. You can create a new estimate from a new job, account history, job
templates or templates.

1. Select the customer. You can just start typing or use the dropdown to select your customer. The default
will display both accounts and contacts, so you can select either. You can also determine if you want to
display prospect or not.
You can search for the account by account number, phone number or email address using the search code
prefixes listed below.

When searching with Account + Contact selected and Prospects unselected you will only see accounts.
With Account + Contact unseleced and Prospects selected you will only search Prospects.
With both selcted you will search for both Accounts and Prospects.
Prospects have not yet done business with you, but you hope to turn them into customers. Customers have done
business with you, and invoices have been created for them. Once you create an invoice for a prospect, that
prospect is automatically converted to a customer. If customers become inactive, they can be turned into
prospects again.
You can identfiy the type of account by the symbol next to the name.
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Why use customer accounts?
EFI strongly recommends that you associate a customer account with most of the documents that you create.
Not only does a customer account include key information such as name, address, and phone number, but it is
also used to determine if an invoice exceeds the customer’s credit limit. In addition, the account determines
whether a deposit is needed, what type of payment is acceptable, whether a PO is required, or if an automatic
discount should be applied to the order. The tax table (which may change the tax rate), tax code, and tax status
are also based on the assigned account. The customer account can even affect special instructions on job
tickets and documents.
When customers use your services, you want them to continue using your services. If you set up an account for
them, you can examine their history, mark them as inactive, generate mailing labels, and market to them. The
history that PrintSmith Vision maintains also helps you identify customers who only use you as a source for
quotes and never send you any orders. You can find out why you never get their orders and decide whether you
want to continue giving them estimates.
For all these reasons, the walk-in account should be used just for customers you never expect to see again. If
you start using the walk-in account for repeat business, you will have history for the walk-in account, not for
individual customers.
In addition, you could end up with history for the same customer in both the walk-in account and a customer
account. Imagine that you select the walk-in account when creating an invoice for Bob’s Hardware and enter the
customer name and address directly into the invoice. Later, you create a customer account named Bob’s
Hardware and create more invoices. Now you have several invoices for Bob’s Hardware, but one is for the walkin account and the rest are for the Bob’s Hardware account. If you try to pick up all the invoices at once,
PrintSmith Vision does not let you since invoices being picked up together must all belong to the same account.
Worse, if you pick up just the walk-in invoice, it will not show up in Bob Hardware’s history — it is in the history
for the walk-in account.
Tip
To reduce this type of problem, EFI recommends that after you create a document for a new
customer using the walk-in account, you use Invoice > Create Customer Document to create an account for
that customer. Doing so also greatly reduces the number of documents assigned to the walk-in account. If an
account already exists, and the document was created using the walk-in account, click Account Info on the
toolbar of the document window (or select Invoice > Change Account) to select the correct account.
For one-time business, you can select the walk-in account (displayed as <<< WALK IN >>>). If necessary, you
can always use the information you entered for a walk-in customer to create a new customer account.
Note
EFI strongly recommends that you use the walk-in account only for one-time business. If you
select the walk-in account for many different customers, you will find it very difficult to track history effectively.

2.

Select the contact. When you select the account, the program will automatically enter the default
contact person, but you can change the contact by using the dropdown.

3.

Select the process you want to use to create the estimate.
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There are different options for creating a new estimate depending on your preference settings. Under
Preference > HTML you have the option of selecting Template Category View. With this unchecked you will
see the options of creating an estimate from a new job, account history, job templates or invoice/estimating
templates. With this checked the options will change to a new job, account history or template. When you
select template, you will be shown a list of template categories that you can use to find a template. For more
information on “Creating Template Categories” see page 20.
4. Select Continue. This will take you to the Job Details screen where you will enter the information about
the job. Often you do not need to make any changes to the account information but if you do you can
move to that tab. Account information options will be discussed later in this document

Create New Job (Job Methods)
After selecting New Job, you will see several options as to Job Method. Once you have selected the job method
you will see a job detail sheet specific to the job method you selected. Job Methods are defined under
Preferences > Estimator > Pricing Method.
Note
The pricing methods that are available as selections and their names are controlled by preferences
(Admin > Preferences > Estimator > Pricing Method). You may want to change the name of the pricing
method so that it makes sense to your company. For example, you may want to change Printing to Offset,
Outside Services to Outsourced or Buyouts, or Color to Digital Color. What you see in your job method
therefore may not match some of the examples in this manual. In addition, if you activated and customized any
of the “Merch” pricing methods, they will also be available as job method selections.
Each pricing method is designed to handle a particular kind of job: This document will list some of the different
job methods and how they are set up.
•

Printing for an offset job on a standard sheet-fed press. See page 50.

•

Roll Fed for a job on an offset web press. See page 63.

•
•

B&W for a black-and-white job on a copier or digital press. See page 64.
Color for a color job on a copier or digital press. See page 64.

•

Large Format for a wide-format digital job. See page 66.

•

Charges Only for an order that includes just setup or finishing charges (no printing). See page 67.

•

Blank for pricing a job for blank stock. See page 67.

•

List for a job based on a price list. See page 68.

•

Outside Services for a job that is sent to another vendor. See page 71.

•
•

Merchandise for any other kind of job that is not accounted for by one of the other pricing methods.
See page 72.
Multi-Part Job for a job that includes sub-jobs. See page 73.

•

Free Style. See page 74.

Printing Job
The Printing job method is for offset jobs that are printed on a sheet-fed press. These jobs are based on sheetfed press definitions.
1.

Follow the general procedure for creating a job and select Printing as the job method. (Your company
may use a different name for this job method.)
2. The job method will default as printing but can be changed.
3. Select the product. In the Product field, select the type of product the job represents. (You can use
Table Editor to define product types in the Products table.)
Note
If Product Type for Job is selected in the Mandatory Field preferences, the Product field is
outline in red. You must select a Product before you can save the job.
4.

If necessary, change the settings of the Brokered or Finished check boxes. (Brokered is automatically
selected if you create a job based on the outside service pricing method.) Identify if the job is Finished
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5.
6.

If you are using Tracker, in the Location field, select the area where the job takes place.
Select the Press. This is the press configuration that will be used to determine the price of the job.
Select the correct press definition for the job. (Your choice affects the price of the job.) The press
specifications will be compared to the stock selected and you will receive a warning if the stock size
does not match the press.
7. Enter a description
8. If this product uses a stock then you can use the drop down you can select the stock to be used. When
you select the stock the parent size will automatically be filled in from the stock information.
9. Complete the run size, finish size, folded size, original sheets and UP/ON. With this information an
image of the layout will be displayed.
Note
The Up and On fields are calculated automatically based on the settings in the Paper Calculator
window, but change them as necessary. Up indicates how many images fit on the run sheet. On indicates
how many unique images (originals) you have. Again, if you are producing one kind of flyer this should be
set to 1.

10. In the Sheets field, enter the number of originals involved. Sheets can also be the number of versions
if, for example, you are producing four different variations of a flyer. If, however, you are producing one
kind of flyer from one original, you should leave Sheets set to 1.
11. The Press field shows the number of impressions needed to get a finished quantity and is calculated by
dividing the number Ordered by the number Up. (If the Press total cannot be divided evenly by the Up
number, it is rounded up.) Change the number in the Press field if necessary, but keep in mind that
PrintSmith Vision will then change the number in the Ordered field.
12. Enter the run method. Often only one option will be available based on the press and stock.
13. Enter ink information and run method. You can identify the number of colors, passes and washes for the
front and back of the material. You can also select or type in the ink to be used from the dropdown.
a.

For Colors, specify the number of colors to be printed on the front and back. The default is 1, but
for multi-color jobs, enter the number of colors.

b.

For Passes, specify the number of runs that are needed for the number of colors specified. Initially,
Passes is based on the number of color heads in the selected press. If you need to run one color
twice, you can change the number of passes as long as it is higher than the minimum number of
passes. (This is considered an override.)

Note
Labor and run time are based on the number of passes, not the number of colors. Charges are
based on the number of colors, not the number of passes.
c.

For Washes, enter the number of press washes for each side of the job. The number of washes
(on both sides) is multiplied by the wash rate in the press definition and added to the price of the
job.

d.

Click the Ink field and select (or enter) up to six colors. (The available selections come from the Ink
Color table, which you maintain with Table Editor.)

Notes
For CMYK, enter each color in a separate field (four fields altogether). When you select an ink
here, it is not billed. To include the ink in the job price, you must add ink charges.
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You can type in a PMS ink in the small box displayed in the line. That ink will be displayed in the short cut menu
and selecting the plus sign will enter that ink in the line.

14. Enter the quantity. By selecting the + next to the quantity field you can enter multiple quantities. All of
the information already entered will be copied over to the additional quantities. You can enter the new
quantity in the new quantity field for the additional quantities. You will also see additional fields at the
top of the screen with each of the quantities so you can tab between quantities. Select the confirm
button after entering a new quantity and it will be reflected in the quantity options fields.
15. Enter the Over/Under quantity if applicable. If you want to charge for the difference between the ordered
quantity and the quantity actually delivered, in the Overs/Unders field, enter a positive number if the
delivered quantity is over the ordered one or a negative number if it is under. Overs and unders typically
apply only to jobs with large quantities involved.
Notes The total price of the job (including all charges) is divided by the quantity ordered to get a unit
price. The unit price is then multiplied by the quantity entered in the Overs/Unders field. This is added
to the job price and the total job price.
Any job that has overs or unders defined is shown with the quantity and price italicized.

16. The In Sets of field typically applies when carbonless or NCR stock is being used for the job, and
indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets of field.
Otherwise, this field is not used.
Tip
For an item like pads, enter the total number of items in the Ordered field. For example, if you need
100 pads of 25 pages, you would enter 2500 in the Ordered field and 1 in the Sheets field. You would then
use charge definitions to make the pads themselves.
17. Finishing operations (such as bindery) may have some associated waste. As you add charges to the
job, any associated waste is calculated and added to the Bindery Waste field. If necessary, enter a
different number in the Bindery Waste field, but avoid doing this until you have added all finishing
charges to the job.
Note
When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are
spoiled.
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18. You can add Charges to the job using the “Add New” button available in the Job Details Screen.
Note
When you are adding charges or modifying any existing charges, make sure to click on Confirm
button and Done button to save the charges to the Job.

Special Order

If the stock requires a special order, click Special Order and complete the Stock Definitions window with
information about the stock.
If the stock for the job is not part of your inventory, then you can select the option for Special Order. This allows
you to specify a special-order material. Here you can enter all the material specifications.
If user wants to add the special-order stock into Stock definition for re-use, then you need to enable “Use in
future” option.

After completing the first screen, the second screen allows you to enter cost information for different quantities.
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Select Done when you are complete, and the information will be copied to the job detail screen.

Stock Picker
If you want to see the full list of stock you can use the stock picker.

You can look at all of the stocks in inventory from the stock picker list. You can use the blank fields at the top of
the screen as filters. For example if you only want to see 80# stock enter 80 in the field below weight. When you
select a column heading you will see an icon that allows you to sort according to that column in order or reverse
order. Highlight the stock you want and select the confirm button. The stock information will be entered
automatically in the job detial screen.
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Paper Calculator

You may not need the paper calculator in all cases. The Paper Calculator will help in determining the amount of
parent sheets needed and the material cost. You enter the specifications and the system will calculate the
amount of material needed for the job.
Review the settings in the Paper Calculator window, change them as necessary, and click Save. Be sure you
specify the correct Run Size and Finish Size as an example.

Using the Paper Calculator
Although not an imposition tool, Paper Calculator lets you specify certain aspects of the layout such as bleeds,
gutters, and white space. Paper Calculator also shows you the number of sheets out and the number of cuts for
any combination of parent, run, and finished sheet sizes. Although you can provide this information for each job,
you can create paper templates for your standard layouts and re-use them in future jobs.

Changing settings in the Paper Calculator window
•

When you open the Paper Calculator window opens after you select a stock for a job, the window
already includes some information about the dimensions of the stock. Otherwise, you must provide this
information. Always check the run and finish sizes and make sure other layout settings are as you want
them.

Note
The default settings of certain fields in the Paper Calculator window are controlled by your paper
calculator preferences, but you can change them when using the Paper Calculator for a particular job.
•

The settings and features in the Paper Calculator window include the following:
o If you have created paper templates, click Find on the toolbar to locate and select a template
for the job. The Template Name field then shows the template you selected.
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o
o
o

Parent Size: The size you purchased.
Run Size: The size of the paper that goes through the machine. Change this by selecting a
different size or entering a size.
Finish Size: The final size of the paper after the job is done. Change this by selecting a
different size or entering a size.

Selecting the slide bar will display the options for the following elements.
•

•

•
•
•
•

Grip Edge / Gap: Select this check box to include a gripper edge. This is the amount of space required
on one feed edge of the run sheet for the press to pick up the paper. You may be able to ignore this
setting due to the placement of the image on the page. The size of the grip edge usually comes from
the press definition but may come from your Paper Calculator preferences. You can, however, change
the grip edge/gap in the Paper Calculator window for an individual job.
Folio Edge: Select this check box to include a folio edge. This is the amount of space that is reserved
on an edge of the run sheet for a multi-part job. The folio edge is used when folding signatures to offset
the imposed image and to leave one edge of the folded signature overhanging the other. If both the
gripper and folio use the same edge, the larger of the two is used (they are not added together), and the
edge is displayed half in red and half in green.
Color Bar: Select this check box to include a color bar opposite the gripper edge.
White Space: Select this check box if you want to define a part of the run sheet as unusable and have
control over the page layout.
Gutter: Select this check box to include a space between multiple images on a sheet. The first value is
the vertical gutter; the second is the horizontal gutter.
Bleed: Select this check box to include bleeds. A bleed extends the printed image beyond the edge of a
page. This overlap is then trimmed to produce the final printed piece. Bleeds generally increase the
number of cuts because the bleed must be trimmed off each finish sheet in addition to any cuts needed
to separate each sheet.
You can specify a different bleed for each edge, but since generally the same bleed is used for all sides,
you can just enter a value in the Top field. The other bleeds are then automatically set to the same
value. Bleeds are shown as blue borders around each sheet and are added to any gutter that is
specified.

Select the appropriate check box for these items as needed.
•

•
•
•
•

Notes

Work and Tumble: Select this check box to change the cut-out diagram for tumbling by showing two
gripper edges. (The Work & Turn label in the Job window then changes to Work & Tumble.) Except
for a possible change in the number of sheets out due to the additional gripper edge, no other change to
pricing is made as a result of selecting the Work and Tumble check box.
Back Trim, Parent: Select this check box if you consistently trim the edges from all four sides of the
parent sheet. This effectively adds four cuts to the parent cut and centers the run sheets in the parent
sheet.
Trim Four Sides: Select this check box to center the image by trimming the edges from all four sides of
the run sheet. This typically results in the best ink coverage.
Disable FSC options: Select this check box if a stock is tracked for chain of custody (such as FSC
certification), but the customer did not request a certified stock, and therefore you want to omit the chain
of custody information from the document.
Run to Finish Grain: If necessary, change this from Neither (where a best fit strategy is used without
any sheet rotation) to Match Grain (sheets are never rotated to improve the number of sheets out) or
Swing/Combination (sheets may be rotated to maximize the number of sheets that can be cut out).
Sizes are defined in the Dimension table which you can edit with Table Editor.

The area on the right shows the cut diagram. Select Parent & Finish; Parent & Run; or Run & Finish to change
what is shown.
Tip

When you are finished be sure to select Confirm

Note
The confirm button does not save the estimate. To save the estiamate you must select the SAVE
button on the estimate summary screen.
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Supplied Stock and Special Order
If the stock will be supplied check that box and the cost of the stock will be removed from the price of the job.
If the stock requires a special order, click Special Order and complete the Stock Definitions window with
information about the stock.

Job Notes
Selecting Job Notes will take you to a screen where you can add job ticket notes. “Add Time Stamp” will put the
date and time with the notes.
.

Digital Assets
The Digital Assets option will allow you to upload digital files.

Delete button
User can delete individual job from the job details screen using Delete button
Note:

When a user deletes the job and confirms they are taken to Estimate/Invoice summary screeb.

Confirm
Once the information has been entered selecting Confirm will save the job information and you can move to the
estimate summary screen.
Important
Selecting Confirm does not save the estimate. You must use the save button on the estimate
summary screen.
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There are several command options available when you create a job.

Carton Labels:
You can create labels for the containers that hold the finished job. You can also define the format of these labels.
Note

You must save the estimate from the estimate summary screen before you can print labels.

1.

If necessary, in the Label Format field, select a different format. Carton Labels is automatically
selected as the Label Format. You can create and edit label formats by clicking Define Label Format.
2. Enter a Total quantity
3. Enter Items Per Box
4. Enter Number of Boxes
5. Enter a Starting Number, if is other than 1, as well as a Ending number
6. If you have a partial sheet of labels and you need to skip over them to the first good label, enter the
number in the Labels to skip field.
7. In the Label Text field, enter any additional information to print on the label.
8. Select to use Today’ Date or End Date
9. Select the information that you want to include on the label, for example, Job Description, Today’s
Date, or Estimated Weight.
10. Enter the information on how you want the labels to print
11. Click PRINT after you specify all the carton label information.

Defining, editing, or deleting label formats
You can define, edit, or delete the formats for carton labels. PrintSmith comes with several pre-defined formats
for labels. You can modify these formats or create as many additional formats as you need using the Define
Label Format button (see step 2 below).
The table below describes the pre-defined label formats supplied by EFI.
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To define a label format
1.
2.
Note

In the Job window, click Carton Labels on the toolbar or click Carton Labels under Commands. The
Carton Labels window opens.
Click Define Label Format. The Define Label Format window opens.
This window is also used for defining, editing, and deleting shipping and mailing labels.

3.

In the Existing Formats field, select <new format>.

4.

Enter a Format Name.

5.

Specify the label details and click Print Sample to see if the label looks the way you want it.

6.

Click OK.

To edit or delete an existing format
1.

In the Carton Labels window, click Define Label Format. The Define Label Format window opens.

2.

In the Existing Formats field, select the label format you want to edit or delete.

3. If you are editing the format, make your changes; if you want to delete the format, click Delete and then
click Yes to confirm the deletion.
4.

Click OK.

Reviewing production data
You can review production data from the Job Window. Here you can review production and pricing information
for the job. The information displayed in this window comes from your pricing definitions and should not be
changed except under special circumstances. The information that is displayed also depends on the job pricing
method. For example, outside service or merchandise jobs have far less data than printing or large format jobs.
Note
You can prevent an individual user from opening the Production Data window with a security
setting (select Admin > Security Setup and disable Job Production Data).
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Review the information in the window:
Parent Size - The size of the purchased sheet. This is taken from the selected stock. (For large format jobs, this
is Roll Width, not Parent Size.)
Parent Costs - Your price for the Parent Size sheet for the number of sheets shown in the per field. (For large
format jobs, this is for square area.)
Press/Run Size - The dimensions of the sheet being run.
Out - The number of Press/Run Size sheets that you can get out of a given parent sheet. (You can override this
number, but if you do, PrintSmith Vision cannot generate a cutout diagram.)
Press Speed – This is expresses in Impressions/minute. (For B&W, color, and large format jobs this is Copier
Speed.)
Production Run - The number of impressions per run. (This cannot be changed)
Markup - The markup on the stock (your gross profit on the stock).
Requires - The number of parent sheets (or other unit) required to run the order. (This cannot be changed)
Sheets Purchased - The number of sheets purchased for the job. (If the selected stock has a minimum quantity,
this number may be higher than the actual sheets required for the job. The cost of the additional paper is
included in the job if the Charge Customer for Entire Order check box is selected in the stock definition.) (This
cannot be changed)
Press - The press definition selected for the job. (For B&W, color, and large format jobs, this is Copier – the
digital definition used for the job.) (This cannot be changed)
Labor Rate/Markup - The labor rate and labor markup used for the press.
Setup, Run, Washup, Total Time - The time to set up the press and the time required for washup apply only to
jobs based on press definitions. The run time is based on information in a press or digital definition.

Job Price
This area of the Production Data window breaks down the job price:
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Stock

The Cost, Markup, and Price breakdowns for
the stock for the job.

Labor

The Cost, Markup, and Price breakdowns for
the labor for the job.

Itemized Markup

The total markup charges (if any) attached to
the job. Markups are calculated separately
after all other charges are calculated so they
are based on the most current prices and
exclude invoice level charges or customer
discounts.

Other Markup

The total of all charges attached to the job that
are not markups.

Production

The total charged for washups. (For jobs not
based on press definitions, you can use the
field to add any additional production fees for
which you do not already have a charge, for
example, a delivery fee to an outside vendor.)

Target Adjust

For offset jobs where you have a price list if
you price the job differently than the price list
the difference will be displayed in Target
Adjust.

Job Price

The total of all the prices shown in the window
(unless the job price was overridden).
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Estimator Checklist
PrintSmith Vision includes an “estimator checklist” so you can review the entire job – from specification creation
to production – in one place. The estimator check list has two sections, one for the item list and the other for the
items table.
One checklist is opened for each job in a document. The item list shows general information about the job; the
items table provides details of the items that make up the job. Items that are red and underlined indicate
conflicting information or information that was overridden and warn you to follow up.

Price List
Once the detail is entered you can create a price list. This is used for customers that are not sure of the quantity
they want to order.
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Roll-fed Job
The Roll Fed job method is for jobs that are printed on an offset web press, for example, a newsletter printed in
four colors on two sides. These jobs are based on roll-fed press definitions.
Roll-fed jobs are identical to printing jobs (see above), with these exceptions:
•
•
•

The Roll Width is the width of the entire roll of stock. This comes from the stock definition and cannot
be changed.
The Cutoff field specifies the circumference of the physical cylinder on the press, for example, 11
inches. This comes from the press definition and cannot be changed.
By definition, there is only one pass on a roll-fed press, so Passes is always set to 1 (and cannot be
changed.)
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B&W or Color Digital Job

The B&W and Color job methods are for black-and-white and color copy jobs. Much of the information for such
jobs comes from the digital definition and stock definition selected for the job. For many jobs, a description and
the number of copies ordered is all that is required to price the job.
1. Follow the general procedure for creating a job (see page 50) and select B&W or Color as the job
method. (Your company may use different names for these job methods.) Then select a stock and make any
necessary changes in the Paper Calculator window (see page 65).
2.

In the Description field in the Job window, enter a name for the job, for example, Color Copies.

3.

Tab through and complete the fields on the right side of the Job window:
a. In the Ordered field, enter the job quantity. For information about specifying more than one
quantity for a job, see page 52.
b. If you want to charge for the difference between the ordered quantity and the quantity actually
delivered, in the Overs/Unders field, enter a positive number if the delivered quantity is over the
ordered one or a negative number if it is under. Overs and unders typically apply only to jobs with
large quantities involved.

Notes
The total price of the job (including all charges) is divided by the quantity ordered to get a unit price.
The unit price is then multiplied by the quantity entered in the Overs/Unders field. This is added to the job price
and the total job price.
Any job that has overs or unders defined is shown with the quantity and price italicized.
c. The In Sets of field typically applies when carbonless or NCR stock is being used for the job,
and indicates the number of sheets in a set, for example, for 3-part NCR, enter 3 in the In Sets of
field. Otherwise, this field is not used.
Tip
For an item like pads, enter the total number of items in the Ordered field. For example, if you need
100 pads of 25 pages, you would enter 2500 in the Ordered field and 1 in the Sheets field. You would then use
charge definitions to make the pads themselves.
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d. In the Sheets field, enter the number of originals or number of versions (see examples below).
Notes
In certain kinds of jobs (such as booklets), sheets are equivalent to leaves. When entering a value
in the Sheets field for jobs like these, keep in mind that you are always describing the finished product.
Example 1: In a job for a set of single-sided copies, Sheets is the number of originals. If you are making 100
copies of 10 pages, Sheets would be set to 10. (If the job is double-sided, Sheets would be set to 5.)
Example 2: In a job for four different versions of a single-sided flyer, Sheets is the number of versions so should
be set to 4.
Example 3: In a job for a 100-page comb-bound booklet, Double-Sided would be selected and Sheets would be
set to 50.
Example 4: In a job for a 16-page booklet which is the result of folding the paper in half and saddle-stitching,
Double-Sided would be selected and Sheets would be set to 4. (4 double-sided sheets folded in half and
saddle-stitched result in a 16-page booklet.)
e. The Up and On fields are automatically calculated but change them as necessary. Up indicates
how many images fit on the run sheet. On indicates how many unique images (originals) you have.
For example, if you are producing business cards with four different names, On should be set to 4.
f. The number Ordered divided by the number Up results in the value in the Copies field (which
may be rounded up). Change the value in the Copies field if necessary, but keep in mind that
PrintSmith Vision will then change the number Ordered.
g. Finishing operations (such as bindery) may have some associated waste. As you add finishing
charges to the job, any associated waste is calculated and added to the Bindery Waste field. If
necessary, enter a different number in the Bindery Waste field, but avoid doing this until you have
added all finishing charges to the job.
Note
spoiled.

When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are
h. In the Est Waste field, enter the number of sheets you expect to lose during the production
process to get the required number (Ordered quantity) of good prints. Normally, Est Waste is set
to 0, but you can override it (if you have permission to do so).

Note
Usually, waste is added to the run length. This affects the estimated run time for the job and the
amount of labor. When labor is a factor in calculating the price, the price changes to reflect this. If the stock cost
is part of the price calculation in the digital definition (the Stock Price is field is either set to marked up Stock
Cost or set to from Copier 1, 2, or 3 in Stock Definition), waste is included in the price.
4. The stock information and dimensions should be correct based on your stock selection and the
information you provided in the Paper Calculator window. If you need to change the stock, click Change
Stock Selection under Commands.
5. The Pricing Copier field defaults to the digital definition associated with the stock (if any) or your
default B&W or color digital definition depending whether you are creating a B&W or color job. Select the
correct digital definition for the job.
The Costing Copier is the printer you want to use for costing if a job is quoted on a low-end printer but is
run on a high-end printer. The price of the job stays the same, but your costs will be accurate if the high-end
printer is used. Typically, you do not need to change this field.
6.

Select Single Sided or Double Sided.

7. Add any setup and finishing charges to the job as described on page 81. For example, if you are folding
and stitching the job, add a folding charge and a stitching charge.
8.

Click Save to save the job. The document window opens with the job and its charges listed.
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Add/Modify Special Pages
You may have pages that are different than the rest of the pages. It could be some color pages where the rest
are black and white or it may be an insert.
Here you can define the special pages and add them to the job detail
a.

Enter the page numbers for the special pages

b.

Select the type of pages

c.

Enter the description

d.

Select the stock type

e.

Select the stock color

f.

Identify as Simplex or Duplex

Selecting Print Services will allow you to enter some specific printing services.

Large Format Job
The Large Format job method is for jobs that are printed on a wide-format digital press. These jobs are based
on large-format digital definitions.
Large-format jobs are almost identical to B &W and color jobs, with these exceptions:
•
•
•
•

The stock selections (in the Stock Picker window) are limited to stocks used for large-format work.
The Cutoff is the length of the stock used for the job.
The Est Waste field is for specifying the number of prints (not square area) that you expect to waste to
get the required number of good prints.
The Pricing Copier field defaults to the digital definition associated with the stock (if any) or your
default large-format digital definition. If necessary, select a different large-format digital definition for the
job.
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Charges Only Job

The Charges Only job method is for jobs that consist of just setup or finishing charges, for example, design
work.
1.

Follow the general procedure for creating a job (see page 50) and select Charges Only as the job
method.

2.

In the Description field, enter a name for the job, for example, Design and Consulting.

3.

If you plan to add more than one job aware charge, in the Ordered field, enter the job quantity. This
quantity is then used automatically in all the job aware charges. Otherwise, leave the Ordered field
set to 0.

4.

In the Notes field enter any comments to explain the job.

5.

Add the charges to the job as described on page 81.

6.

Click Save to save the job.

Job for Blank Stock
The Blank job method is for selling blank stock. The prices for blank stock are taken from the Pricing for Blank
Sheets area on the Pricing Options tab in the Stock Definitions window.

Note
Blank stock pricing is based on the Blank Stock Pricing quantity and markups in your Stocks and
Sizes preferences and the costs in the stock definition (the Cost row under Qty. Adjustments on the
Specification and Pricing tab).
PrintSmith Vision uses the blank sheet pricing to calculate a unit price and then m ultiplies this by the quantity
ordered for the job.

To create a job for blank stock
1. Follow the general procedure for creating a job (see page 50) and select Blank as the job method. Then
select a stock and make any necessary changes in the Paper Calculator window (see page 65).
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2.

In the Description field, enter a name for the job.

3. In the Ordered field, enter the quantity and press the TAB key. The Unit Price and Price are calculated
according to the blank stock pricing in the stock definition.
4.

Click Save to save the job.

List Based Job
The List job method is for print jobs based on list pricing. List prices are tables of quantities and either numbers
of colors or numbers of passes through the press. PrintSmith Vision includes some list price schedules to get you
started. You can change the contents of the schedules or delete them as long as at least one is left. (There must
always be at least one predefined price schedule.)
Note
List pricing is useful if you need to match another pricing system or a printed price list exactly, but
you do have to enter and change the prices manually.
If you use Crouser pricing, see the guide PrintSmith Vision - Crouser Pricing. Crouser list price schedules work
very much like the standard list price schedules described here except that you cannot edit or delete them.
If you create jobs based on list pricing, you can (but do not have to) assign price list schedules to stock
definitions. When you select a stock for a list-based job, and the stock has a list price schedule associated with it,
that list price is used for the job. Otherwise, PrintSmith Vision warns you that the default price schedule will be
used. You should then select a list price for the job.
Before you can create jobs based on list pricing, you must create your list price schedules or review and adapt
the predefined price list schedules.
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Creating list price schedules
Select Pricing > List Price Schedules. The List Price Schedules window opens.

To create a list price based on quantities (copies) and number of colors, click New Color Schedule. A window
with Colors at the top opens.
Alternatively, to create a list price schedule based on quantity and number of passes through the press, click
New Pass Schedule. A window with Passes at the top will open.
To complete the price list information:
1. In the Name field, enter a descriptive name for the schedule.
2. By default, the price list is based on the ordered quantity, but if necessary, select one of the following in
the Method field:
•
•
•

Use press sheets – the run quantity of sheets through the press.
Use press sheets and bindery waste – all the paper running through the press.
Use ordered quantity per sheet (originals) – the ordered quantity for each original, for example,
25 business cards for each name.

3. Enter your quantities and prices in the table. Note that the fields below the table are used for whatever
additional increment that you specify; +1000 in the example below.
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4. Click OK

Modifying list price schedules
EFI recommends that you review the pre-defined list price schedules and adapt them to your needs.
1. Select Pricing > List Price Schedules. The List Price Schedules window opens.
2. Double-click the list price schedule you want to review or edit (or select it and click Select). The list
price schedule opens.
3. Edit the schedule as necessary and click OK.

Copying list price schedules
1.
2.
3.
4.

Select Pricing > List Price Schedules. The List Price Schedules window opens.
Double-click the list price schedule you want to copy (or select it and click Select). The list price
schedule opens.
Select File > Save As and provide a name for the new list price schedule.
Edit the schedule as necessary and click OK.

Deleting list price schedules
You can delete any list price schedule, but the system must always include at least one list price schedule so
that a default exists.
1. Select Pricing > List Price Schedules. The List Price Schedules window opens.
2. Select the list price you want to delete click Delete.
3. Click Yes to confirm the deletion.

Assigning list price schedules to stocks
When you use list pricing as the job method, your stock definitions can be (but do not have to be) associated with
list price schedules. When a list price schedule is associated with a stock that you select for a list-based job, the
list price schedule is used to price the job. If the selected stock does not have an assigned list price schedule,
you are warned that the default list price schedule will be used for a list-based job; you can then select a list price
schedule for the job.
Note The default list price schedule is the first one listed in the List Price Schedules window.

To assign list price schedules to stocks
1.

Open a stock.
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2.
3.
4.

In the Stock Definitions window, click the Pricing Options tab.
Under Schedule for List Pricing, click Select Schedule and make your choice. The name of the
schedule is now displayed to the right of the Select Schedule button.
Save the stock definition.

Creating jobs based on list price schedules
When you select List as the job method, a list price schedule must also be selected. If the stock you select for
the job is associated with a list price schedule (see above), that schedule is used (although you can change it).
Otherwise, you must select a schedule while creating the job.
Follow the general procedure for creating a job (see page 50) and select List as the job method. Then select the
stock.
1.

In the Description field in the Job window, enter a name for the job.

2.

If you were warned that the default list price schedule will be used, select a different schedule.

3. In the Quantity field, enter the quantity ordered. If the schedule is based on colors, the initial calculated
price is based on one color on the front. For passes through the press, the price is based on one pass.
4. In the area below Costing Press, for a schedule based on colors, enter the number of colors on the
front and back as shown in the figure below. (If the schedule is based on passes, enter the number of
passes as necessary.) The price of the job is automatically updated based on the information in the list price
schedule selected for the job.

5 Click Save.

Outside Service Job
The Outside Services job method is for jobs that you send out to other vendors, not do in-house. Such jobs are
also known as brokered or vended jobs. An outside service job is marked up according to your outside services
markup preference (Admin > Preferences > Estimator > Markups). (You can always adjust the markup as
market conditions change.)
Note
Jobs are not identified as outside service jobs on estimates or invoices so your customers will not
know these jobs were sent out.
If purchase orders are enabled in your system, you can create a purchase order for the outside service.
1.
2.

Follow the general procedure for creating a job (see page 50) and select Outside Services as the job
method. (This may have a different name in your shop.)
In the Description field, enter a name for the job, for example, Design Work for Spring Promotion.
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3. In the Notes field enter any comments to explain the job. These notes are for the outside service
(vendor) and are not shown to the customer unless you select the Show Notes check box.
4. In the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list of vendors in
the Vendor table.)
5.

In the Quantity field, enter the number ordered.

6.

Do one of the following:
•
•

Note
7.

In the Unit Cost field, enter the cost of one unit of the item you are having done. The system then
calculates the Total Cost by multiplying Unit Cost by Ordered (quantity).
Enter the Total Cost. (No Unit Cost is calculated in this case.)

The Price is Total Cost multiplied by the Markup.
Click Save to save the job.

Note
If you activated any of the five Merch pricing methods (in the Pricing Method preferences), they
work just like the Outside Services method. Typically, the Merch pricing methods are used to group outside
services by different sales categories.

Merchandise Job
The Merchandise job method is for any kind of work that is not accounted for by one of the other job methods. A
merchandise job is marked up according to your merchandise markup preference (Admin > Preferences >
Estimator > Markups).
1. Follow the general procedure for creating a job (see page 50) and select Merchandise as the job
method. (This may have a different name at your shop.)
2.

In the Description field, enter a name for the job, for example, Frames.
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3. In the Notes field enter any comments to explain the job. These notes are not shown to the customer
unless you select the Show Notes check box.
4. If applicable, in the Vendor field, select the vendor you are using. (Use Table Editor to maintain your list
of vendors in the Vendor table.)
5. In the Quantity field, enter the number required. For information about specifying more than one
quantity for a job, see page 52.
6.

In the Unit Cost field, enter the cost of one unit of the item you are selling.

Note
Total Cost is the Unit Cost multiplied by the Quantity, and the Price is Total Cost multiplied by
the Markup
7.

If necessary, add charges to the job as described on page 81.

8. Click Save to save the job.

Multi Part Job
The Multi-Part Job pricing method is for complex jobs that include sub-jobs. For example, you have an order for
a booklet that has a cover and a number of inside pages. The cover might be a process color job on coated stock
while the inside pages might be photocopied. The cover may need negatives, stripping, plates, scoring, and so
on, while the inside pages are a simple copy job. Since the jobs are related, you want to keep them together.
Some charges would apply to the entire job (for example, collating or binding) while others (for example,
embossing the cover) would apply just to the cover job. Similarly, you might have an order for an unusual banner
that involves three separate jobs: printing the banner itself, sending it out to be sewn, and sending it out for
installation.
After you select the Multi-Part Job pricing method, you first provide some general information about the overall
job, after which you add the individual jobs that make up the parts of the overall job.

To create a multi-part job
1.
2.

Follow the general procedure for creating a job (see page 50) and select Multi-Part Job as the job
method.
Select the product. In the Product field, select the type of product the job represents. (You can use
Table Editor to define product types in the Products table.)
Note
If Product Type for Job is selected in the Mandatory Field preferences, the Product field
is outline in red. You must select a Product before you can save the job.

3.

If necessary, change the settings of the Brokered or Finished check boxes. (Brokered is automatically
selected if you create a job based on the outside service pricing method.) Identify if the job is Finished
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4.
5.

If you are using Tracker, in the Location field, select the area where the job takes place.
If the Product you select for a job is associated with a specific tax table (in the Products table), the Tax
Table field is (with some exceptions) set to that tax table.
6. If you are using Tracker, in the Location field, select the area where the job takes place.
7. If you need to change the pricing method for the job, select it in the Type field. (Other fields in the Job
Window will be affected by your selection.)
8. In the Comment field, enter any notes about the job.
9. Enter the description. The job method will default into the description field but it can be edited, removed
or added to.
10. Enter notes about the job. You can check the box to have notes included in documentation and invoice.
11. You can add charges for the overall multi job in addition to the charges that may have been added to
individual job parts.
12. Finishing operations (such as bindery) may have some associated waste. As you add charges to the
job, any associated waste is calculated and added to the Bindery Waste field. If necessary, enter a
different number in the Bindery Waste field, but avoid doing this until you have added all finishing
charges to the job.
Note
When a finishing charge is defined in sets, the waste is the number of sets (not sheets) that are
spoiled.
13.

In the Est Waste field, enter the number of sheets you expect to lose during the production process to
get the required number (Ordered quantity) of good prints.
Note
As you complete each job part be sure and select Confirm. This will add the job charges to the
multi-part job.
Each part of the multi part job can be different job methods and are defined when you create the part. Use the
“Add Part” button to add each part to the job.
When you select add a job, you will be taken back to the add job screen where you can select the job method for
that part. After adding a job, you can select the Go to Job Details button and you will be taken back to the multijob page where you can see all of the job parts and charges, including charges added to each job part.

Free Style Job
There may be times when you do not need a job ticket or estimate and just want to produce an invoice for the
customer. For a free style job all you enter is the job description, quantity and price.

Create Job from Account History
If you select Account History, then you will see a list of account historical invoices or you can select from historical
estimates. This is helpful for reprint jobs where the price may or may not have changed. You can narrow the
search by using the search fields at the top of the list to select from the posted date, invoice or estimate number,
description, cost or sales rep.
Note

For walk-in customers you will also see a column for account name.

Estimating | ⚫ 75

You will then see a new screen with the information from the historical invoice or estimate.Select the one you
want and then select NEXT. This will take you to the estimate summary screen. If the prices have changed since
the invoice or estimate was originally created you will be given the option to update the price definitions.

You can select the product from the drop down list.

The quantity will default from the original estimate or invoice but you can change it. The price will automatically be
recalculated based on the new quantity. If you need to make changes to the job you can select the job detail tab
and make changes there. For more informatiuon on the job detail screen see the prior section on the job method
that is appropriate.

Create Job from Templates
In the section on create from there are two views with different options. If you choose to use template
categories then you only see the options of Create New Job, Account History and Templates. If you do not use
template categories, then in addition to the others you will see the option of Job Templates. The check box for
Template Category View is under Preferences > HTML View.
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Without the Template Category View you can choose from Job Templates or Templates. For either one you can
then select invoice or estimate templates.

If you select job templates you will see all of the job methods and as you select the job method you will see the
templates that have been set up for that job method.

If you select for the Template Category View then when you select Template you will be shown the list of
template categories. You can select to show all templates or select a specific category and then you will see only
the templates for that category.
You can also use the column headings to search for specific templates, just start typing in the selected field.
In accounts you can identify templates or job templates for a specific account. When you search for templates or
job templates you will see all of the templates but you can use the column heading for customer to select the
account you want and then only the templates set up in the account will be shown. See Selecting Invoice and Job
Templates under Accounts on page 159.

You can create a template category from the template list (see page 20) or when you create a template from an
estimate on the estimate summary screen (see page 82)
After selecting the invoice or estimate template, the new estimate screen is opened. If there has been a price
change in any of the operations or material since the original invoice or estimate was done you will get an alert
and you can decide to have the new estimate updated with the new price or keep the old price.
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Account information
You should always review the information in this window, provide any missing information, and make any
necessary corrections.
Note
If any account or contact fields are required (as specified in the Mandatory Field preferences), you
must provide this information before continuing. This applies to the walk-in account, too. If there is a Red box
around the contact area that indicates that there is some missing information regarding that contact. User will not
be able to proceed until the mandatory information is filled.
Review the Invoice Address; if necessary, click Edit to change it. Doing so changes the address only in the
document, not in the customer account.
Note
You can change the account name and address if Can change address on ALL document’s
preference is selected in the Estimator Behavior preferences (Admin > Preferences > Estimator > Estimator
Behavior).
The Contact field includes information about the invoice contact from the selected account. If necessary, do one
of the following:
Note
A temporary contact is not added to the customer account. In addition, if PrintSmith is integrated
with SugarCRM, temporary contacts are not sent to Sugar. For more information, see the PrintSmith Vision –
SugarCRM Integration Guide.
•

If the contact you want to specify is not in the Contact List, add one by clicking New (or by selecting
File > New) and completing the Edit Contact window. This new contact is added to the customer
account when you save the document.

Add
Contact

Edit contact

Account Status and Type
You can identify the status of the account and the types of payments that will be accepted from that account.

Invoice and Delivery Address
In addition to the contact information you will also se the invoice address and delivery address. The invoice
address cannot be changed from this screen and must be changed in the customer account information. From
the Quick Access Screen in the Legacy version select account and the select the account from the provided list
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and then you can change the invoice address using the edit option. Changing the invoice address in the customer
account will not change the address in the estimate account information. You will need to create a new estimate.

You can change the delivery information by either selecting from Contact list if there are other contacts already
set up or you can enter a new delivery. To enter a new delivery address select the optio of Other and that will
then open the option to edit delivery.
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Internal Information
There is also some internal information that is needed for this invoice.

1.

The Taken by field identifies the person who created the document (based on the user name entered to log
into PrintSmith Vision). If necessary, change this name.
Note For better job tracking always log in as yourself; do not share your login with other users.

2.

If you selected an account for the document, the name of the sales representative associated with the
account is displayed in the Sales Rep field. If necessary, select a different representative.

3. If necessary, in the Hold field, select a hold state if the job needs to be held or the customer is on credit hold.
You can see hold information in the Work in Progress report (see page 147 for more information on WIP).
(You can edit the Hold State table with Table Editor to include the kind of states that apply to your business.)
4. If necessary, select a Lead Source. (You can edit the Lead Source table with Table Editor to include the kind
of leads that apply to your business.)
Note
When you convert an estimate to an invoice the selection in the Lead Source field is kept; if you copy the
document to a new invoice or estimate, the value is not kept.
5,

If necessary, in the Proofreader field, enter the name of the person doing the proofing.
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Missing Information Warning
If any information is missing you will see a warning and the area for the missing information will be outlined in
red.
Note

Until user adds the missing information they will not be allowed to switch to another tab.

Estimate Summary
There are several features available from the estimate summary screen.

Adding Free Style Items, Jobs or Charges to an Estimate

Add Free Style Item
Sometimes you may have a situation where a customer is ready to place an order but they do not want to wait
while you enter all the information needed to create a job. This works well if it is something basic such as a
business card or stationary where you know the price and the specs. You can provide the customer with an
invoice and then later fill in the job specifications. In this situation, you will select ‘Add Free Style Item’
•
•
•
•
•
•

To enter a Free Style Item:
Select the product
Enter a description
Enter a quantity
Enter the item total charge. The unit price will be calculated form the quantity ordered and total cost
Select if the line item is to be taxed or not.

After adding Free Style job and saving the estimate you will get the option to convert to job. The Price of the
Free Style job is automatically locked. To make changes to the job you will need to unlock the item by clicking
on the lock.

Estimating | ⚫ 81

After converting the job, you will be directed back to the job detail screen. On the job detail screen, you can
change the job method and add the required job information, you can also mark the job has Finished and
Brokered. You can add charges to the job.
Note
User is not allowed to Add charges to Free Style job before saving and converting to a job.
However, once the job is converted you can add the charges.

Add job
Adding a job will take you a screen where you can select how you want to add a job. It has all the same options as
the original new job screen.

See the information on “Adding a job” starting on page 80. After adding the job, it will be reflected in the total
estimate.

Add Charges
Charges are set up in the Legacy version. Go to Pricing > Charge Definitions.
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Note
When you are adding charges or modifying any existing charges, make sure to click on Confirm
button and Done button to save the charges to the Estimate.

Create Account from a Document
This is only available with Walk-In accounts. When you have an estimate or invoice from a Walk-In account and
want to make them a new account you can use this feature. You must have a company name an address for this
account.

Save as a Template

1.
2.
3.

Select if you are creating an estimate or job template.
Enter the template name
Select the template category from the dropdown.
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If you create a job or estimate and anticipate using it in again you can create a job or estimate template. A job
template consists of a single job and all the setup and finishing charges for that job. An estimate template
contains all of the information from the original estimate. Templates can be used many times. You can create an
estimate from a template and then make changes to that estimate as needed.
You can also create templates for multi-part jobs. In this case, the template contains the overall job, its charges,
and the parts (jobs) that make up the overall job, as well as their charges. For any repetitive jobs, templates save
time and reduce errors.
Note

To see how to “Create Template Categories” see page 20.

Templates can also be associated with customer accounts (on the Templates tab in the Customer window). This
facilitates the process of selecting a template when working with an account.

Copy to a new estimate
This option allows you to copy the entire estimate over to a new estimate. You will get a warning if you have not
saved prior to copying.

Email Estimate
Selecting this option will first save the estimate if it is not already saved and then open an email window with a
preset message.

Estimating Notes
You can enter estimating notes
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Print Estimate
Note:
Estimate must be saved before printing. If you select print estimate before saving the program will
save the estimate automatically.
You can also define the style to be used for the printing.

You can print an estimate also from Pending Documents.

Change Account
You can change the account for the estimate. Click on the account name and then use the drop down to select
the new account. You can also type in part of the name.
Note

Change account is only available from the Account Information screen or Invoice/Summary screen.
The user must have permission to change an account.

One portion of the estimate summary screen is minimized by default use the arrow at the bottom to display this
portion of the screen.
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Special Instructions
You can enter special instructions that will appear on the estimate.

Sales Categories
This shows the invoice sales breakdown for each sales category
Note
The total for the sales categories comes from the invoice item total and not the invoice total that
could include taxes, discounts or markups.
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Dates

You can mark the wanted date as firm and mark to file the originals.

User can select\update the shipping method here from dropdown.

When the PO number is mandatory then the field would be highlighted so that user can enter the data, Warning
is not displayed when an Invoice is saved. However, when user tries to pick up the Invoice the following warning
is displayed.
“Orders for this customer require a Purchase Order. Please enter a PO#.”

Price Information
The Price information area shows the estimate totals. To enter a shipping amount, enter or change a customer
discount percentage, select a different tax table and tax code click Edit (plus sign after label)
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There are several options in the section for the price information section
You can add a discount or markup by selecting the plus sign. It can be entered as a percentage or a fixed
amount.

Note
If the account had a one-time discount defined, and you indicated you wanted to apply it when you
created the document, the discount is shown in the Discount Amt field, and the Apply one-time discount
check box is selected. If no discount was defined, you can enter one now.
You can add a delivery fee.
You can add or change a sales tax by selecting the plus sign.

Selecting the No Tax check box will result in zero tax for the invoice/estimate.
If the customer is taxable you can still identify which lines are to be taxed and which are not.
Note:
At charge level user needs to open the charge and check if it’s taxable or not. Identification mark is
not available

You can also change the customers tax exemption status
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Command line option
You can lock the price

This locks the price for all items on the estimate. You can unlock the price for all items by changing it here.
When the price is locked it will display a lock for each line item

You can unlock the price for an individual item by selecting the lock
If there is a royalty associated with this estimate you can make it exempt.
Click Recalculate to update each job and charge in the document with the latest pricing information and then
recalculate the entire estimate.
From each line item you have other options.

Specifying multiple quantities with different job specifications
If you want to add multiple quantities for a job or want the ability to change job specifications for different
quantities, use the Multi-Qty field in the Job window as follows:
When creating a job in an estimate, enter the first quantity in the Ordered field, provide other information about
the job, for the next quantity in the same job, click + next to the Quantity field, click to add another quantity, enter
the second quantity in the Ordered field, change other information about the job as necessary. Click Confirm.
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If you want to estimate multiple quantities from the estimate summary screen use the Add Multi Quantity option
available for each line.

You can edit the description using this icon to the right of the trash can

Note
If you have multiple lines on the estimate summary screen you can change the sequence of the
lines by clicking and dragging the description.
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Cost Tab
Cost is the amount you spend to produce the order; price is the amount you charge your customer. The
difference is your profit.
Although PrintSmith Vision does not require you to enter your costs, without them you will not be able to see
where you are making (or losing) money.
You define costs in your pricing definitions:
•
•
•

For charges, costs are entered by clicking Costing in the Charge Definitions window.
For digital definitions, costs are entered in the Cost Plus area of the Digital Definitions window.
For stocks, costs are entered on the Specification and Pricing tab in the Stock Definitions window.

Notes EFI recommends that you build most of your profit into labor rather than having very high stock markups
to compensate for a printing labor rate that is too low.
You can change costs in a locked document (one that is in history).
After you select charges, stock, and a press or printer for an order, the costs associated with your selections are
calculated as estimated costs. If you use Tracker, it will calculate actual costs for you; otherwise, you can enter
the actual costs manually if they differ from the estimates. You can review the estimated and actual costs in the
Costing window as described below. On the estimate summary section there is also a cost tab. The estimated
cost, actual cost (once the job is complete), the difference, selling price and job margins is displayed for each line
item. Cost is the amount you spend to produce the order; price is the amount you charge your customer. The
difference is your profit.

Entering actual costs
Although PrintSmith Vision does not require you to enter your costs, without them you will not be able to see
where you are making (or losing) money.

To review or enter actual costs
1.
2.

When a document is open, On Estimate summary tab click on Costing button.
Review the costs.

3. If you know the actual cost then click the Actual column and enter the actual cost. Blue identifies costs
that you entered. Red alerts you that an item was priced below cost. The margin will automatically
recalculate.
If there are additional charges using the arrow on the left hand side will open the display to show those items
also.
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Saving an estimate
Until an estimate is saved, you will see the message at the top of the screen that the estimate is not saved. Make
sure to save the estimate after any modification.

You should then see the message that the estimate has been successfully saved.
Note
The message will only stay on the screen for a few seconds and then disappear
Once the estimate has been accepted you can convert it to an invoice.
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Invoicing
Creating Invoices
As mentioned earlier several of the screens, features and methods of creating an invoice are the same as
creating an estimate.
The steps for creating a new invoice that are the same as creating an estimate are
•

Selecting the account (See page 48)

•

Creating a new job (See page 50)

•

The only option available in invoicing that is not in estimating is the ability to print the job ticket. (See
page 97)

•

The accounting tab is the same (See page 77)

•

There are some differences in the summary tab and those will be discussed below.

•

The costing is handled like it is in estimating. (See page 90)

Invoice Summary

On the invoice summary screen there are several command options. You have the option to add to the new
invoice items that were not on the original invoice or not part of the job specifications. You can add a freestyle
item, a job or a charge. You can also copy everything to a new invoice at this level.

Add Free Style
Add Job

Save as
Template

Copy

Raise PO
for Invoice

Invoice
Notes

Email
Invoice

Print Job
Ticket for
Invoice

Add Charges
Add free style, add job, add charges, save as a template, copy, email and print invoice are all the same as in
creating an estimate. See this information beginning on page 80.

Copying purchase orders when copying invoices
When you copy an invoice and the invoice has purchase orders associated with it, you can choose also to copy
some or all of the purchase orders to the new invoice. If you know you will need to purchase goods or supplies
for the new invoice, the ability to copy the purchase orders saves you time – you can just make some minor
changes (such as due date) and re-issue the purchase orders.
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1. When an invoice with purchase orders is open, select Invoice > Copy to New Invoice. A message asks if you
want to copy the purchase orders.
2. Click Yes to copy the purchase orders along with the invoice or No to just copy the invoice.
If you clicked Yes, the Invoice PO List window opens and lists all the purchase orders that were created for the
invoice.
3. To select all the purchase orders, click the top check box; to select individual purchase orders, click their
check boxes.
4. Click Duplicate.
5. When asked, update pricing if necessary (recommended).
6. Click Save to save the new invoice. A message informs you that purchase orders were copied to the invoice.
7. Edit the purchase orders as described in “Reviewing, editing, and copying purchase orders” on page 152 and
then print or e-mail them.

Raise a PO
If you need to have an outside purchase for part of all of the job, then you can create a purchase order.
Selecting Raise a PO will take you to a screen where you can enter the information about the purchase.

Add a Line
Item

You can select the vendor from the drop down.

Create a
New PO

Email

Print
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NOTE
In order for a vendor to be displayed for a PO they box labeled” use for purchasing” in the vendor
record must be checked.
NOTE
You must enter the wanted date before you can email or print the PO. If you are going to email then
you must have an email address in the vendor record.

When you add a line to a PO you will get a new short cut menu screen where you can enter the information for
the new line item.

Once a purchase order is saved you can access it again using this feature.

For each line item you can edit it, mark as complete or delete the item
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You can also use the check box next to the items to Delete or Mark as Complete. If you check the box above the
items, it will select all items.

You can have multiple purchase orders for one invoice. Just create the first PO, enter the information includi ng
the due date and save. Then you can create another PO by using the NEW button. Then all of the purchase
orders will be listed and available.

Tax
You can now choose to have tax displayed for purchase orders. To activate this feature, go to the Legacy
version > Preferences > HTML view and check the box to Enable Tax for Purchase Order. There is a warning
associated with this selection.

With the tax box checked when you open a purchase order the tax will be displayed.
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Note

Since the tax option was not available in prior versions theses fields will be disabled for older views.

You can now edit the Quantity, Unit Price and Sub Total fields. If you change the sub total then the unit price will
recalculate, if you change the unit price the sub total will recalculate and if you change the quantity the sub total
will recalculate.
The taxes are also displayed in the total.

The default ship to address for the PO will be the same as the company address. Selecting the pencil icon will
allow you to edit either the bill to or ship to address.

If you want to use the Invoice address as the Delivery Address use the toggle to make that selection.
If you change the delivery address when you are using the invoice delivery address you will get a warning
message asking you want to also change the invoice delivery address to this new address

You can also raise a PO for a line item.
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Invoice Notes
Selecting this option will give you a short cut menu where you can enter notes on the invoice. These are internal
notes and will not show in the invoice.

Email Invoice
Selecting this option will save the invoice if it is not already saved and then open an email window with a preset
message.

Print job Ticket for invoice.
This option will print job tickets for all the jobs on the invoice.

Resequencing line items
You can now re-sequence the line items by clicking and dragging the description.

In the second screen shot you can see that the courier was moved down to after hand folding and drilling was
moved above hand folding.
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If the customer is taxable you can still identify which lines are to be taxed and which are not.

Sales Format
This displays the different options of how the invoice will print when the print invoice button is selected.

You can select\update the shipping method here from dropdown.
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If the customer has a resale number, it can be entered here. You can enter the customers purchase order
number. When the PO number is mandatory then the field would be highlighted so that user can enter the data,
Warning is not displayed when an Invoice is saved. However, when user tries to pick up the Invoice the following
warning is displayed.
“Orders for this customer require a Purchase Order. Please enter a PO#.”

You can mark the due date as firm

Under User Preferences there is a listing for Summary configuration. Here you have the option to expand the
Estimate/Invoice Summary or not. The estimate summary and invoice summary screens have a portion of the
screen that is collapsed. If you check this box then it will open the summary screens expanded and if unchecked
the summary screens will open with it collapsed.

Price Information
The Price information area shows the invoice totals. To enter a shipping amount, enter or change a customer
discount percentage, select a different tax table and tax code click Edit (plus sign after label)
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There are several options in the section for the price information section
You can add a discount or markup by selecting the plus sign. It can be entered as a percentage or a fixed
amount.

Note
If the account had a one-time discount defined, and you indicated you wanted to apply it when you
created the document, the discount is shown in the Discount Amt field, and the Apply one-time discount
check box is selected. If no discount was defined, you can enter one now.

You can enter a delivery fee.
You can add or change a sales tax by selecting the plus sign.
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Selecting the No Tax check box will result in zero tax for the invoice/estimate.
You can also change the customers tax exemption status
If you have multiple tax tables for an invoice it will be identified on the invoice summary screen

They will be identified separately on the printed invoice.

You can add deposit to the invoice

You can add up to three deposits, identifying them by payment method and a reference number.

102 ⚫ EFI Productivity Suite | PrintSmith Vision User Guide

Command line option
You can lock the price

This locks the price for all items on the invoice. You can unlock the price for all items by changing it here.

When the price is locked it will display a lock for each line item

You can unlock the price for an individual item by selecting the lock
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If there is a royalty associated with this invoice you can make it exempt.
Click Recalculate to update each job and charge in the document with the latest pricing information and then
recalculate the entire invoice.

Saving an invoice
Until an invoice is saved, you will see the message at the top of the screen that the invoice is not saved. Make
sure to save the Invoice after any modification.

If this customer has “Require purchase order” enabled in Account setup then when you try to save the invoice you
will get an alert that a purchase order is required.
Note
Be sure to update all mandatory fields before saving the invoice
You will need to enter the customer’s purchase order number before saving.
You should then see the message that the invoice has been successfully saved.
Note
The message will only stay on the screen for a few seconds and then disappear

Delivery Ticket
On the invoice summary screen in the line item you can access the delivery ticket
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Here you can verify delivery address, change the location of the item and mark it as shipped

You can also enter the shipping information

You can also produce a new delivery ticket, print a packing slip and shipping label.

You can search for a different delivery ticket through search option provided at top of the window
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When you search for a delivery ticket you will be taken to that ticket in pending documents.

The delivery ticket allows you to change the location of the product and mark it as shipped.

You can check the box for an item and then mark it as shipped.
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Recording Notes About Orders
When you are working in a document window, you can use the note pad to record notes related to an order.
For example, if you are taking an order over the phone, you may want to jot down some notes so you can
complete the document later. Similarly, if you purchased stock at a special discount and passed some of the
savings onto the customer, you could record this. If the customer placed the same order again, and the stock is
priced normally, the customer might question the price. The note you recorded would remind you of the reason
for the price difference. In addition, if you lock prices, you may want to note the reason for doing so.
Note
You can change information on the note pad even if a document is locked.
Except for the wanted by date (entered in the When field), none of the information you enter on the note pad is
used in the document, but you can use the note pad to guide you in creating the job. The notes are saved with
the document so you can return to them later when you have time.

To record notes
1.

Click Invoice Notes on the toolbar in the document window.

2.

Enter or modify information in the note fields: Who, Phone, What, How Many, What Size, Paper,
Notes, and When. (When corresponds to the wanted by date.)

3.

If you want the note pad to open automatically whenever you open the document, select the Show
Note Pad when document opens check box.

4.

Click OK.

Note

For detailed information on functionality please refer to PrintSmith Vision setup and User guide.
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Cash Register
Settings
Customer Payment Options
You can only use payment methods that have been approved for that customer. To access the set-up program
for accounts, go to AR at the top of the main screen and then select Accounts.

Select if you are searching for customers, prospects or contacts.
Next select the account name

This will take you to the screen where you can set up various customer preferences and controls.
Under Credit Control you can set up the types of payments that are available to that customer.
Note

Be sure and save your settings.
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If you have the customer set for cash only then the Cash Register program will show that as the default option.
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Credit Card Surcharge
You should also set up any surcharge you want to add when the customer pays by credit card. To get to this
setting go to Admin > Preferences.

Under Preferences select Credit Card Info. This will display a screen where you can set up different surcharges
for different credit cards. These can be based on what your credit card processor charges you. This is not
considered income since it is paid to the processor. The surcharge will apply for all customers. Be sure and save
before closing.
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Receiving Payment
The first step is to identify the customer. You can enter a few characters of the customer’s name and it will show
you those that fit.
Next you will need to add invoices that are to be paid with the payment received.

You will then be shown a list of the unpaid invoices for that account. Use the check boxes on the left to identify
the invoices you want added to the cash register. After the selection use the Add to Pick Up button to place those
invoices in the cash register

If you know the invoice number, you can also enter it manually

Next select the payment method
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Payment by Check
Select the check payment method and enter the check number. The Amount Paying will default to the total of the
added invoices.

After you select the Receive Payment button you will get the option to print a receipt, select the print format for
the receipt or email the receipt. When that is complete, select Post.
Each invoice will print a separate receipt and when you are finished with them you will get an information
message that the transaction processed successfully.

Payment by Cash
The only difference in receiving a cash payment is if you are in a country where cash is rounded to the nearest 5
cents. This is set up under Admin > Preferences > International. Check the box for Use Australian Cash Register
Rounding. This will cause cash receipt to round to the nearest 5 cents and any difference will show in rounding.
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When paying by cash it rounds the 94.93 invoice to 94.95 with .02 going to rounding.

Payment by Credit Card
You can use CardConnect® as your card processor. For more information on use CardConnect® see the
document for CardConnect® Integration. CardConnect® is a third-party credit card processing company. For this
document we will go through the steps of using a credit card regardless of the system you use to process the
card. In the case of CardConnect® a reference number will be supplied directly to the cash receipts program. In
other cases, you will need to enter the reference number you get from you credit card processing company.
You can select the credit card type and then enter the reference number. To get the reference number you need
to go to your merchants account screen and make the payment. You will get a reference number or approval
number that is then entered in Cash Register.
After entering the reference number select Receive Payment.

If you try to process the payment before entering the card transaction reference number you will get a warning
that the card will not be processed.

Charge Accounts
A transaction can be charged only if a customer account is selected for the transaction and the account allows
charges. This type of transaction is called a POS charge. A POS charge commonly occurs when a regular
customer comes in, makes a small purchase, and asks you to charge it to his or her account. It is neither cost
effective nor efficient to create a standard invoice for a small amount. Furthermore, you do not want the account
history full of small transactions because it makes the history less useful. To see how to set up the account to
accept charges and to set the credit limit for the account see the Payment Options set up starting on page 158.
PrintSmith Vision maintains a special balance, called the merchandise charge balance, in each account for these
small POS charges. These charges do not appear on statements. At the end of the month or some other suitable
occasion, you should use AR > Post POS Charges to print a special statement composed of all POS charges.
As part of this process, PrintSmith Vision makes a single entry in Accounts Receivable for the entire amount in
the merchandise charge balance so the payment can be posted and included on statements.
You can set up charge accounts for customers and then you can charge the invoice to those accounts. Charge
an account does not impact your AR, you will need to post payments for the charged amount in the Post
Payment application.
Select Receive Payment and that will give you a new screen where you can Post the charge.
When the customer pays their charges you will use Post Payments to process that payment.

Department Charges
In addition to invoices you can add department charges. These are typically items purchased that are not part of
the job such as boxes. To create a department charge go to Preferences > POS > Cash Register in the Legacy
version. Here you can create a department charge by entering the name, selecting the sales category, enter the
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charge for the item if you want and selecting the taxing method. Be sure and check the box to the left of the
charge so that it will be available.

To add a Department Charge, fill in the information on the screen and select Add. If the price is not already
defined you will need to enter the unit price and the quantity.

Once you have identified the method of payment and selected Receive Payment you can print or email a receipt
and Post the payment.
Regardless of the payment method you have the option to print or email the invoice to the customer. You will
also have the option to use the customized email and attach the invoice and receipts. See page 24 for
information on created customized emails and how you can automatically have invoices and receipts attached to
that email.
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Post Payments
Applying Payments to Invoices
If you picked up and posted an invoice under Cash Receipts and charged that invoice to an account then later
when the customer pays for that invoice, you must apply the payments against the invoices so they are recorded
as Accounts Receivable receipts. This process reconciles the money you received with the money that was due
(as recorded in your invoices). In PrintSmith Vision this is known as posting payments.

Why posting payments is important
A common mistake when first getting started with PrintSmith Vision is to enter payments while picking up
invoices without applying them to invoices. This has some undesirable side effects:
•
•
•
•

Invoices that were paid are still shown as open and may cause the account to become past due when it
really is not.
The list of open invoices can get long making it more difficult to find an invoice to apply payment to it.
Customers may not understand statements that include invoices they think they paid.
The receipt is considered “on account,” and is not included as a taxable cash receipt in Accounts
Receivable.

Posting payments
To post payments first select the account. This will then display the invoices that have been charged to that
account.

Notify
Customer/
Follow Up

Clear
and
refresh
the
page

Selecting Invoices for Payment
After you select the customer you will see the invoices that have been charged to their account as well as their
status. If you want to see more detail about the invoice, select Properties. In properties you can edit the
description. You can also edit the description from the line item by selecting the pencil to the right of the three
dots.
Next select the payment method they are using. Only the payment methods you have approved for that customer
will be available options.
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After the payment method has been selected you have several options as to how to record payments to the
invoices. This is the same process regardless of the payment method selected but some of the payment
methods will need additional information that is discussed in the portion for each method.
1.

Note
2.
3.

Using the check boxes to the left of the invoices you can select the invoices to be paid and then select
“Calculate Payment”. The program will enter the amount paid on the selected invoices in the right-hand
column labeled PAY and enter the total of those invoices in the amount receivable.
If you select the top box next to REF it will select all invoices.
You can enter the payment amount in the Amount Receivable field and select Auto Apply and the
amount will be applied to the oldest invoices first.
If the customer is making partial payments to invoices, then you can select the field for that invoice
under pay and a field will open to allow you to enter the amount of payment for each invoice. Then
select Calculate Payment and the total will be entered in the Amount Receivable field.

Tip
You can select invoices before you enter an amount and then click Calculate Payment on the
toolbar, so the Amount is calculated automatically.

Payment Method
Payments by Cash
Enter the amount of cash received and you can either use Auto Apply or select the individual invoices to which
the payment is to be applied.

Payment by Draft
Enter the reference number you received from the bank and then proceed to identify the invoices as the
procedure above outlined.

Payment by Check
Enter the check number and then select the invoices.

Payment by Credit Card
If you are manually processing the card outside of EFI PrintSmith Vision you will select the card type and enter
the reference number you got from your card processor.
If you are using USA ePay or CardConnect® then select the card icon to the right of the reference number field.
You will then get a pop-up box where you can either manually or automatically process the card depending the
option chosen. If you are not given a reference number you will need to enter one.
For more information on using USA ePay or CardConnect® see the documentation on those specific processes.
After selecting the payment method and the invoices select Post Payment. If the customer still has an amount
due the program will default to the remainder going on account. If the customer overpaid on the total amount
due, then you will need to select how the refund is to be handled but using the dropdown for that field.

Handling refunds
If a payment is greater than what the customer owes, the Remainder field in the Post Payments window lets you
indicate how you want to handle the overpayment.
•
•
•
•

•

You can select one of the following in the Remainder field:
On account: The overpayment is not refunded but is posted to the account as an unapplied credit.
Return cash: Cash is refunded and subtracted from the cash total in the PrintSmith Vision “cash
drawer.”
Write check: A check is written. Since PrintSmith Vision does not handle check writing, it records only
half the transaction. It adds the refunded amount to the account balance and the AR balance, but does
not record a negative receipt. Instead, a special refund check is shown during daily closeout and is
printed on the deposit ticket. The Daily Sales report includes a Refund Check category to show the total
amount of refund checks during the period.
Credit card refund: A negative amount is applied to a credit card. This is recorded in the cash drawer
credit card category and is a separate item in daily closeouts.
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•
Note

Direct Deposit: You will need to enter the reference number of the deposit.
The remaining selections in the Remainder field are credit card refunds for a specific card.

Issuing a refund for overpayment
Problem: You receive a check from a customer to pay for a group of invoices, one of which was already paid.
You agree to send the customer a refund check.
Solution:
1. In the Post Payments window, enter the amount of the check as written.
2. Select the items that are to be paid.
3. In the Remainder field, select write check. This refunds the amount of the overpayment with a check,
which you must write later. (Checks are not written in PrintSmith Vision.)
4. Click Post.
Alternatively, if your customer agrees, you can leave the overpayment on account and apply it to later sales; this
is the recommended method as no special action is required. You can access the screen to make journal entries
from here or you can use the quick buttons on the left of the screen. Go to accounting > AR > Journal entries.
For more information on making journal entries see the section on journal entries beginning on page 118.
The section on the lower left-hand corner of the screen gives you the option of printing a receipt or emailing the
invoice. You can select the format to be use

Issuing a refund on a paid invoice
Problem: You receive a complaint from a customer about an order for which the customer already paid and
agree to refund part or all of the order by sending the customer a check.
Solution:
1. In the Post Payments window, select the invoice that you are refunding and click Add Journal Entry. (For
more information about journal entries, see page 118.
2. Make the appropriate correction and click OK. The Post Payments window opens, and both the invoice
and journal entry are highlighted.
3. In the Remainder field, select write check.
4. Click Post.
To email an invoice to the customer
If you have set up customer email formats, then you will see the option for customize email. For information on
how to set up custom mail see page 24.
To print a receipt
a. Select the Print Receipt check box.
b. Make sure a printer is selected in the Current Printer field on the toolbar. (This field is displayed only
when the Print Receipt option is selected.)
Note
By default, Current Printer is set to the printer selected in the cash drawer preferences (reference
from flex side), but you can select a different printer if you have more than one receipt printer. All users who log
into PrintSmith using the same browser will see the same printer selected. This printer is also automatically
selected in the Cash Register and Invoice windows. If you click Restore Settings in the Post Payments window,
the printer reverts to the default preferences.

Notify Customer
This will allow you to create an activity to notify the customer.
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You can choose from pre-defined activities and a note will be added to the customer account log.

Follow-up required gives you the opportunity to enter a follow up date and who is to follow up. You can also enter
follow-up comments.
Completed allows you to enter the date complete, completed by and the action taken.
You can email directly from this screen.

\
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Journal Entries
General procedure for making journal entries
This section provides general information about making journal entries and some examples of particular types of
journal entries.
1. Select AR > Journal Entry. The Journal Entry window opens.
Tip
In situations where you need to adjust a locked invoice, you can open the Journal Entry window
directly from the Post Payments window.
2. Complete the top part of the window:
a. Depending on what you need to do, click Select Customer to select an account or click Select
Invoice and enter the number of the invoice you want to adjust. In the case of an invoice, the account to
which the invoice was posted is displayed, and a reversing entry for the invoice is set up. If all you want
to do is write off an invoice, just click Update & Post.
b. If you want to print a credit memo for the journal entry (for example, to give to a customer to show
that you credited the account), leave the Print Document check box selected. The credit memo will be
printed after you click Update & Post.
c. If you want to e-mail the credit memo, select the E-Mail check box. For more information about emailing credit memos, see page 119.
d. Customize email. You have the option of creating a customized email. For more information on this
see page 24.
e. Leave the Affect Sales check box selected so that sales totals are updated as a result of the journal
entry.
Warning
A journal entry that does not affect sales can unbalance your books. The only time you
should clear the Affect Sales check box is while entering beginning balances when first setting up the
system, for a job the customer refuses at pickup, or if a customer’s check does not clear. If you are not sure
whether sales should be affected, consult an accountant to learn if your sales need to be reduced, or if a
deduction should be taken at tax time.
f. Leave the Update Customer Statistics check box selected so that the customer’s sales statistics are
adjusted when you post the journal entry. This is intended primarily as a means of adjusting total sales
when you write off an invoice. The system also adjusts the document count used to calculate the
average order and ratio of estimates to orders if you use the Select Invoice button to set up the entry.
3. Review and/or change the distribution amounts (journal entry details) and the memo totals.
Each distribution amount is added to the Sub-Total and the Tax Sub fields unless you override the Tax Sub
amount. Sales tax is recalculated after each change. When Tax Sub does not equal Sub-Total, they are shown
as overrides, and changes that you make in the detail fields do not change Tax Sub. You can either remove the
override from the Tax Sub field by deleting it (PrintSmith Vision then synchronizes Tax Sub with Sub-Total) or
you can manually adjust Tax or Tax Sub.
Note
If you change Tax Sub so that it differs from Sub-Total, distribution amounts that you enter
subsequently will update Sub-Total but not Tax Sub. Both Tax Sub and Tax are shown as overrides. This is
useful when backward calculation does not generate exactly the amount you need, or when only part of the
journal entry is taxable.
You can ignore the distribution amounts and enter amounts in the totals section directly. If you enter an amount
in the Sub-Total, Total, or New Balance fields, the rest of the memo is calculated backwards. This is useful if
you already know what you want the end result to be.
For example, if a customer has a balance of 72.46, and you want to write off the entire balance, you can enter 0
in the New Balance field, and a memo is generated to arrive at that balance. In this case, the total amount of the
memo is 72.46 (a credit memo). If the Taxable check box is selected, the system calculates the subtotal needed
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to generate a taxable amount that, when taxed and added together, equals 72.46. If the tax rate was 6%, the
subtotal would be 68.36 and the tax 4.10. If the Taxable check box is cleared, the subtotal is the same as the
total.
4. The Description field includes some default text; change it if necessary (up to 255 characters). This
description is used in account history and in credit memos.
5. If you contact the customer whose information you are viewing in the Journal Entry window, log the
interaction and, if necessary, indicate that follow-up is required:
a. Click the Notify icon. The Notify Customer window opens.
b. Complete the Notify Customer window.
6. In the Sales Rep field, select a sales representative if the journal entry affects the commissions earned by
that sales representative.
7. In the Comments field, enter a detailed explanation of the reason for the journal entry, for example, Bad
check. The comment is included in printed credit memos.
8. To change all positive numbers to negative numbers and all negative numbers to positive ones, click
Reverse. For example, if you receive a bad check, you do not want to remove the record, but you do want to
add back the debt to the customer’s account.
9. To zero all fields in a journal entry that are not related to taxes, click Only Tax. Typically, this button is
used when adjusting (adding or removing) tax from an invoice. Everything is zeroed except Tax Sub, Tax,
and Total.
10. To write off a percentage of some known amount, enter a percentage in the field to the right of the Calc
Adjustment button, and then click Calc Adjustment.
11. When the journal entry is set up the way you want, click Update & Post.
12. If you initiated the journal entry from the Post Payments window (see below), you automatically return to
the Post Payments window where the original entry and the journal entry are automatically selected and
ready to be posted. Click Update & Post. to apply one to the other.

Originating journal entries from the Post Payments window
When you need to adjust invoices that are locked because you already performed a closeout, you can simplify
the steps in making a journal entry by starting the process from the Post Payments window.
1. In the Post Payments window, select an account.
2. Select the invoice you need to adjust and click Add Journal Entry. The Journal Entry window opens, and
information from the selected invoice is displayed in negative format, ready to be adjusted.
3. Make the necessary adjustments and click Post. For examples of the types of adjustments you may want
to make, see “Journal entry examples” starting on page 120.
4. After you click Post in the Journal Entry window, the journal entry is added to the Post Payments window
which re-opens automatically. Both the original invoice and journal entry are selected and ready to be
posted. Click Update & Post to apply one to the other.
You can print and email the credit memo. If you want to email you have the option of the standard email template
of you can customize the email template.

E-mailing credit memos
When you post journal entries, you can e-mail the credit memo for the posted journal entry (and/or print the credit
memo).
In addition:
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• The invoice contacts for your accounts must have e-mail addresses.
• The E-Mail check box must be selected in the Journal Entry window before you post the journal entry.

When you e-mail a credit memo from the Journal Entry window, it is sent directly (you cannot review it before it is
sent). By default, the credit memo is sent to the contact for the invoice or the invoice contact for the account.
If the Credit Memo log text field in the E-Mail preferences includes text, e-mailed credit memos are logged in
the customer account (on the Log tab).
If the Credit Memo log text field in the E-Mail preferences is blank, e-mailed credit memos are not logged.
If the Use log text for subject and file name check box is selected in the E-Mail preferences, the Credit Memo
log text is also used for the subject of the e-mails and the name of the PDF attachment (the statement). If the
Use log text for subject and file name check box is cleared.
For more information on credit memo email templates and custom email see page 23.

Journal entry examples
This section provides some examples of journal entries. Many of the examples assume you are familiar with the
Sales Summary report. In this report, sales information is on the left and receipt information is on the right. You
can use journal entries to adjust them both. (To run the report, select Reports > Daily Sales, select Sales
Summary, and double-click the date for which you want the report.
Tip
Remember that if you are creating a journal entry for a locked invoice, you can initiate the process
from the Post Payments window as described in “Originating journal entries from the Post Payments window” on
page 114.

Writing off an invoice as un-collectable
If a customer refuses a job, you must write off the invoice. The invoice still remains in the customer’s account
history but is taken care of from an accounting perspective.
1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be canceled. A
reversing entry for the invoice is created.
2. Make sure the Update Customer Statistics check box is selected.
3. Click Update & Post.
4. Select AR > Post Payments and then select the account with the bad invoice.
5. Select the memo and then select the invoice. Alternatively, if these are the only two open items, click
Auto Apply.
6. Click Update & Post.
Tip
To avoid basing a new invoice on the bad (refused) invoice, EFI recommends that you enter a note
about the invoice in the account history to clarify it was a bad invoice.

Writing off an entire account balance as un-collectable
If a customer goes out of business, you must write off the entire account balance.
1. In the Journal Entry window, click Select Customer and select the account you want to write off.
2. Clear the Affect Sales check box.
3. Enter 0 in the New Balance field. If the Taxable check box is selected, the entire amount due is treated
as taxable sales. You must manually calculate the taxable amount if only part of the balance is taxable.
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4. Enter an appropriate description and click Update & Post. The journal entry is posted. At this point, sales
are adjusted, a negative adjustment to new charges is made, and the account balance is 0.00. There are still
open items, however, which you should “pay” off with the journal entry you just created.
5. Select AR > Post Payments and select the account you are writing off. There may be several open
items. The last open item is a journal entry, the one you just created.
6. Click Auto Apply to select all of the open items.
7. Click Update & Post. The account balance is unchanged, but there are no longer any open items.

Handling a bad check
If the customer gave you a bad check, you must make a journal entry to add back the debt to the customer’s
account.
1. In the Journal Entry window, click Select Invoice and select the invoice for which you got the bad check.
2. Clear the Affect Sales check box since you did not sell the job.
3. Click Reverse to turn all the negative amounts to positive ones (because you need to add them back as
what the customer still owes you).
4. Click Update & Post.

Discounting a percentage of an invoice
If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by
discounting the invoice by some percentage, for example, 10%. If a closeout was already performed, you must
make a journal entry to account for the discount.
1. In the Journal Entry window, click Select Invoice and enter the number of the invoice you want to
discount.
2. In the field to the left of the Calc Adjustment button, enter a percentage, for example, 10 and press the
TAB key.
3. Click Calc Adjustment, and all the amounts change to 10% of the original amounts.
4. Click Update & Post.
5. In the Post Payments window, select the original invoice and the memo you just created and then click
Update & Post.
Note

The invoice in account history will continue to show the original amounts.

Giving a dollar discount
If a customer is unhappy with a job, you may want to maintain a good relationship with the customer by giving a
fixed amount back (rather than a percentage as shown above).
1. In the Journal Entry window, click Select Invoice and enter the number of the invoice you want to
discount.
2. Select the sales category from which you want to take the money and enter the amount as a negative
number.
3. Delete the entries in all the other sales categories (so they are blank).
4. Click Calc Adjustment, and the amounts reflect the fixed amount you applied as a discount.
5. Click Update & Post.
6. In the Post Payments window, select the original invoice and the memo you just created and then click
Update & Post.
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Removing tax from a posted invoice
If you learn after a closeout that an invoice was taxed when it should have been tax exempt, you mus t make a
journal entry to remove the tax. This also corrects your taxable sales and non-taxable sales.
1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be adjusted.
2. Click Only Tax. All of the details are cleared except for Tax Sub and the rest of the totals. Tax Sub is a
special number used strictly for calculating tax. With Sub-Total set to 0.00, the only real amount is the tax.
3. Click Update & Post. A credit memo is created.
4. In the Post Payments window, select the original invoice and the credit memo you just created and then
click Update & Post.

Adding tax to a posted invoice
If you learn after a closeout that an invoice was not taxed when it should have been, you must make a journal
entry to add the tax. This also adjusts your taxable sales and non-taxable sales.
Note
This procedure assumes that the document was made tax-exempt the recommended way, by using
the No Tax button in the Document Totals window. If you marked each item in the invoice as not taxable, you
must manually calculate the tax amount before using this procedure
1. In the Journal Entry window, click Select Invoice and enter the number of the invoice to be adjusted.
2. The invoice was not taxable, so the Taxable check box should be cleared. If there were items in the
invoice that are taxable, there will be an amount in the Tax Sub field. Select the Taxable check box to
calculate the tax based on the document’s tax table.
3. Click Only Tax. All of the details are cleared except for Tax Sub and Tax. Tax Sub is used strictly for
calculating tax. With Sub-Total set to 0.00, the only real amount is the tax.
4. Click Reverse. This changes the journal entry into a debit memo. All the amounts become positive.
5. Click Post. Tax Sub is added to taxable sales. On the receipts side, Tax is added to tax on sales and to
new charges.
6. In the Post Payments window, select the original invoice and the debit memo you just created and then
click Update & Post.

Issuing a refund
Suppose that you overcharged a customer in a cash register transaction, the customer paid, and you performed
a daily closeout. If the customer returns and requests a refund, you must issue a credit memo and then refund
the amount.
1. In the Journal Entry window, select the account to be used for issuing the credit. An “In House” account is
useful for these types of transactions.
2. Enter the amount of the refund as a negative number in the Total field and press the TAB key. If the
Taxable check box is selected, the Tax Sub and Tax are calculated.
3. Click Update & Post. A credit memo is posted to the account. This takes care of adjusting sales and tax
on sales, but cash is not yet affected.
4. Select AR > Post Payments and select the account. The credit you just posted will be at the end of the
list of open items.
5. Select the credit memo.
6. Select the type of refund in the Remainder field (on account, return cash, and so on). This indicates
that the entire credit memo is to be returned to the customer and identifies how it is being returned.
7. Click Update & Post. The amount of the credit memo is removed from the cash drawer.
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Adjusting sales categories
If you discover that a charge was posted to the wrong sales category, you must create a zero-balance journal
entry that moves the amount to the correct sales category. EFI recommends that you create an “in house”
account to use for these types of transactions to avoid cluttering up customer histories with housekeeping journal
entries. If you do not want to create a customer account for this type of transaction, you can use the walk-in
account.
For example, if $100 was charged to the HP 5000 sales category instead of the VUTEk sales category, you
would make the following journal entry:
1. In the Journal Entry window, click Select Customer and select the “in house” account to use for the
transaction.
2. In the HP 5000 field, enter -100.
3. In the VUTEk field, enter 100.
4. Click Update & Post. A zero-balance journal entry is recorded.
The sales report shows this as a $100.00 decrease in the HP 5000 sales category and a $100.00 increase in the
VUTEk category, with no other effect on sales.

Notify Customer

Clear Journal Entry

Notify Customer
This will allow you to create an activity to notify the customer.

You can choose from pre-defined activities and a note will be added to the customer account log.
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Follow-up required gives you the opportunity to enter a follow up date and who is to follow up. You can also enter
follow-up comments.
Completed allows you to enter the date complete, completed by and the action taken.
You can email directly from this screen.
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Register Tape
PrintSmith Vision keeps a detailed record of all transactions for each sale’s “day” on an electronic register tape.
A sales day ends when you perform a closeout, and a new tape is started. The register tape records significant
events such as deposits, document voids, posted payments, finance charges, and journal entries. When you
post transactions in the Cash Register window they are recorded on the register tape.
If you are using line-item taxation and a transaction involved more than one tax table, all the tax tables are listed
in square brackets, but the Tax amount is the total tax (the amount is not broken down on the register tape).

Voiding entries on the register tape
Occasionally, people make mistakes: they select the wrong invoice for posting, enter a check as cash, and so
on. Sometimes a customer may change his or her mind about a purchase or ask for a refund. When this
happens, you want to be able to correct the problem quickly. In PrintSmith Vision, you can adjust your
accounting records in two ways: you can make a journal entry or you can void the transaction on the register
tape. Whenever possible, EFI recommends that you void the transaction on the register tape.
After you perform a closeout, the register tape for that period is locked. As a result, you should review the tape to
determine if any transactions need to be voided before performing a closeout. It is much easier to void the
transaction before the closeout than to create a journal entry afterwards. A journal entry does not cancel the
transaction; it creates a new transaction that counteracts or reverses the original transaction. A journal entry can
sometimes be difficult to set up and it is subject to the same kind of errors as the original transaction. For
information about journal entries, see 99.
When you void a transaction, on the other hand, a new transaction is not created except to record the void itself.
For example, if you void an invoice pickup transaction, the invoice is removed from the account history and
placed back in the pending invoice list just as though it had never been picked up.
Voids are not allowed in a few situations:
•
•
•
•

•
Note

Deposit entries. To remove a deposit, open the invoice and use Invoice > Deposit Entry to zero out all
the deposit information.
Invoice cancellations. Once an invoice is canceled, the data in the invoice is gone – there is no way to
recover it, so no way to void a cancellation.
Voided entries. You cannot void an entry that was already voided, or an entry that records a void.
Invoices or payments that were already paid or applied in a later transaction. PrintSmith Vision will
notify you of the problem and identify the entry that is at fault. For example, if you pick up an invoice and
later use AR > Post Payments and apply the payment, you cannot void the invoice pick up until you
void the payment.
POS charges. You cannot void charges that were posted using AR > Post POS Charges.
You can only void transactions if you have permission to do so.

To void a transaction, select it and then the VOID button will be active and you can use it (if you have
permission). Once the transaction has been voided it will have a line drawn through it and a new entry will be
added that a transaction has been voided. This is the recommended way to correct mistakes; once a closeout
takes place, you must make journal entries to correct mistakes, which can be more complicated to set up.
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You can also print the tape register by selecting that feature. Since register tapes can be quite long you can also
search using the standard search at the top of the screen. You can search by date or date range, ID number,
price or total.
If you are using line-item taxation (see page 29), and a transaction involved more than one tax table, all the tax
tables are listed in square brackets, but the Tax amount is the total tax (the amount is not broken down on the
register tape).

Opening old tapes
As part of a daily closeout, the register tape for that period is archived and locked, and a new tape is started. You
can use the Old Tape button to open register tapes from previous closeouts (identified by date). While you can
review and print any tape, you cannot void entries in old tapes because they are locked after a daily closeout.
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Closeout
A closeout in PrintSmith Vision is the process of summarizing the sales and accounting activity for a day or
month.

What do “daily” and “monthly” mean?

Daily closeout
Despite the name, how you define “daily” is up to you. You pick the frequency.
•
•
•

Daily does not need to correspond to a 24-hour calendar day.
The period represented by a daily closeout can span several days, e.g., every Wednesday.
More than one daily closeout can be performed during a 24-hour period.

Monthly closeout
Despite its name, a monthly closeout can be run at any time, but typically you would do this at the end of a
calendar month. The monthly closeout just summarizes the daily closeouts.

What to avoid
•
•

The longer the period between daily closeouts, the harder it can be to track down discrepancies – the
volume of transactions will be higher.
The period represented by a daily closeout should never span the end of the month, e.g., if a daily
closeout was run on April 28, do not run the next one on May 2 – this will distort your monthly figures.

Manual vs. automatic closeouts
Closeouts are typically performed manually (as described below), but you can also automate the process. For
information and recommendations about automatic closeouts, see page 127.
NOTE

Auto closeouts do not allow for a review of detail reports.

Manual closeouts
Closeout checklist
1.
2.
3.
4.
5.
6.
7.
8.
9.

Post POS charges
Start daily closeout: new vs. append.
(Optional) enter productivity data.
Balance cash drawer.
Look at sales summary.
Run trial closeout to verify numbers. Trial closeout will lock everyone out of the system.
Verify sales summary report against invoice pickups, payments, journal entries, and tax
summary.
Run real daily closeout.
As needed, run monthly closeout.

Details of these tasks follow.

Task 1: Post POS charges
If you charged any cash register transactions to accounts, post those charges before starting a closeout:
1.

Select AR > Post POS Charges.

2.

Select the options you want (for example, Print Summary Report) and click OK.
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Task 2: Start daily closeout
Click on Accounting on the left panel > AR > Closeout
1.

Select Trial closeout or Daily closeout. EFI strongly recommends you always run a trial closeout before
doing a “real” closeout – this gives you the opportunity to review various closeout reports and correct
any discrepancies if necessary. Trial closeout also allows you to just select the reports you want to see
by checking the box Quick Trial Close. If you do not check that box, then the rest of the closeout
process is the same for Trail or Daily.

2.

Select one of the following:
•
New closeout for today – always select this unless you are doing more than one closeout during
the same calendar day.
•

Append to closeout – select only if you are performing more than one closeout during the same
calendar day (this can be useful if you have multiple shifts and want to close out each shift).
After selecting the type of closeout then you have the option to “Capture Productivity Data”. There are four
steps to the closeout process.
1. Productivity Data (Optional)
2. Balance Cash Drawer
3.
4.

Review Sales Summary
Verify Reports

Automatic closeouts
Instead of performing daily or monthly closeouts manually, you can have closeouts performed automatically –
without any user interaction – at a time of your choice.

Before you begin: important recommendations and notes
•
•

Monthly closeouts: EFI recommends doing automatic monthly closeouts to ensure your monthly totals
are captured at month’s end. For example, if you are travelling, or if the end of the month falls on a
weekend or holiday, an automatic monthly closeout ensures the closeout always takes place.
Daily closeouts: EFI does not recommend automatic daily closeouts for normal use because you have
no opportunity to balance the cash drawer by counting cash or credit cards, reviewing deposits, and so
on. In general, manual daily closeouts are recommended. Automatic daily closeouts can be useful,
however, if you cannot always be there to perform the closeout manually but want to make sure the
closeout takes place regularly.

Note
An automatic daily closeout will take place only if the register tape has items on it. If you perform
manual daily closeouts on most days, and the register tape is empty, automatic closeouts will not take place on
those days.
If the system finds discrepancies in the cash drawer during an automatic daily closeout, the closeout will fail, and
you will need to perform a daily closeout manually to correct the problem(s). For this reason, if you frequently
correct discrepancies in the cash drawer during manual daily closeouts, automatic closeouts are not a good
solution for you.

Activating automatic closeouts
To take advantage of automatic closeouts, you must activate them in the PrintSmith Vision Closeout
preferences.
1. In PrintSmith Vision, click Preferences in the Quick Access panel (or select Admin > Preferences).
2. Under Accounting, select Closeouts.
3. Select the Activate Auto Closeout check box.
4. To perform daily closeouts automatically, select the Perform daily closeout automatically check box
and then select a Time of Day. (The default time is 20:00.)
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5. To perform monthly closeouts automatically, select the Perform monthly closeout automatically check
box and then select a Time of Day. (The default time is 23:00.) Automated monthly closeouts always take
place on the last day of the month.
6. To ensure some members of your organization are informed if a closeout fails or is interrupted, enter:
•
Failure Notification E-Mail Addresses (separated by ;)
•
•

Subject Line of e-mail that is sent
Body Text of e-mail that is sent

Important
For e-mail to be sent, you must have e-mail enabled and configured in PrintSmith Vision. For
information, see “E-Mail preferences” in the PrintSmith Vision – Setup and User Guide.
7. Click Save.
The daily and/or monthly closeouts will now take place automatically at the time you specified.

Closeout warnings
Users who are logged into PrintSmith Vision are given a 15-minute warning that an automatic closeout is about
to begin so they can finish their work and log out. If they remain logged in, their session is suspended until the
closeout is done.
In addition, if users try to log in while a closeout is taking place, they will be prevented from doing so.

Automatic daily closeouts
Note the following about automatic daily closeouts:
•
A daily closeout will only take place if the register tape has items on it.
•

If a daily closeout already occurred on a calendar day (typically due to a manual closeout), the automatic
daily closeout will be appended to the previous closeout.

•

If the system finds discrepancies in the cash drawer during an automatic daily closeout, the closeout will fail,
and you will need to perform a daily closeout manually to correct the problem(s).

Automatic monthly closeouts
An automatic monthly closeout will take place only if the register tape is empty. If it is not empty, the system
automatically performs a daily closeout before the monthly closeout.

Status of automatic closeouts
A history of all your automated closeouts is available under History in the Closeout preferences. Here you can
see what type of closeout was performed, when it was performed, and whether it was successful.
1. Click Preferences in the Quick Access panel (or select Admin > Preferences).
2. Under Accounting, select Closeouts.
3. Check the History. (Click Refresh to update the results.)
In addition, if a closeout failed, and you specified one or more Failure Notification E-Mail Addresses in the
Closeout preferences (and have e-mail enabled and configured in PrintSmith Vision), those users will be notified
by e-mail. Typically, they will need to correct problems by performing a manual daily closeout.

Closeout reports
No closeout reports are printed when an automatic daily or monthly closeout takes place, but those reports and
deposit tickets are available from the Reports menu for viewing and printing later: Reports > Daily Sales,
Reports > Monthly Sales, and Reports > Deposit Ticket.

Closeout Steps
Productivity Data
You can enter the productivity data if you want to track productivity statistics.
•
•
•
•

Square feet in Store: your square footage. This is used to calculate sales per square feet.
Number of Workers: the number of employees. This is used to calculate sales per employee.
Press Hours Worked: the number of billable hours for all your printers.
Other Prod Hours: other direct labor hours such as setup and finishing.
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•

All Other Hours: other hours worked that are not related to production. This would normally
include sales and supervisory hours.

Balance the Cash Drawer
Important The process of balancing the cash drawer is the single most important verification procedure you
perform in PrintSmith Vision. Never finish a closeout if the Balance Cash Drawer window has unexplained
discrepancies.

Count cash
Count all the cash you have on hand. This amount should match what is shown in the Cash in Drawer field.
PrintSmith Vision automatically subtracts the amount in the Change Fund field from the amount in the Cash in
Drawer field and displays the total cash to deposit in the Cash to Deposit field. This amount is also shown on
the right side of the window so all the deposit totals are in line.
Note You cannot finish a closeout if Change Fund is larger than Cash in Drawer. Since Change Fund is the
amount of cash held out of the deposit, you cannot have more in the drawer than you actually have. You must
make sure the change fund does not exceed the cash in the drawer.

Common problem:
You have less in the Cash in Drawer field than is shown in the Change Fund field.
A returned deposit almost always causes this problem. If you return a deposit made with a check that was posted
on a previous day, the check is no longer in the cash drawer. When this happens, PrintSmith Vision issues a
cash refund because it no longer has the check to return to the customer. Often, you will have issued a business
check for the refund, and this causes the discrepancy.
A discrepancy can also occur if you entered a check while posting payments for more than the total selected for
payment and did not apply the remainder to the account. In this case, PrintSmith Vision issues a cash refund to
the customer instead of crediting the remainder to the account.

Solution:
Review the register tape (POS > Open Tape) to find the problem and correct it. Look for Refund - CASH in
transaction records on the register tape.

Count checks and drafts. Checks and drafts are shown in the deposit item list (at the top of
the Balance Cash Drawer window) in the same order they were posted.
•
•

Verify that each item in the list matches an actual check. (Alternatively, add up all the checks on hand
and compare this to the amount shown for Checks in the Balance Cash Drawer window.)
If you have checks on hold or on automatic release, keep them separate so they are not part of your
verification.

Handle refund checks
When posting payments, you can issue refunds by writing a check. In this situation, only half of the transaction is
completed in PrintSmith Vision. The check itself is not written in PrintSmith Vision so the record of a refund check
in PrintSmith Vision is just a reminder that a check must be written to complete the transaction.

Count credit cards
Credit cards are slightly different from checks and drafts. Typically, the credit card processing system issues a
summary report with transaction counts and totals for each type of card. For a summary of charges for each
credit card, click the button to the right of the Credit Card total in the Balance Cash Drawer window.
Note
separate.

Credit card transactions that are on hold are not included in this window. Keep these transactions

Add checks
Balance Cash Drawer window).
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Warning
Checks added this way are included only on the deposit ticket, and almost always result in a
variance in your daily sales report unless offset by a change in cash. EFI strongly recommends you fix the
transaction that caused the problem rather than add a check.
Added checks are placed at the end of the list in the Balance Cash Drawer window with the word Add in the
Status column.

Change checks in deposits
You can change the reference number or amount for a check if necessary (by selecting a check in the Balance
Cash Drawer window and clicking Change Check in Deposit).
Warning
A change to the reference number or amount of a deposit affects only the deposit ticket, and
almost always results in a variance in your daily sales report unless offset by a change in cash. EFI strongly
recommends you fix the transaction that caused the problem rather than change a check.

Hold or release checks
To place a check on hold or to release a check so it is included in the deposit, select the check in the Balance
Cash Drawer window and click Hold/Release Check. Items on hold have Hold in the Status column. They are
not included in the deposit total on the deposit ticket. On subsequent closeouts, they are included in Items on
Hold.

Correct discrepancies
If there are any discrepancies, identify them and fix the problems before continuing with the closeout. Click
Cancel in the Balance Cash Drawer window to cancel the closeout.
Typically, once you identify an incorrect transaction, you must use POS > Open Tape to find and void the
transaction and then you must re-enter the transaction correctly.
Note Always void the most recent transactions first.
When trying to identify discrepancies, watch out for:
•

•

•

•

•
•

The amount on a deposit item differs from the amount in PrintSmith Vision. Always fix this
situation. Find the transaction on the register tape and void it. Then enter the transaction again with the
correct amount. Although you can modify the reference number or amount of any transaction, avoid
doing this because it almost always introduces accounting errors.
Payment type totals do not match. If the total of all payment types in PrintSmith Vision does not
match all of the payments in the cash drawer, payments of the wrong type were probably entered. For
example, if cash is over by $100 and checks are under by $100, a payment was probably recorded as
cash instead of being recorded as a check. To fix this problem, identify the faulty payment, void it, and
re-enter it as the correct type of payment. EFI strongly recommends that you always fix this type of
problem to maintain a strong audit trail.
Extra check, credit card, or draft in hand - You probably forgot to post a payment in PrintSmith Vision
or forgot to enter a deposit on an invoice. If one of the other payment types is too high, a payment or
deposit may have been entered with the wrong payment type. Look for a transaction with a different
payment type that matches the amount on the check or draft. Void the transaction and re-enter it with
the correct payment information. If it is a deposit, open the affected invoice, change the type of the
deposit, and save the document.
Extra check or draft in PrintSmith Vision. If all the other payment type totals are correct, a payment
was made that should not have been made. The information in the list of deposit items will help to
identify the incorrect transaction. Most of the time, this is a pickup or POS charge that was paid for in
PrintSmith Vision when it should have been charged to the customer’s account. Void the transaction
and then charge it to the customer account.
Cash in hand is too high. Unless this is your very first closeout, and beginning cash was not entered
in the Change Fund field, you probably forgot to enter a payment or a deposit.
Cash in hand is too low - If cash or credit cards are correct, you probably entered a cash payment in
the cash register that should have been a charge or entered a cash deposit when one was not made.
Alternatively, you entered the wrong payment amount. If cash or credit cards do not match, find those
mistakes first. If cash is still off, look for the mistakes in cash transactions. Void the incorrect transaction
and re-enter it.
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Review Sales Summary
After you click NEXT STEP in the Balance Cash Drawer window, the Daily Sales window opens. This includes
the A/R Balance – this is the original balance (from the last closeout) minus payment plus new charges adjusted
by any journal entries.
Note
Although you can review the contents of this window, it is more important to compare the contents
of certain reports during a trial closeout.

Verify Reports
Here you can select the reports that you want to see. At a minimum you should select the following reports.
•
•
•
•
•

Sales Summary
Invoice Pickups
Payments
Journal Entries
Tax Summary

The reports that you selected open in a preview window, from which you can print them.
Verify the Sales Summary report against the Invoice Pickups, Payments, Journal Entries, and Tax Summary
reports.
If you find discrepancies, correct them. If everything is correct, continue to the real daily closeout.
When you select “Finish Trial Close” the reports that you selected will be displayed on the screen where you
have the option to print or download them.
The daily closeout will take you through the same steps as the trial closeout except that you do not have the
option for Quick Trial Close.
•
•
•
•
•
•

•

The daily closeout does the following:
Adds an entry to the register tape indicating that a closeout was performed.
Archives the current register tape and creates a new register tape. The archived tape is locked so it
cannot be changed, but you can use Reports > Open Old Tape to review an archived tape.
Resets the cash drawer. Cash is set to the amount in the Change Fund field. Checks are set to reflect
any checks on hold. Credit cards are zeroed. AR balance is unchanged.
Updates the daily sales summary. This summary includes information about new invoices and invoice
pickups, as well as tax details.
Saves a copy of the deposit ticket.
Tip
To print a deposit ticket after a closeout is done, select Reports > Deposit Ticket. In the
Deposit Ticket window you can select a deposit ticket (identified by the date of the closeout) and then
preview and print the Daily Deposit Record. You can also select multiple deposit tickets in the Deposit
Ticket window and then click Select to generate a report that includes a Daily Deposit Record for each
of the deposit tickets you selected.
Opens each of the closeout reports you selected in a preview window from where you can print them.

Only on the daily closeout will yfou have the option of having the system verify the closeout tax detail and tax
summary data. To activate this feature, go to the Legacy version > Preferences > HTML View and check the box
to Enable discrepancy Check Button in Closeout. A new button will be displayed in the Closeout screen called
Verify Closeout Data.
Important: You will get the warning that it is recommended to start this process during your non-business
hours because it will take some time depending upon the size of transactions. Please make sure tax elements
and rates are matching in all current tax tables.
After running Verify Closeout Data you will get a message that the closeout data is done and you should check
the Tax Detail and Tax Summary Reports.
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Monthly Closeout
A monthly closeout provides a summary of the sales for a calendar month and updates customer sales statistics
and account histories. The system automatically figures out which month needs to be closed out next and
informs you what it is going to do. You do not have to enter anything except the optional productivity data.
Although typically you will perform a monthly closeout at the end of a month, you can do so at any time. If a
closeout was already done during the current month, PrintSmith Vision updates the monthly sales figures instead
of starting a new month.
Note
system.

Monthly closeouts are currently done in the Legacy version and will lock everyone out of the

To perform a monthly closeout
1.
2.
3.
4.
5.
6.
7.

Go to Legacy UI
Click Accounting > AR > Monthly Closeout.
Before starting the closeout, PrintSmith Vision informs you what period is being closed out. Click
Continue to review the productivity information and change it if necessary.
When the Monthly Sales window opens, review the information and then click Continue. \
In the Closeout Reports window, select the reports you want to print. Click Trial Closeout to
perform a trial closeout or Finish Closeout to complete the monthly closeout.
The reports that you selected open in a preview window from where you can print them. \
Check the Total in the Sales Summary report as follows:
•
Take the Total from the Invoice Pickups report.
•
Subtract the Total from the Journal Entries report.
•
Add the POS sales (open each daily tape for the month and manually add up the totals).

The result should match the Sales Summary Total.
8. When the closeout is finished, you are asked if you want to update account history with sales
statistics. Click OK if this is the “final” closeout for the month.
Tip Updating sales statistics can be time-consuming so you can skip this step if you know this is not the last
closeout for the month.
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Pending Documents
The Pending Documents window is a “command center” for managing your active documents. These are all
the invoices that are in production or are waiting to be picked up as well as all the estimates that were not
voided (canceled), archived, or converted to invoices. You can control which columns are displayed in the
Pending Documents window and the order in which they are displayed, as well as the colors that identify
certain kinds of information.

The Pending Documents Window

The Pending Documents window has four tabs across the top that you can use to select which documents you
want to see or you can select to see all documents. The documents can be identified by the icon on the tab and
to the left of the account. Each tab will also display the number of documents in each category.
Tip The number of web orders is not included in the total number of invoices.
You can filter further, regardless of the tab you are using, by selecting the TYPE dropdown.

Each user can determine which columns are displayed, number of days of estimates to display and the color
indicator for invoices and estimates at different stages.
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Each column can be sorted high to low or low to high by selecting it. Or if you are looking for a specific
invoice/estimate you can just enter the information in the appropriate field. You can click and drag columns to
change the layout. Note also that the wanted date now includes time.
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If you are looking for something within a specific date range, you can enter the date range by selecting the
starting date and then the ending date. If you are looking for a specific date the starting and ending date selected
will be the same.
Tip

Only click once when you select the date, do not double click

You can clear all filters

You can access the job contained in an invoice or estimate by selecting the > to open the detail.

You can change the location of each job. The location for the estimate/invoice will reflect the latest location that
was changed for a job. When you change the location of the estimate/invoice that location will be reflected in
each job. You can add job comments

You can change the wanted date of an estimate/invoice
Selecting the document number will take you to the estimate/invoice where you can make changes if needed.
The three-dot symbol will show you other options. Those options are different for each tab.
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Estimating options

Open in new tab will open the estimate/invoice in a new tab for modification or review.
Convert to Invoice will convert the estimate to an invoice and take you to the invoice screen.
Notify Customer will allow you to create an activity to notify the customer.

You can choose from pre-defined activities and a note will be added to the customer account log.
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Follow-up required gives you the opportunity to enter a follow up date and who is to follow up. You can also enter
follow-up comments.
Completed allows you to enter the date complete, completed by and the action taken.
You can email directly from this screen.

Hold estimate will allow you to select the reason for the hold
Note
The next time you open this option after putting the document on hold you will have the option to
release the hold.

Lost estimate will allow you to identify the reason for the loss.
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If you select other reason you can enter comments below. (See page 190 for how to set up Reasons)
You can also print or archive the estimate.
Archive Estimate will remove it from Pending Documents.
For invoices some of the options are the same but there are some specific to invoices.

Pickup Order takes you to the Cash Register program. You can pick up more than one order, but they must all
be for the same account.
Note
When you click Pick Up, PrintSmith Vision checks whether the tax rate on the invoice is current. If
the rate changed since the invoice was last opened, you are warned that the tax is incorrect. If you receive this
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warning, open the document, check the tax (which is recalculated when the document opens), and save the
document before picking it up. You can ignore the warning and pick up the document, but the sales tax will be
incorrect.
Release for Pickup changes the status to ready to pick up.
You can print the invoice or job ticket
You can also void an invoice. If the invoice has a deposit on it, you will be notified and asked if you want to
refund the deposit.
If you select Yes, then the amount should be returned and in credit card manager the amount will be voided. If
user says No, then the deposit will be FORFEITURE

Web Orders
Under Web Orders you can also produce a delivery ticket and shipping label.

You can enter the weight, delivery date and tracking number. For more information on delivery ticket see page
103.
Using the label icon, you can print a shipping label.
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Work in Progress (WIP)
Work in Progress contains all the jobs that are waiting for processing. There are two views available for WIP,
WIP mode or Report mode.

WIP Mode
In the WIP Mode you can choose to display jobs or documents. A document may contain more than one job. You
can use the heading to filter out certain jobs based on the headings as well as have them sorted in ascending or
descending order. You can use click and drag to change the position of the column headings. Each job or
document will be displayed in the color that matches the status. (See customizing the list to set the color)

The screen shot above is displaying documents. If you select jobs, then you will see a different layout. Additional
tabs will be displayed. If you are using Fiery and you have jobs assigned to Fiery then the Fiery Integrated tab
will be visible and you can select for those jobs.

You can print out the WIP list as a csv file using the “Download as CSV” icon in either view.
If you select the “Download as pdf icon you will see the different print options you have in either view. Only the
items on the screen will be printed.
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•
•
•
•
•

•

Print with extra space will add a blank line after each row in PDF
Print with Job Comments will add job notes after each row in PDF
Repeat Headers will repeat the column header on each page if generated PDF have multiple pages
Open PDF in new tab will open the PDF in new tab instead of showing the download option
The user has the option of selecting a standard paper size or selecting custom and entering in the width
and height. The units field is used to select the units for the entered width and height.
You can also select the orientation and scale to be used in the PDF

Selecting the “Customize List” option you will get a short cut menu screen where you can change the columns to
display, identify the color for each item based on its status and set up other filter options.

There are different column options depending if you are displaying jobs or documents. You can determine if you
want to include estimates or not. You can set up additional filters here also. You can set up a filter based on the
order price you enter. You can also set up filter for order where you have received the deposit and determine if
you want to include shipping and tax amount in the displayed totals. In the case of order price amount and
deposit received with orders they become a filter you can select. If you check include shipping and tax amount in
totals, then the totals will change to reflect that amount.
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In this screen you can also determine the color you want to use to identify the different statuses of the jobs. You
can enter a specific hexa decimal color code or you can select the color field and select the color that way.

The documents are color coded according to the guide

By using the drop down, you can filter the jobs you can display based on their status or a saved filter
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Once you have created a filter you can save and use it later.
In this example a filter was created for a particular customer, 1111 Football Management.
Selecting “Save Filter” gives a short cut menu where you can name the filter

This filter now becomes available in the search
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Selecting “Manage Filters” allow you to modify or delete the saved filter

You can clear the filter

Hovering the mouse over the document title will show more detail about the job. Double clicking on the document
title will take you to the job details screen for the invoice.

Once you select one or more documents or jobs you have other options depending on which screen and which
tab.
On the documents screen you can print job tickets. Selecting this option will print the job ticket(s) for the jobs in
the document.
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On the jobs screen under both the All Job or the Fiery Integrated tabs you have these options

Print job ticket will print the job ticket to the screen where you can determine where you want the document to
print.
The next field will display the options of where the job can be processed. The column “Device ID” will display the
device ID.
Note

This is only available on the job screen display

Select users to Assign gives you the option to assign a user to the job. A list of users will be displayed in the
dropdown. You can also use the three dots to assign job. The user can then be used as a search option.
The submit to Fiery field will allow you to submit the job to fiery.
The options displayed under the tabs works well when you are working with multiple jobs but you also have
options available for each job. Assign job, Submit to Fiery and print job tickets work just like the above options. In
addition to those you can, mark the job as outsourced and notify the customer.
Note
If the job has already been submitted to Fiery, that option changes to Void Fiery job which will
cancel the job in Fiery.

You can mark the job as outsourced by moving the sliding dot. This will cause the job to be marked as
outsourced and change the number of jobs in the outsourced total.
Note

Marking a job as outsourced does not change its pricing method and job price.

Selecting “Notify Customer“ brings up a box that shows all of the current activities and the ability to add an
activity.
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When you select Add New you will be shown a place to enter a new activity

Report Mode
Using the Report mode you can select the type of report .
Note

The maximum number of records displayed is limited to 500.
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Report types
Several variations of the Work in Progress report are available:
•
•
•
•
•

Standard for a list of orders by number, customer name, title, ordered date, wanted by date, proof date,
and total amount due.
Date and Time for a report very similar to the Standard report except that instead of showing the total
due, the report shows the time of the order in addition to the date of the order.
Location for a list of orders by number, customer name, title, ordered date, wanted by date, name of
user who entered the invoice (taken by), and location. (The location may have been manually entered
or scanned.)
Weekly Schedule for an overview of the number and type of orders due in a week, starting on the next
Monday. Orders due before then are listed in the Earlier column.
Press Schedule for a breakdown of invoices by jobs and for information about the workloads for each
press according to the date and time jobs are wanted.

You also have options as to how you want the reports grouped

In this example they are grouped by account.
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You have the option to choose additional information to be displayed. In this case 2 items have been selecte d to
be displayed.

When you select Show Total you will see the totals for each group and a total for all records
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The Report Mode the job columns and document columns are fixed and cannot be customized like the WIP
mode. You can still indicate the color to be used and also identify items you want included on the reports. You
still have the option to use the column headings for sorting or filtering.
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PO History
The PO history process allows you to view all purchase orders including completed purchase orders and the
current status of the purchase order.

You can filter purchase orders by selecting a vendor, date range or status using the column headers. Selecting
this icon will clear the filters and list all purchase orders.

Checking the box “Show Completed” will add completed purchase orders to the list.
Double clicking on any PO number will open that purchase order. From there you can edit or change the status
of a line or the entire purchase order.
You can sort the purchase orders in ascending or descending order by using this icon.

You can mark a PO as complete by checking the box next to the PO and then select Mark as Complete.
You can delete purchase orders by checking the box next to the purchase orders you want to delete and then
selecting the delete icon.

Selecting the plus sign allows you to create a generic purchase order that is not related to an invoice.
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1.

Select the vendor

2.

Enter the required date. Clicking on the field will display a calendar.

3.

Enter the buyer information and description.

4.

Select add a line item and complete the information on what you are ordering

Note

The PO type is now generic

You have the same features that you have when raising a PO in invoicing. See page 93 for information on
“Raising a PO” in invoicing. You can edit, mark as complete or delete an item.

The Required by Date can be edited in the Purchase Order.

You can email, print and save the PO. This now includes the ability to print completed purchase orders.

Note
If you want to email to the supplier then you must include their email address in the vendor record.
See page 26 for information on “Adding or Editing a Vendor Record”.

Duplicate a PO
You can duplicate a PO from the History screen or within a PO
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When you duplicate a PO it will also display the Source PO # and you can access the source PO by clicking on
the link. Also it will keep the shipping address from the original PO.

Print PO
There are two versions of the PO available, one that displays taxes and one that does not. Either of these reports
may be customized by the customer to add their logo or make other changes but the standard reports must be
used as the basis for the customization. Go to Legacy version > Reports > Report Manager to identify the report
format you want to use. As identified above you can print the PO from the PO History screen and also in the PO.

Tax
Just as when you raise a PO in Invoicing you can see the tax information (see page xxx for more information on
setting up taxes)
With the tax box checked when you open a purchase order the tax will be displayed.

Note

Since the tax option was not available in prior versions theses fields will be disabled for older views.

You can now edit the Quantity, Unit Price and Sub Total fields. If you change the sub total then the unit price will
recalculate, if you change the unit price the sub total will recalculate and if you change the quantity the sub total
will recalculate.
The taxes are also displayed in the total.
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Shipping Address
You can edit the shipping address from PO history with the same methods you had when raising the PO from the
invoice.
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Accounts
About Customer Accounts
In PrintSmith Vision, you can define accounts for both prospects and customers. Prospects have not yet done
business with you, but you hope to turn them into customers. Customers have done business with you, and
invoices have been created for them. Once you create an invoice for a prospect, that prospect is automatically
converted to a customer. If customers become inactive, they can be turned into prospects again.
Accounts are a key part of your PrintSmith Vision system. Invoices are assigned and posted to accounts,
payments are made for accounts, account histories are tracked, and sales statistics are kept for each account.
Tip

The terms customer and account are often used interchangeably in PrintSmith Vision.

In addition, each account has contacts associated with it. An account may have a single contact person or
different people. For example, one contact may receive invoices and another receive statements. You can
always add a contact while you are setting up an account, but you can also manage contacts independently of
accounts and provide additional information about the contacts. For more information, see “Contacts” on page
174.

About Master Accounts
Master accounts are very useful if you do business with several departments or locations at one company or
organization but need to send the statements to a central location for payment. You can track each of the
departments or locations with a separate account and then tie them together through a master account for billing
purposes. For example, you do business with the London, San Francisco, and Santiago offices of a company
named SuperPromos, but all payment comes from SuperPromos Corporate. In this case you would set up four
accounts: SuperPromos Corporate would be the master account and the SuperPromos London, SuperPromos
San Francisco, and SuperPromos Santiago sub-accounts would all be linked to the SuperPromos Corporate
master account. All orders and order history will be tracked for each sub-account, but billing statements will be
sent to the master account with a breakdown for each sub-account.
Note A master account is created like any other account (see the instructions that start on page 149); nothing in
the account settings identify it as a master account. When you create sub-accounts, however, you link them to
the master account on the Settings tab in the Customer window (see page 164). This is how a master account is
established.

General Guidelines for Working with Accounts
When setting up accounts for prospects and customers, keep the following in mind:
•
•
•
•
•
•

To get started, you only need to create accounts for customers that have an outstanding account
balance; add other customers later as needed.
The creation of a customer or a prospect is the same, you identify them on the Marketing tab.
You can create any number of accounts for a single customer, as long as the name on the account is
unique – the accounts can all have the same address (or no address at all).
When you create accounts for a large customer who requires centralized billing and therefore a master
account, create the master account first and then create the sub-accounts that are linked to the master
account. For more information, see “About Master Accounts” above.
Although not required, you should create accounts for all your regular customers even if you do not plan
to extend them credit.
PrintSmith Vision has a special walk-in account for occasional or walk-in business, but you can use it
any way you see fit. Avoid changing the walk-in account to a charge account, however. Whenever you
extend credit to a customer, always set up an account and assign any pending documents for the
customer to this account (instead of using the walk-in account).
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•
•

EFI recommends that you create a few special accounts: one for in-house printing and one for “junk”
transactions (tax adjustments and so on) that you do not want cluttering up other accounts.
Multiple users can work with accounts at the same time, but if one user opens an account, it is locked
so other users cannot work with it. When an account is locked, and you try to open it, a message
informs you it is unavailable.

Understanding the Customer Window
You manage the information about your customer accounts in the Accounts window. To open this window, click
Accounts in the Quick Access panel (or select AR > Accounts.) You will be shown a list of accounts and
column headings. You can search on any of the headings but to select an account you must click on the account
name. You can customize the column to be displayed on the list using the Customize feature. Some of the
columns cannot be removed and they will be grayed out.
Selecting one or more accounts using the check box to the left will allow you to delete accounts or sync them
with MDSF. Accounts that have been synced with DWF will be identified by the globe to the left of the check box.
Using selectors at the top you can display only those accounts that have been synced with MDSF or just those
not MDSF registered. You can also use the three dots to delete, sync an account with MDSF or add a contact to
the account.

Deleting Accounts
You can delete a prospect account at any time if you think the prospect will never turn into a customer.
You can delete a customer account only if the customer does not have an open balance and there are no
estimates or invoices on the pending list for the customer.
Note You can restore a deleted account as long as you know the number of an invoice or estimate that was
created for the account.
To restore a deleted account
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If an account was deleted, but invoices or estimates were created for the account before you deleted it, you can
rebuild the account history from an invoice or estimate and recover almost all the customer information.
1. Select Invoice > Review Any Document to open any invoice or estimate that was created for the deleted
account.
2. Select Invoice > Create Customer Acct fm Document or Invoice > Create Prospect fm Document. The
restoration can take several minutes depending on the size of your database.
The account is restored using the name and address information in the document except that the account name
is Recovered acct #xx, where xx is the account number. It is placed at the beginning of the Customer list or
Prospect list (if restored from an estimate) in the Account Picker window.
3. Select the account, specify the account type and credit limit, and correct the name.
4. If necessary, change a prospect to a customer by selecting Customer on the Marketing tab of that prospect.
5. Save the account.
The recovered account has its full history, account information, and sales statistics.

Adding Contacts to Accounts or Prospects
To be used in PrintSmith Vision, a contact must be associated with an account. Add contacts to an account in
any of these ways:

While creating a document
1. While creating an invoice or estimate (see page 48), select the customer account in the Account Picker
window.
2. In the Account Info window (which opens automatically), click New to the right of Contact List. The Edit
Contact window opens.
3. Enter the contact information and click OK. The Contact List field now includes **NEW CONTACT**.

In the Account Window
1. Click Accounts in the Quick Access panel.
2. In the Account Picker window (see page 157), double-click the account to which you want to add a contact (or
click the account and click Select).
3. On the Address tab, click near the bottom of the window. The Contact window opens.
4. Provide information about the contact and click Save.

In the Contact window (see page 160)
1. Click Contacts in the Quick Access panel. The Contact Picker window opens.
2. Click New. The Contact window opens.
On the account picker, select an account for the contact, enter the contact information, and click Save.
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Create
Account

Customize
list

Creating Accounts
The process of creating an account for a prospect and a customer is identical, except that you identify the
account as a prospect or customer account.

General procedure for creating accounts
Note
A master account is a centralized billing account (such as a university) with associated subaccounts (such as university departments). All statements are sent to the master account, but the sub-accounts
do their own ordering, have their own order history, and so on. You create a master account just like any other
account – it is not identified as a master account in the account set up. When you create the sub-accounts,
however, you link them to the account you want to serve as the master account. This is how a master account is
established.

Select the Create Account button and the New Account window opens. (After you save an account, the window
title changes to the account number and name.)
1.

Enter Account name.

Note
In the Name field, enter a unique name for the account (up to 70 characters). If the account is for a
person, enter the last name first, for example, Smith, John, so it is easy to find in the alphabetical list of
accounts, but enter the name in the address fields as John Smith so that John Smith is the name on invoices
and statements.
Tip
2.

You can change the name of any account at any time, except for the <<<WALK-IN>>> account
Enter Account Type

Under Type, select the account type. This controls what type of payment is accepted for the account. When you
create a new account, Type is automatically set to Cash/Check/Credit Card, but you can change this as
necessary.
Full Deposit

When an invoice is opened or saved with a balance due, you are reminded that
this customer must pay in advance. Payments can be made with cash, checks or
credit cards.

Cash

The customer must pay with cash. Checks and credit cards are not accepted,
and charges are not allowed.
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Cash/Check/Credit Care

The customer must pay with cash, check, or credit care, charges are not allowed.

Charge Account

The customer may charge the amount to the account, but can also use any other
payment type, for example, cash or credit card.

Credit Card on File

For a trusted customer, a credit card that is on file can be accepted when picking
up an invoice. You can select this option only if you are using integrated credit
card processing in PrintSmith Vision. For information, see the guide to PrintSmith
Vision – Secure Credit Card Processing.

3.

Enter Account Status.

Ignore Account Status when you are setting up your PrintSmith Vision system. By default, the account that you
set up are considered New. The status information is updated automatically when account aging takes place.
Typically, account can be a certain number of days past due according to three aging classifications with
standard values of 30, 50 and 90 days. You can change these aging classifications as needed with the aging
periods preferences. On a case-by-case basis, you may need to change the account status as follows.
New

When an account is first created, and has never been aged, it is considered a new account

Current

An account is current if all amounts owed are within the allowable limits

Past Due

The account has open items picked up more than 30 days ago. (The number of days may be
different if you changed it in your aging preferences.

Delinquent

The account has open items picked up more than 60 days ago. (The number of days may be
different if you changed it in your aging preferences.

Inactive

As of the last aging, the customer was inactive for the period specified in your credit/default
preference. Invoices or payments all cause the customer to be active again.

Frozen

The account aging process can automatically freeze accounts with open items picked up more than
90 days ago. Once an account is frozen, no more invoices can be created, and no charges can be
accepted. An account is normally unfrozen manually, or automatically during the aging process. A
frozen account will still be displayed in the list of accounts but if it is selected you will get a pop-up
message identifying it as a frozen account. The account will need to have the status changed if you
want to create an estimate or you must have Admin access.
Note

4.

You can not copy an invoice from a frozen account.

Enter Sales Rep.

There are 4 tabs where you can enter the account information, Contact and Address, Credit/Tax Control,
Settings and Marketing.
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Contact and Address

Use the Contact and Address tab in the to provide general information about the customer, for example, name,
invoice and statement addresses, and associated contact information. This tab also includes the account
number, which is assigned automatically when you save a new account, and which you cannot change.
Each account can have two separate addresses: invoice and statement (billing). The invoice address is copied to
an estimate or invoice when you select an account for the document. When printed, documents can include
either an invoice or statement address (or both). Likewise, either address can be included on statements.
Note
Any required fields (as specified in the Mandatory Field preferences) are outlined in red. You must
complete these fields before you can save an account.
You can create a customer account without any contacts, but EFI strongly recommends that you always create
at least one contact at the same time as you create the customer account. Once a contact is assigned to a
customer, the customer must always have an assigned contact, but you can change the contact. You just cannot
change an account so that it no longer has a contact assigned. You can create additional contacts later.
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Tip If you plan to e-mail documents (for example, invoices, estimates, or statements) from PrintSmith Vision,
make sure all contacts include an e-mail address. If there is a central phone number for the customer, enter it in
the Main Switchboard Number field.
1.
2.

3.

The External Accounting ID can be used as a reference for an identification in something such as a CRM.
If you are using an external system (such as an accounting package), in the External Ref # field, enter the
account ID from the other system. You can search for customers by this reference number and you can also
include the number on documents, job tickets, and statements.
Enter the address for invoices. The name you entered for the Name field for the account will default as the
name in the Invoice address, but you can change it if needed.

Tip You can use Table Editor to maintain information in the City, State, Zip, and Country tables so that this
information can be selected instead of typed. You can also start typing part of a city, state, zip code, or country in
one of these fields, and the selections will be filtered. For example, type ba in the City field to see all cities (in the
City table) that begin with ba.
4.
5.

6.
7.

Select Done
Enter the address for Statements. The name will default but can be changed. If the statement address is the
same as the invoice address, the invoice address is automatically used for both. If a different address is
required for statements, you can make changes before you select Done. After selecting Done you can still
edit any of the information by selecting the Edit button.
Select Done.
Enter the information on the Invoice Contact. The contact is automatically assigned to the account as the
default invoice contact. The contact is also now listed in the Contact List field.
Note

8.

On an existing account if you search for a contact you must search by last name.

Select Done
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9.

Enter the information on the Statement Contact. If the statement contact is the same as the invoice contact,
the invoice contact is automatically used for both. You can change the information in the Statem ent Contact
if it is different.
10. Select Done.

Credit/Tax Control

Use the Credit Control tab in the Customer window to set credit limits, finance charges, discounts, and so on.
1. In the Credit Limit field, enter the maximum amount the account can charge to the account. By default, the
system credit limit is used. (You set the system limit in the Legacy version. Go to Admin > Preference and under
Accounting, select Credit/Defaults.) If no system credit limit is defined, and you leave this field blank, Unlimited
Credit is displayed to the right of the field.
2. In the Due Days from Posting field, enter the number of days to add to the current date to calculate a due
date for an invoice that is picked up and posted in the cash register. If you do not provide a value here,
PrintSmith Vision uses the value (if any) in the Number of days due before field in the Estimator Printing
preferences. This is found in the Legacy version under Admin > Preferences and under Estimator select
Estimator Printing. The due date is included under the amount due in the totals section of the invoice if the Show
payment due date check box is selected on the Footer tab in the Document Preferences window. In the Legacy
version go to Admin > Document Preferences > Footer tab.
3. In the Monthly Finance Charge Pct field, enter the percentage for calculating finance charges when
statements are generated.
If this field is set to 0.00%, the system default finance charge rate is used (as defined with the Credit/Defaults
preferences. (You set the Finance Charge in the Legacy version. Go to Admin > Preference and under
Accounting, select Credit/Defaults.) When the system default rate is used, it is displayed to the right of this field
as shown in the figure above: Using standard rate of 1.50%. The system default rate is used unless you enter a
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different rate in the Monthly Finance Charge Pct field or select the Never calculate finance charges check
box.
Note
The finance charge is the rate used each time finance charges are calculated when you generate
statements. It is not an annual rate.
After the account has some history, additional information is displayed on the Credit Control tab: Avg Days to
Pay shows the average time it takes the customer to pay an invoice; Finance Charges YTD shows the total
amount of finance charges posted to the account in the current year; and Current Balance shows the total
amount owed to you by this customer, including merchandise charges or POS charges.
4. In a franchise situation, select the Royalty Exempt check box if jobs for the account are not subject to
royalty payments. (Ignore this check box if royalty payments do not apply to you.) The check box is always
displayed but can only be selected or cleared by a member of the owner or system admin access groups.
Note
window.

Individual invoices can be flagged as royalty exempt (or non-exempt) in the Document Totals

5. If the account uses standard corporate-wide pricing, select the National Pricing check box. If the account
uses specialized pricing, leave the check box cleared.
6. If you want to give the account a discount (or you want to markup invoices for the account), under
Automatic Discount, do one of the following:
•
•

Select Percent and enter a discount as a positive percentage and a markup as a negative percentage.
This discount (or markup) is applied each time you create an invoice for the customer.
Select Dollars and enter a discount in dollars. This fixed discount is applied each time you create an
invoice for the customer.

Note
If you want the discount to be a one-time discount, select the One-time discount check box. For
example, you may want to offer a special deal to first-time customers or you may want to promote a new service.
When you create an invoice for the account, and a one-time discount was specified, you are asked if want to
apply the discount. If you click No, the discount remains in the customer account. If you click Yes, the discount
amount is applied to the invoice and cleared from the Credit Control tab.
Under Tax Setup:
If the account is subject to sales tax:
a. In the Tax Table field, select the tax table you want to use for the account. The tax table is set up in the
Legacy version, go to Admin > Table Editor > Tax tables. This tax table is known as the parent tax table and
is automatically used on invoices for the account unless you change it at the invoice level. In addition, the
parent tax table is used by default for charge definitions, unless you select a different tax table (in the Preset
Info window).
b. In the Tax Code field, select a tax code to categorize the sale. (A tax code results in a separate line in the
tax detail report for the same tax table to identify the organization that is levying the tax. Use Table Editor to
maintain your tax codes.)
c. In the Resale field, enter the customer’s license number. This number is included on documents created
for the account.
If the account is tax exempt:
a. In the Resale field, enter the account’s tax exemption ID. This ID is included on documents created for the
account.
b. In the Certificate Expires field, enter the date (if any) the account tax exempt certificate expires.
c. Select the Tax-Exempt check box so that no sales tax is applied to the account.
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Settings

Use the Settings tab in the account window to control or modify how the account is used throughout PrintSmith
Vision
1.
2.
3.
4.

5.

In the Business Type Code field, enter a SIC code or ABC code to classify the account. (For example, the
Customer List report can be sorted by business type.)
In the Ship Via field, select a default shipping method for the customer.
In the PO Number field, enter the purchase order number if one is required; it will be included on all new
invoices.
In the Default Invoice and Default Estimate fields, select the invoice and estimate formats to use by
default when creating invoices or estimates for the account. EFI supplies some standard formats, but you
can also create custom ones.
Select or clear the following check boxes:
PO required on Invoice
Select this check box if the account requires a purchase order. When the check box is selected,
you are warned to enter a purchase order number when you create an invoice, but the invoice is
still created even if you do not enter the number. The invoice cannot be picked up until you enter a
PO number, however. Also, until you enter a PO number, the warning is displayed when an
estimate is converted to an invoice, as well as each time the invoice is opened.
Do NOT generate statements
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Select this check box if do not want statements generated automatically for the account. (You can
still generate a statement for any account by selecting the account.) This option is useful for subaccounts of a master billing account that do not require their own statements.
Account is commissioned
Select this check box if commissions are paid on sales for the account. (You can use this
information in custom commission reports.)
Always file originals
Select this check box so that invoices for the account indicate that you are saving files provided by
the customer (typically artwork). You can change this setting when you create an invoice.
6.

Select invoice and job templates.
A template contains the complete specification of an order or of a job that you can re-use over and over
again without having to re-enter all the details. You can create a template based on any invoice, estimate, or
job. For information about document templates, see page 20; for information about job templates, see page
75.
Use the Templates feature to associate invoice or job templates with an account, so they are available
when you want to create an invoice, estimate, or job for the account. This allows you to have templates
specific to this customer readily available.
•

•

7.

For invoice templates, select the + and you will see a pop-up box listing estimating and invoice
templates. Select all appropriate and when invoicing for that customer they will be available options.
When creating an invoice or estimate from a template all estimate and invoice templates will be
displayed. Entering the account name in the Name column header will then only display those
templates that have been set up for that account.
For job templates, follow the same procedure. When creating an invoice or estimate from a job template
all estimate and invoice templates will be displayed. Entering the account name in the Name column
header will then only display those job templates that have been set up for that account.

In the Security level of this account field, enter a security level to prevent access to the account by users
whose security level is lower. If a user’s access level is lower than that specified here in the Security level
of this account field, the user cannot use the AR > Accounts, AR > Post Payments, and Reports >
Account History commands, but can still select an account for an estimate or invoice.

Marketing

Use the Marketing tab in the account window to record background information about the customer that can, for
example, help you design promotional mailings or otherwise track customer data.
Note
Several fields on the Marketing tab are related to tables you maintain with Table Editor. See steps
5 through 7 below. You may want to review and edit these tables before starting to enter information on this tab
because you can customize what is entered in some of the fields.
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Any required fields – as specified in the Mandatory Fields preferences – are outlined in red.
Under Company
1. Indicate if the account is for a Customer or Prospect. If a customer cannot be changed to a prospect, these
selections are unavailable, as in the figure above. (For example, you cannot convert a customer to a prospec t if
the customer has a balance or pending invoices.)
2. If the account is for a person rather than a business, select the Personal Account check box. You can take
advantage of this setting when creating mailing labels (with Reports > Mailing Labels) to segregate personal
accounts for targeted mailings.)
3. If you do not want to include the account on mailing labels or in mail merge files (generated with Reports >
Mailing Labels), select the Do not mail check box.
4. In the Number of Employees field, enter the number of employees in the company to help you target
companies based on their size.
5. In the Annual Revenue field, enter the annual amount of revenue of the account or the annual target you
expect from the account. This information can help target companies based on their revenue stream.
6. In the Business Type field, select the kind of work done by the company. This information is stored in the
Business Type table which you can change with Table Editor.
7. Under Marketing Dates, enter up to five dates for any purpose, for example, Anniversary or Birthday.

Note
The labels of the five fields under Marketing Dates are stored in the Marketing Date Labels table
and are initially named User 1 through User 5. Use Table Editor to change these labels to suit your purposes.
For example, the figure below illustrates how the User 1 field was changed to Anniversary and User 2 was
changed to Birthday. Any changes you make to the field labels are also reflected on the Marketing tab in the
Contact window (see page 176).
Under Marketing Tags, provide further information about the account. Note the following:
•
•

The Lead Source fields both use data from the same table (named Lead Source). Use Table Editor to
change what this table includes.
Eight User tables are available for customization. You can use Table Editor to change the name of a
User table (which will change the label of the corresponding marketing tag field) and to edit the contents
of a table. For example, the figure below shows several renamed user tables: Common Interest, Likes,
Type of Work, Sport Interest, and Mailer Type. You can enter data in the table, so users can select it in
the field and you can also allow users to enter data directly in the field.

Accounts | ⚫ 167

Note
Any changes you make to the user tables are also reflected on the Marketing tab in the Contact
window (see page 178).
Under Custom Data, enter further information about the account, for example, its web site or LinkedIn URL.
Tip
The Custom Data fields are text fields that can be used for any purpose (up to 255 characters per
field). The labels of the fields shown in the figure below are the default labels, but you can change these to
anything you want by editing the Account Custom Labels table with Table Editor. (You can edit the records in the
Account Custom Labels table, but you cannot delete or add records.)

Note

You must save the account before using the following procedures.

Master Account

Add charges to job

Notes

Add charges to invoice

Master Account
If you are creating a sub-account for a customer with centralized payables (known as a master account in
PrintSmith), click Master Account to select the central payables account. (For more information, see “About
Master Accounts” on page 155.) The master account must already exist and cannot be a sub-account that is
already linked to a master account.

Add Charges for jobs or invoices
Under Add Charges you can select charges to apply as predefined charges to invoices and estimates created
for the account and/or to jobs created for the account. (For information about charges, see the section that
begins on page 81.)
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Notes
Use Notes to enter notes that are displayed in different contexts.
Important These notes are all designed for small amounts of text (up to 255 characters). They are not for
lengthy messages or for record keeping; use the Log tab instead.
1.

2.
3.

4.

In the Account selection notice field, enter a note for one of two purposes:
•
To notify your users of something special about the account whenever the account is selected for a
document.
•
To place these notes in the Special Instructions field of a document.
When you select an account for an estimate or invoice (or copy a document for the account), a window
opens displaying this notice and asks if you want the text copied to the Special Instructions field.
In the Notes to insert in each job field, enter the text that you want automatically copied to job ticket notes
whenever a new job is created for the account. (This text is not copied to job ticket notes for existing jobs for
the account.) For example, you may have a customer for whom you will not start production unless a proof
was signed, or to whom you always return the artwork. If you enter this information in the Notes to insert in
each job field, the note is automatically included on the job ticket.
In the Notice to place on statements field, enter the text that you want to include on statements generated
for the account. For example, you can enter text to customize collection notices for an account or to remind
a customer of upcoming repeat orders. (The notice is included on statements if the Show customer
statement notes check box is selected on the Output tab in the Generate Statements window. To access
this in the Legacy version go to AR > Generate Statements.)

Log
Use the Log feature to record your interactions with the customer, flag items for follow-up, indicate that an issue
is complete (resolved), and review information in the log.
In addition to information you enter directly on the Log tab in the Customer window, the following are logged
automatically:
•

•

Documents e-mailed to the customer from the Invoice, Estimate, Cash Register, Post Payments,
Journal Entry, and Generate Statements windows are logged automatically on the Log tab if you
configured e-mail logging in your E-Mail preferences. Both the Type and Comment for an e-mail item
come from the E-Mail preferences.
Any information that is entered in the Notify Customer window is logged automatically. These log entries
are preceded by (Notified) on the Log tab.

Tip
The Notify Customer window can be opened by clicking a Notify button in these windows in
PrintSmith Vision: Pending Documents, Contact, Work in Progress, Post Payments, and Journal Entry.
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1. To log the communication you had with the customer:
a. Select Add New
b. To categorize the kind of communication you had, select a Type, for example, CALL or VISIT
If you selected a Type, some default text is displayed in the Add to customer account log field. Edit this text or
enter your own (up to 255 characters).
Tip
The selections in the Type field and the default text in the Add to customer account log field
come from the Customer Log Type table.
c. Click Add.
2. To see a log entry in full, select it in the list at the left of the Log tab so it gets displayed at the right of the tab.
Tip
If the log includes many entries, shorten the list by entering part of the entry in the blank field and
select the look up button.
3. To edit a log entry, select it in the list, make your changes, and click Done.
4. If follow-up is required for a particular log entry:
a. Select the log entry in the list.
b. Select the Follow-up required check box.
c. In the Follow-up date field, enter or select the date on which you need to contact the customer.
d. The Follow-up by field is automatically set to your user name, but if you want another user to do the
follow-up, select that user.
e. In the Follow-up comment field, enter more details (up to 255 characters) of what needs to be done.
f. Click Save.
4. To indicate that the issue raised in a log entry was resolved:
a. Select the log entry in the list.
b. Select the Completed check box.
c. In the Date Completed field, select the date on which you resolved the issue.
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d. The Completed by field is automatically set to your user name, but if another user was responsible for
resolving the issue, select that user.
e. In the Action taken field, explain what was done (up to 255 characters) so you have a record of it.
5. To remove an entry from the log, select it in the list and click Delete.
6. To print the entire log for the customer, click Print Log. This will print only the follow up log information.
For activities you can select how far back you want to see by selecting 30, 90, 180 days or all.

Web
If you are using eFlow based MDSF Integration, the customer window also includes a Web button. (For
information, see section Register Accounts and Contacts to Market Direct StoreFront starting on page 180.)

Sales Info
The Sales Info button in the customer dashboard contains sales statistics. As you do business with the
customer, information will become available over time and you can view that information here. You can update
the customer’s statistics and perform an instant aging of the account.

There is a pie chart which shows this customer’s aging.

The next chart displays customer account statistics for different periods.
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Sales statistics for this month, this year and last year.
Year over year growth
Quotes Vs Orders – The ratio of estimates to orders. This helps to identify accounts for which you are continually
entering estimates but rarely getting jobs. The number of estimates may not be exact. PrintSmith Vision counts
an estimate only when you save it. If the account is in use in another window or by another user, it is not
counted. An estimate is also not counted if you change the account on an existing estimate.
Estimate Won Vs Lost
Sales Ranking will compare the sales volume of the account to other accounts. For a rank to be available, you
must run and save the Account Ranking report. The sales ranking is based on the last time you ran the report.
Another chart shows the sales trend for different periods. You can choose to the order trend for 1 month, 3
months, 6 months of 1 year. If you hold your cursor over a period it will display the total number of orders and
sales during that period.
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Sales Dates
Created
Last Billed
Last Payment

Last Aged
Last Invoice
Last Estimate
First Invoice
First Estimate
Estimates Won/Lost

The date the account was created in
PrintSmith Vision.
The date a statement was last generated for
the account.
The date the last payment was received for the
account and recorded with AR > Post
Payments.
The date the account was last aged.
The date the last invoice was created.
The date the last estimate was created.
The date the first invoice was created.
The date the first estimate was created.
The ratio of estimates that were won (you got
the business) to estimates that were lost.
PrintSmith Vision tracks this information
automatically.
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Contacts
Contacts are the people associated with an account, for example, those who receive statements or invoices or to
whom you send promotional mailings. An account may have a single contact or may have many; it depends on
the account.
Although you can enter some contact information while working with a customer account (from the Contact and
Address tab in the Customer window; see page 157), you may want to enter additional information about
contacts or create additional contacts, perhaps with different addresses. In addition, some information – as
specified in the Mandatory Fields preferences – may be required. (Required fields are outlined in red.)
You can access the contacts window by clicking Contacts in the Quick Access panel (or select AR > Contacts.)

Understanding the Contact Window
Customize
list

Each contact is color coded to indicate if the parent is account, parent is prospect or no parent is assigned.

A default account is identified by the symbol
You manage the information about your contacts in the Contacts window. To open this window, click Contacts in
the Quick Access panel (or select AR > Contacts.) You will be shown a list of contacts and column headings.
You can search on any of the headings but to select a contact you must click on the contact name. You can
customize the column to be displayed on the list using the Customize feature. Some of the columns cannot be
removed and they will be grayed out.
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Sync with MDSF

Delete Contacts

Selecting one or more contacts using the check box to the left will allow you to delete contacts or sync them with
MDSF. (For information, see section Register Accounts and Contacts to Market Direct StoreFront starting on
page 180.)

Deleting Contacts
You can delete a contact only if the contact is not in use in the system or is not the default contact for an
account.
1. In the Quick Access panel, click Contacts (or select AR > Contacts). The Contact Picker window opens.
2. Find and display the contact you want to delete.
3. Click Delete on the toolbar and then click Yes to confirm the deletion. (If the Delete button is unavailable for a
contact, the contact cannot be deleted.)

Editing Contacts
You can edit the contacts for an account. For example, you may want to change an address or log your
interactions with the contact.
1.

Click Contacts in the Quick Access panel (or select AR > Contacts). The Contact Picker window opens.

176 ⚫ EFI Productivity Suite | PrintSmith Vision User Guide

2.

Find and open the contact you want to edit and select Edit Contact

3.

Make your changes on the tabs. (For information about the fields on the tabs, see the sections that begin
with “General procedures for creating contacts” on page 176.) Note the following on the Address tab:
•
•

4.
Tip

A <default contact> serves as both the shipping and billing contact. If nothing is displayed, the contact
is assigned to an account but is neither the shipping nor the billing contact.
You can change the account to which the contact is assigned for any type of contact except the default
contact. You can only change the default contact for an account on the Address tab in the Customer
window. (See page 160.)

Click Save on the toolbar.
To create a new contact from the Contact window, click New Contact on the toolbar.

General procedure for creating contacts
1.

Select Create Contact

2.

Select the account name

3.

Select the sales rep

4.

If the contact is for a person rather than a business account, select the Personal Account check box. This
setting helps you segregate personal accounts for targeted mailings.

5.

Select the Do not mail check box to remove the contact from labels or mail merge files generated with
Reports > Mailing Labels

6.

Contact type is for MDSF

7.

Click the Address tab to enter or edit basic information about the contact. (See page 174)

8.

Click the Marketing tab to provide information that is useful in targeting marketing materials to the contact.
See page 178.

9.

If you are using integrated credit card processing in PrintSmith Vision, use the Credit Info tab to save credit
card information for the contact. For information, see the guide PrintSmith Vision - Secure Credit Card
Processing.

10. Enter MDSF name for this contact
11. Click Save on the toolbar.

Contact Address tab
Contact Detail and Communication Address
Here you can enter the name and other information about the contact. If you e-mail documents to customers, be
sure to include an e-mail address for all contacts. The communication address for the contact is highlighted in
red to indicate it is required.
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Select the Use Contact Address check box if you want to use the contact address instead of the account
address when you select the contact for estimates or invoices. When you select this check box, the Address
area becomes available below the check box. Click Edit to provide the address

Shipping Address

A contact may have many shipping addresses. You can select a shipping address at various points when
creating jobs for the account, for example, in the Account Info window or on the delivery ticket. Under Shipping
Address, manage the shipping addresses for the contact as follows:
•
•
•

To add a shipping address, click Add New and complete the Edit Address window. The address is then
listed under Shipping Address (as shown in the figure below).
To edit a shipping address, select it under Shipping Address and click Edit.
To remove a shipping address, select it under Shipping Address and click Delete.
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Marketing tab

Use the Marketing tab to provide information about a contact to help you with promotional mailings aimed at
particular contacts. This tab is similar to the Marketing tab for a customer account but applies to a contact.
Note
Several fields on the Marketing tab are related to tables you maintain with Table Editor. See steps
3 and 4 below. If you did not already do so when setting up accounts, you may want to review and edit these
tables before starting to enter information on this tab.
1. If the contact is for a person rather than a business account, select the Personal Account check box. This
setting helps you segregate personal accounts for targeted mailings.
2. Select the Do not mail check box to remove the contact from labels or mail merge files generated with
Reports > Mailing Labels.
3. Under Address, enter up to five dates for any purpose, for example, Anniversary or Birthday.
Note The labels of the five fields under Address are stored in the Marketing Date Labels table and are initially
named User 1 through User 5. If you did not already do so when setting up accounts, use Table Editor to
change these labels to suit your purposes. Any changes you make to the field labels are also reflected on the
Marketing tab in the Customer window (see page 178).
Under Marketing Tags, provide further information about the account. Note the following:
•
•

The Lead Source fields both use data from the same table (named Lead Source). Use Table Editor to
change what this table includes.
Eight User tables are available for customization. You can use Table Editor to change the name of a
User table (which will change the label of the corresponding marketing tag field) and to edit the contents
of a table. For example, the figure below shows several renamed user tables: Common Interest, Likes,
Type of Work, Sport Interest, and Mailer Type. You can enter data in the table, so users can select it in
the field and you can also allow users to enter data directly in the field.
Note
Any changes you make to the user tables are also reflected on the Marketing tab in the
Customer window (see page 178).

•

The Gender field uses data from the Gender table and the Age Range field uses data from the Age
Range table. (If either field is required – as specified in the Mandatory Field preferences – it is outlined
in red.)
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Credit Info tab

If you are using integrated credit card processing in PrintSmith Vision, use the Credit Info tab in the Contact
window to save credit card information for a contact. Here you can enter the information about the account
holder. Then select add card. This will take you to the USA ePay site where you can enter the information about
the credit card. Save the information and you will get a message from USA ePay that the transaction was
successful. On the credit info tab the card holder name and the account numbers last four digits will be
displayed.
For more information, see the guide PrintSmith Vision - Secure Credit Card Processing.
You can delete the card information by selecting the delete button.

Using the Web tab for a contact
If you are using eFlow based MDSF Integration, the Contact window also includes a Web button. (For
information, see section Register Accounts and Contacts to Market Direct StoreFront starting on page 180.)
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Register Accounts and Contacts to
Market Direct StoreFront
Understanding the relationship between accounts, contacts and
MDSF
A customer account in PrintSmith Vision is equivalent to a company in Marketing Direct StoreFront.
Contacts in PrintSmith Vision are equivalent to users in Marketing Direct StoreFront. The users, also known as
buyers, place orders on the Marketing Direct StoreFront site.
Information about accounts and contacts when sent from PrintSmith Vision to Market Direct StoreFront is known
as registering accounts and contacts. If you update a company or user in Market Direct StoreFront, the
corresponding account or contact is updated in PrintSmith Vision. But, if you delete a company or user in Market
Direct StoreFront, the corresponding account or contact remains in PrintSmith with no indication it is no longer
present in Market Direct StoreFront.
Note
If you make changes to an account or contact in PrintSmith Vision after the account or
contact is registered, the changes are sent to Market Direct StoreFront automatically.

Registering accounts and contacts to MDSF
Before you can register a contact as a buyer in Market Direct StoreFront, the contact must have an e-mail
address and a MDSF user name defined in PrintSmith Vision.
Before you can register an account as a company in Market Direct StoreFront, the account must have at least
one contact with an e-mail address and MDSF user name defined.
You can register accounts and contacts in different ways, but in all cases you must first make sure that contacts
have e-mail addresses and MDSF user names.

Method 1: Register a contact and automatically register the account
Start by going through your accounts and identifying those contacts you want to register as buyers for the
account (this is often all the contacts). When you register a contact, the contact’s account is also automatically
registered (if not already registered).
1. For each account you want to register in Market Direct StoreFront as a company, do the following:
a. Click Accounts in the Quick Access panel (or select AR > Accounts).
b. In the Account Picker window, select an account.
c. On the Address tab, in the Contact List field, select a contact you want to be a buyer in Market Direct
StoreFront and click Open Invoice Contact Button.

The Contact window opens.

Register to MDSF | ⚫ 181

Tips

You can also open a contact by clicking Contacts in the Quick Access panel and selecting a
contact in the Contact Picker window (contacts are always identified by their accounts). If you are
creating a new contact, you must save the contact before you can register the contact. The contact
must also be associated with an account.

2. In the MDSF User Name field, enter a unique name. The contact will use this name to log into the Market
Direct StoreFront site.
3. Click on Web button.
Note:
If the name is not unique, you will be asked if you want to use the e-mail address as the user
name. Click Yes or No.
If you click No, enter a different name and click Web button again.

4. After you click Web button, a message informs you that registration was initiated, and that
the contact will be e-mailed login information after registration is complete

After registration is complete:
•

The contact is registered as a user in Market Direct StoreFront.

•

The contact receives an e-mail with a link to the Market Direct StoreFront site and a user name and
password. After first logging in, the user will be forced to change the password.

•

The account with which the contact is associated is also registered in Market Direct StoreFront (unless
it was already registered)

Important

Never add, edit, or delete a company in Market Direct StoreFront because that information is not
sent to PrintSmith Vision. Companies (meaning accounts) must always be managed from
PrintSmith Vision.
Or click of Web button in the Contacts window:
•
There is an Update Contact button so you can update contact information in Market Direct StoreFront if
it changes.
•
The Last Registration Date and Registration Status are updated.
•
The Unregister Contact button becomes available. You can use this if you no longer want the
contact to be a user in Market Direct StoreFront
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Method 2: Register individual accounts and their contacts
You can also register an account from the Customer window, as long as the default invoice contact
for the account has an e-mail address and MDSF user name defined. If the account has other contacts
that you want to register as users in Market Direct StoreFront, they must also have an e-mail address and
MDSF user name defined.
1.
2.
3.

Click Accounts in the Quick Access panel (or select AR > Accounts).
In the Account Picker window, double-click the account you want to register.
Click the Web button
a. You will be asked if you want to register default contact(s).
b. Click Yes to register default contact(s) or No to select specific contacts if the account has multiple
contacts. If you clicked Yes, registration is initiated.
If you clicked No, in the Customer’s Contacts List window, select the check boxes of the contacts
you want to register as users in Market Direct StoreFront and then click Select Contact(s).
Note
If a contact is missing a MDSF User Name or E-mail, you will not be able to register the
contact without providing the missing information.
c.

You could now provide the missing information in Account contact list’s popup itself, just click in the
space under column of MDSF User Name and E-mail, you would be able to edit the information

4.

When you receive a message informs you that registration was initiated, and that the contacts will be emailed
login information after registration is complete, click OK to continue.

After registration is complete, as with the first method of registering accounts and contacts, both a company and
user(s) are created in Market Direct StoreFront the information under Web button is updated, and the contacts
receive an email with login information.

Register to MDSF | ⚫ 183

Method 3: Register multiple accounts in one step
If the default invoice contacts for accounts you want to register in Market Direct StoreFront already have an email address and MDSF user name defined, you can register all the accounts and all their default invoice
contacts in one step.
Important

1.
2.

When you register several accounts in one step, only the default invoice contacts for the accounts
are registered as users in Market Direct StoreFront. If an account has multiple contacts that you
want to register, either register the account as described for Method 2 above or register the
contacts individually from the Web tab in the Contact window as described for Method 1.

Click Accounts in the Quick Access panel (or select AR > Accounts).
In the Account Picker window, select the check boxes of the accounts you want to register
If the default invoice contact for an account is missing a MDSF user name or Email id, you are notified, and
will not be able to register the account until the contact has a MDSF User Name (on the Web tab in the
Contact window).

3.

Click Register Account.
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4.

After you click Register Account, a message informs you that registration was initiated, and that the contacts
will be e-mailed login information after registration is complete

After registration is complete, the accounts will have Globe icon next to check box in the Account Picker
window.
If you have a long list of accounts, you can enable MDSF Register toggle in the Account Picker window to
see all the accounts that are registered with Market Direct StoreFront.
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Updating accounts and contacts
If you change some information about an account or contact that is already registered, the information is
sent to Market Direct StoreFront automatically to update the corresponding company or user in Market
Direct StoreFront.
Some changes to an account, however, for example, to the address, are not automatically updated for a
contact that uses the address. In this case update the contact manually as described below.
1.
2.

Open the account or contact in PrintSmith Vision and click the Web Button in the Customer or
Contact window.
Click Update Account or Update Contact depending on what you are updating.

Unregistering accounts and contacts
If you want to delete a particular company or user in Market Direct StoreFront, you must unregister the account
or contact in PrintSmith Vision. The account or contact will still exist in PrintSmith Vision, but the corresponding
company or user will be deleted in Market Direct StoreFront.
When you unregister an account, no contacts (users) associated with the account can place orders in Market
Direct StoreFront. When you unregister a contact, that person can no longer place orders in Market Direct
StoreFront.
Important

1.
2.
3.

Never delete a company or user in Market Direct StoreFront because that information is not sent to
PrintSmith Vision. Companies (meaning accounts) and users (contacts) must always be removed
from Market Direct StoreFront by being unregistered in PrintSmith Vision.
In PrintSmith Vision, open the account or contact you want to unregister (delete from Market Direct
StoreFront).
Click the Web button in the Customer or Contact window.
Click Unregister Account or Unregister Contact depending on what you are deleting.

The company or user is then removed from Market Direct StoreFront.
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Account History
You can access account history by selecting the icon in the quick access panel or using the menu on the left of
the screen by selecting Accounting > Reports >Account History.

The initial display of account history will be in document order. You can sort by selecting a customer and then
further refine you search by History Type and Period. When a customer is selected their Current Balance and
Merchandise Balance will be displayed next to the History Type.

The options for Period are:
All

Starts with the first item posted to the account.

First Open

Starts with the first open (unpaid) item and
continues to the end of the list. (The history
shows all items after the first open item. This is
generally more useful in checking on payment
status than AR > Post Payments, which
shows only open items.)

This Month

Starts with the first item in the current month.

Prior Month

Starts with the first item in the previous month.
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This Qtr
This Year

Starts with the first item in the current quarter.
Starts with the first item in the current year.

Last Year

Starts with the first item last year.

You can further search for specific transactions by using the column headers just as you would for other
programs. For the date range column click on the starting date, then click on the ending date and then use the
select button.
The columns in the account history report include the following:
Posted

The date that the entry was posted to the
account history. Entries are displayed in the
order in which they were posted. To reverse
the order, click the column header.

Document Number

The number of the invoice posted to the
account

Title

A description of the document. For invoices,
this is the invoice title. For payments, the
description is generated by PrintSmith Vision
when the document is posted. (To change the
description, select the document, click
Properties on the toolbar, and edit the
Change Description to field.)

Total

The amount of the document when it was
originally posted. The total is underlined if there
was a deposit on an invoice.

Contact Name

The default contact for this customer.

Paid on

For invoices and journal entries, the date a
payment was last applied to that item. For
payments, the date is blank
.
For invoices and journal entries, the check
number or credit card reference (authorization)
number.

Ref #

PO#

The purchase order number, if any.

User

The name of the user

Sales Rep

The name of the Sales Rep associated with
this account.

Balance Due

The current balance due on the item. Negative
amounts are credit balances that were not
applied to a debit (invoice or debit memos).
Items with no balance due were paid off or fully
applied (payments and credit memos).
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The three-dot ellipsis will display different options depending on the type of transaction. For invoices you will
have the options to Open in new tab, Notify Customer, Properties or Print Invoice. For the other transactions the
only option is Properties. If necessary you can change the Description when viewing the Properties.
Open in new tab will take you to that invoice.
Notify Customer will bring up that feature. (see 121)
Properties will display the details for that transaction
Print Invoice will print the invoice

Analyze account will give you a report on the account of their Sales Breakdown, Receipts Summary and
Production Data. Analyze Selection will give you the same type of information but just for those transactions that
you selected by using the box to the left of the item.
Other options for account history include
Notify Customer Clear Filter

Print Data

Copy an Invoice
If you previously created an invoice for a customer, and want to re-use it, you can go to the customer’s account
history and re-create the invoice:
1.
2.
3.

Select Reports > Account History and select the account you want.
Find the invoice you want to re-use and double-click it.
The invoice opens in a locked state. Select Invoice > Copy > Copy to New Invoice to create a new
invoice based on the old invoice. You can also select to Copy to New Estimate.

The documents in account history are “locked” since they form part of the audit trail PrintSmith Vision maintains.
All details in the document are retained, however, and you can copy these documents to new estimates or
invoices. You can update the pricing with the latest prices when you copy a document, but all of the descriptive
information and notes you made on the job (the location and condition of the artwork, special pricing instructions,
and so on) are retained.
When you copy a document from history, PrintSmith Vision keeps track of the source document. For example,
the old document number is displayed in the document window and printed on job tickets. If you file artwork by
document number, and get a repeat order, the job ticket has the old document number so you can locate the
artwork.

Editing Account History
You can edit the Title for any transaction in account history and you can edit the PO number for invoices.
Select the edit Icon.

to edit.
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Estimating History
You can access Estimating History by selecting the icon in the quick access panel or using the menu on the left
of the screen by selecting Accounting > Reports > Estimating History.

The Estimating History report will display all historical invoices. You can select a specific account to display and
further filter the estimates by the Period the estimate was created. The options are:
All, this month, prior month, this quarter, this year or last year.
The columns in this report include the following:
Account

The account under which the estimate was created

Estimate #

The number of the estimate.
The date that the estimate was created.
The date that the estimate was created

Created
Title

A description of the estimate. (To change the
description, select the estimate, click
Properties on the toolbar, and edit the
Change Description to field.)\

Total
Status

The amount of the estimate.
The won/lost status of the estimate.

Invoice #

The invoice number if the estimate was
converted to an invoice (because the
customer accepted the job).

Off Pending

The date the estimate was removed from the
pending list.

Reason

The reason the estimate was lost
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Across the top of the report there are 4 displays that will show the total estimates, estimates won,
estimates lost and estimates that are neutral. In each display there are two numbers, the first represents
the total of that category for the customer selected and the second is the total of all estimates in history
for each category.
The colors representing each category are also used along the left of the estimates to show the category
for each estimate.

Reasons
You can define the reasons for a lost estimate. Reason codes are set up under Table Editor > Reasons.
You can enter a reason code for an estimate from either the Estimate History Report or from

Selecting the + will open a new field where you can enter a new reason. Updating the reason string will update
the existing reasons string in the Estimate history window. Reason codes

Changing the Status of an Estimate
Normally, the status (Won, Lost, or Neutral) of an estimate is determined by the system, but you may need to
change the status yourself. For example, if a customer decides to go ahead with an order after all, you can
change the status of an estimate to Won. Also, if you created several estimates for a job, but only used one of
them, you would typically set the status of the unused estimates to Neutral (since they were neither won nor
lost). For more information about won/lost status, see below.
To change the status of an estimate, select it in the Estimate History window and then select Won, Lost, or
Neutral in the Status field.
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To keep accurate won/lost records, keep the following in mind:
•

•
•
•
•

When you convert an estimate on the pending list to an invoice, the original estimate is placed in history
and considered Won. When you copy an estimate to an invoice, the original estimate remains in the
pending list and is not put into the estimate history (and is therefore not considered won or lost). For this
reason EFI recommends you use Invoice > Convert to Invoice and not Invoice > Copy to New
Invoice when changing an estimate to an invoice.
When an estimate is converted to an invoice, the winning invoice number is recorded in the historical
estimate and included in history. If you open a historical estimate that was won, the deposit entry area
in the Estimate window shows the number of the invoice to which the estimate was converted.
If you convert a previously lost estimate to an invoice, the status of the estimate is changed to Won in
estimate history. You can only convert an estimate to Won once.
If you use Admin > Clear Estimates to clear estimates from the pending list, during this process you
can indicate whether the estimates were Lost or are Neutral (neither Lost nor Won). When the system
auto-archives estimates, however, they automatically are given a status of Lost
If you make a mistake and want to discard the estimate, void it. A voided estimate does not affect the
won/lost ratio and is not recorded in estimate history.

Using the ellipsis will give you some other options:
Open in new tab will open the selected estimate in a new window
Notify customer will give you the screen for notifying customer.
Estimate notes allows you to add notes about that estimate such as to explain unusual features or explain why
an estimate was lost. You can identify if there are notes for an estimate by the icon to the left of the check box.

Notes can also be edited.
You also have the following options for the Estimate History report.
Print Data

Clear Filters

Download as CSV

Copying an estimate
1.
2.
3.

Find the estimate you want and double click on the estimate number.
The estimate opens in a locked state. Enter the product and then select Copy
Select Copy to New Estimate or Copy to New Invoice.

The documents in account history are “locked” since they form part of the audit trail PrintSmith Vision maintains.
All details in the document are retained, however, and you can copy these documents to new estimates or
invoices. You can update the pricing with the latest prices when you copy a document, but all of the descriptive
information and notes you made on the job (the location and condition of the artwork, special pricing instructions,
and so on) are retained.
When you copy a document from history, PrintSmith Vision keeps track of the source document. For example,
the old document number is displayed in the document window and printed on job tickets. If you file artwork by
document number, and get a repeat order, the job ticket has the old document number so you can locate the
artwork.

Changing an Estimate Title
When you hover the mouse over the estimate title you will see the full title and also a symbol that when selected
will clear the current title and provide you a place to enter a new title.
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Import Stock
Importing Stock Catalogs
In addition to entering stock definitions, you can import stock definitions and update prices from an electronic
price catalog from a vendor, as long as the import file meets certain requirements as described below.

Stock import file format
•
•

To import stock definitions successfully, the import file must be in the correct format.
The file must be a comma-delimited (CSV) text file.

Important The delimiters used in the CSV file must match what is specified in the Default CSV Separator
and Default CSV Quote Character fields in your International preferences. If these fields are blank in the
International preferences, the CSV field separator defaults to comma (,) and the quote character used to enclose
text strings defaults to double-quote (“), which are the standard delimiters in the U.S. In other countries, different
delimiters are used and can be specified in the International preferences
•

The following fields are mandatory and if they are not filled in then the import will not be successful. The
mandatory fields are marked with an asterisk * on the mapping screen
o Vendor Name
o Unique Stock ID
o Stock Name

In addition, if you do not have a vendor listed then it might create a new stock
•
•

•
•
•

Each stock must have a unique ID (stock ID). If you do not know or have a stock ID, you must obtain it or
make one up and enter the ID in the import file for the stock to be imported correctly.
By default, column E of the stock import file includes a single uppercase letter corresponding to a stock
group, e.g., S= sheet, R = roll (see “Fields in import file” below). If you want to use a different character for a
stock group, you can use Table Editor to edit the Stock Group table and enter an uppercase letter in the Key
(Alpha) column for a particular stock group. During a stock import, if the character in column E of the import
file matches a value in the Key (Alpha) column in the Stock Group table, the stock is assigned to that stock
group. Otherwise, the stock import uses the standard values as described for column E in the table below.
If any information about the stock is not available or does not apply, leave the field blank in the import file.
(Otherwise, data will shift over to the wrong field.)
For a stock definition to be updated, the stock number and vendor name in the import file must match
exactly what is already in PrintSmith Vision.
The following fields must not have decimal formatting, or they will be imported as 0: Costing units, Bracket
1-5 qualifier (1-6 qualifier for the HTML version) Lot count, and Carton count.

Fields in import file
The fields in the import file should be as listed below.
Note: To help you keep track of the fields, the first column in the table below has column letters (corresponding
to columns in a spreadsheet). These are just to help you verify that all the necessary fields are in the import file.
In the HTML version you can map fields so the actual column number is not critical.
You can download a sample csv file to see the format.
There are two different file formats, one for Flex (Legacy) and one for the Fast Track (HTML) Version. While this
document deals primarily with the HTML version the Flex version has also changed so it is included here for
reference.

Important: You must never use the HTML csv file version for importing into the
FLEX version as it will corrupt your data.
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Flex version column headers.

Col

Field

Value

A

Vendor name

The name of the vendor (up to 70
characters). If not supplied, the
name in the Default vendor
name field on the Preview tab in
the Import Stock Catalog window
is used instead. The vendor
name is required for price
updates of existing stock
definitions.

B

Unique stock ID

(Required) A unique vendor stock
ID (up to 40 characters) – this is
the Stock # in the stock definition
in PrintSmith.

C

Parent sheet size

The parent sheet size in decimal
format (no fractions), for
example, 8.5x11.00.

D

Stock name

The name of the stock (up to 70
characters).

E

Stock group

The stock group (a single
uppercase letter):
S-Sheet
R-Roll
E-Envelope
C-Carbonless
O-Other
If this field is blank, this defaults
to S (sheet).
If, however, the Stock Group table
includes a Key (Alpha) value that
is used in the import file, the stock
is associated with that stock
group.

F

Costing units

The costing units – the quantity in
which the stock is priced. (This
must not have decimal formatting,
or it will be imported as 0.)

G

Basis weight

The basis weight of the stock.

H

M weight

The M weight (weight of 1000
sheets) of the stock.

I

Caliper

The caliper or thickness of the
stock.

J

Envelope size
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The size of the envelope. (An
entry must exist in the Dimension
table for each envelope size.)
Only applicable if unit description
(in column E) is set to E. If blank,
sheet size is used.
K

Bracket 1 pricing

The first bracket pricing (see the
Settings tab in the Import Stock
Catalog window).

L

Bracket 2 pricing

The second bracket pricing.

M

Bracket 3 pricing

The third bracket pricing.

N

Bracket 4 pricing

The fourth bracket pricing.

O

Bracket 5 pricing

The fifth bracket pricing.

P

Bracket 1 qualifier

Q

Bracket 2 qualifier

Quantity break for pricing in
bracket 2 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

R

Bracket 3 qualifier

Quantity break for pricing in
bracket 3 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

S

Bracket 4 qualifier

Quantity break for pricing in
bracket 4 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

T

Bracket 5 qualifier

Quantity break for pricing in
bracket 5 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

U

Color

The stock color, up to 30
characters. (You must supply
either this or a generic color.) If
the color is not currently in the
Stock Colors table, it is added to
the table.

V

Generic color

W

Product finish

Quantity break for pricing in
bracket 1 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

A generic color (up to 30
characters) as defined in the
Generic Colors table. (You must
supply either this or a stock
color.) If the color is not currently
in the Generic Colors table, it is
added to the table.
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The finish (dull, gloss, and so on),
up to 20 characters. This is added
to the product name.
X

Carbonless parts

The number of carbonless parts.
Only applicable if the unit
description (in column E) is set to
C.

Y

Price expiration date

Date in mm/dd/yyyy format after
which the price is no longer valid.

Z

Not used

Not used

AA

Lot count

Minimum order quantity (lot
count). (This must not have
decimal formatting, or it will be
imported as 0.)

AB

Carton count

Number of sheets per carton.
(This must not have decimal
formatting, or it will be imported
as 0.)

AC

Stock type

The numeric stock type ID as
defined in the PrintSmith Basic
Sizes table:
1 = Business Papers
2 = Book Papers
3 = Cover Papers
4 = Index
5 = Tag Board
6 = Blanks
7 = Vellum Bristol
9 = Blotter
10 = Label
11 = Newsprint
If you leave the stock type blank,
but provide the basic size (next
field), the system looks up the
stock type in the Basic Sizes
table.

AD

Basic size

The basic size in decimal format
(no fractions), for example,
25.5x28.5.

AE

Metric size

A setting that indicates if the
stock is metric: Y or N.

AF

Product coating

A setting that indicates if and how
stock is coated:
0 = Not coated
1 = Coated one side
2 = Coated two sides

AG

Grade

The numeric ID of a grade as
defined in the PrintSmith Stock
Grade table.

AH

Percentage

The percentage of recycled
matter, for example, 10% or .10.
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AI

Type of management

The type of forest management
(up to 70 characters) from the
PrintSmith Stock Forest
Management table, for example,
Green Seal Certified. If not
found in the table, it is added to
the table.

AJ

FSC Certified

A setting that indicates if the
stock is FSC certified:
Y or N (or 1 or 0)

AK

SFI Certified

A setting that indicates if the
stock is SFI certified:
Y or N (or 1 or 0)

AL
Green Seal Certified

A setting that indicates if the
stock is Green Seal certified:
Y or N (or 1 or 0)

AM

Normal Run Size

The normal run size for this
material

AN

MDSF Display Name

The name that is displayed
for this stock in MDSF

AO

MDSF gsm Weight

The gsm weight for this stock
as displayed in MDSF

AP

MDSF Media Type

AQ

MDSF Media Weight
Description

The media type for this stock
As displayed in MDSF. For
example, envelope, letterhead,
Plain paper.
The media weight description
As displayed in MDSF. For
example, Bond (20 pound)/75
gsm

Fast Track (HTML) version column headers.

Col

Field

Value

A

Vendor name

The name of the vendor (up to 70
characters). If not supplied, the
name in the Default vendor
name field on the Preview tab in
the Import Stock Catalog window
is used instead. The vendor
name is required for price
updates of existing stock
definitions.

B

Unique stock ID

(Required) A unique vendor stock
ID (up to 40 characters) – this is
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the Stock # in the stock definition
in PrintSmith.
C

Parent sheet size

The parent sheet size in decimal
format (no fractions), for
example, 8.5x11.00.

D

Stock name

The name of the stock (up to 70
characters).

E

Stock group

The stock group (a single
uppercase letter):
S-Sheet
R-Roll
E-Envelope
C-Carbonless
O-Other
If this field is blank, this defaults
to S (sheet).
If, however, the Stock Group table
includes a Key (Alpha) value that
is used in the import file, the stock
is associated with that stock
group.

F

Costing units

The costing units – the quantity in
which the stock is priced. (This
must not have decimal formatting,
or it will be imported as 0.)

G

Basis weight

The basis weight of the stock.

H

M weight

The M weight (weight of 1000
sheets) of the stock.

I

Caliper

The caliper or thickness of the
stock.

J

Envelope size

K

Bracket 1 pricing

The size of the envelope. (An
entry must exist in the Dimension
table for each envelope size.)
Only applicable if unit description
(in column E) is set to E. If blank,
sheet size is used.
The first bracket pricing (see the
Settings tab in the Import Stock
Catalog window).

L

Bracket 2 pricing

The second bracket pricing.

M

Bracket 3 pricing

The third bracket pricing.

N

Bracket 4 pricing

The fourth bracket pricing.

O

Bracket 5 pricing

The fifth bracket pricing.

P

Bracket 6 pricing

The sixth bracket pricing

Q

Bracket 1 qualifier

Quantity break for pricing in
bracket 1 (in sheets). (This must
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not have decimal formatting, or it
will be imported as 0.)
R

Bracket 2 qualifier

Quantity break for pricing in
bracket 2 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

S

Bracket 3 qualifier

Quantity break for pricing in
bracket 3 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

T

Bracket 4 qualifier

Quantity break for pricing in
bracket 4 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

U

Bracket 5 qualifier

Quantity break for pricing in
bracket 5 (in sheets). (This must
not have decimal formatting, or it
will be imported as 0.)

V

Bracket 6 qualifier

Quantity break for pricing in
Bracket 6 (in sheets). (This mush
not have decimal formatting, or it
will be imported as 0.)

W

Color

The stock color, up to 30
characters. (You must supply
either this or a generic color.) If
the color is not currently in the
Stock Colors table, it is added to
the table.

X

Generic color

Y

Product finish

The finish (dull, gloss, and so on),
up to 20 characters. This is added
to the product name.

Z

Carbonless parts

The number of carbonless parts.
Only applicable if the unit
description (in column E) is set to
C.

AA

Price expiration date

Date in mm/dd/yyyy format after
which the price is no longer valid.

AB

Not used

Not used

AC

Lot count

Minimum order quantity (lot
count). (This must not have
decimal formatting, or it will be
imported as 0.)

A generic color (up to 30
characters) as defined in the
Generic Colors table. (You must
supply either this or a stock
color.) If the color is not currently
in the Generic Colors table, it is
added to the table.
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AD

Carton count

Number of sheets per carton.
(This must not have decimal
formatting, or it will be imported
as 0.)

AE

Stock type

The numeric stock type ID as
defined in the PrintSmith Basic
Sizes table:
1 = Business Papers
2 = Book Papers
3 = Cover Papers
4 = Index
5 = Tag Board
6 = Blanks
7 = Vellum Bristol
9 = Blotter
10 = Label
11 = Newsprint
If you leave the stock type blank,
but provide the basic size (next
field), the system looks up the
stock type in the Basic Sizes
table.

AF

Basic size

The basic size in decimal format
(no fractions), for example,
25.5x28.5.

AG

Metric size

A setting that indicates if the
stock is metric: Y or N.

AH

Product coating

A setting that indicates if and how
stock is coated:
0 = Not coated
1 = Coated one side
2 = Coated two sides

AI

Grade

The numeric ID of a grade as
defined in the PrintSmith Stock
Grade table.

AJ

Percentage

The percentage of recycled
matter, for example, 10% or .10.

AK

Type of management

The type of forest management
(up to 70 characters) from the
PrintSmith Stock Forest
Management table, for example,
Green Seal Certified. If not
found in the table, it is added to
the table.

AL

FSC Certified

A setting that indicates if the
stock is FSC certified:
Y or N (or 1 or 0)

AM

SFI Certified

A setting that indicates if the
stock is SFI certified:
Y or N (or 1 or 0)
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AN
Green Seal Certified

A setting that indicates if the
stock is Green Seal certified:
Y or N (or 1 or 0)

AO

Normal Run Size

The normal run size for this
material

AP

MDSF Display Name

The name that is displayed
for this stock in MDSF

AQ

MDSF gsm Weight

The gsm weight for this stock
as displayed in MDSF

AR

MDSF Media Type

AS

MDSF Media Weight
Description

The media weight description
As displayed in MDSF. For
example, Bond (20 pound)/75
gsm

AT

MDSF Media ID

The ID number as displayed in
MDSF. You can only map one
item to one MDSF Media ID

AU

New Unique Stock ID

If the vendor changes the stock
ID then this column allows them
to enter the new unique stock ID.

The media type for this stock
As displayed in MDSF. For
example, envelope, letterhead,
Plain paper.

Note:
For the HTML version only, If the file to be imported does not follow the mapping listed above you
can change the mapping using the import program prior to uploading. See Mapping the Import File on page 204.

Manually Mapping to MDSF
Manual mapping is used when you have a stock in the plant but may not want that stock listed in MDSF. Manual
mapping allows you to link the stock in the plant to the stock in MDSF for pricing only. You have two options in
manually mapping to MDSF. The first is in the Flex (legacy) version and the second is on the HTML version.

Manual Mapping in Flex
On the Flex (Legacy) version the mapping is done in Pricing > Stock Definitions. The procedure is similar to
registering individual stocks (see Market Direct StoreFront Integration Guide, Task 10: Register Stocks in Market
Direct StoreFront. The difference is that instead of selecting the Register Stock button and allowing the system to
determine the MDSF Media ID, you enter the ID of an existing item. By entering that ID number in the MDSF
Media ID field you are mapping the stock you are entering to an existing MDSF stock for pricing. Since the
pricing is controlled from MDSF the stock in the plant that is mapped to a MDSF stock will have the same pricing
plan as the MDSF stock.
Select Register Stock. Now the message will indicate that you are manual mapping instead of registering the
stock.
Note
In Flex (Legacy) MDSF is listed as DSF but that will be changed in a later release. For this
document it will be referred to as MDSF but the screen shots will still show DSF.
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Important

You cannot use the same MDSF stock for more than one mapped stock.

Enter the Media ID from an item that is already registered in MDSF.
Select Register Stock
You will get the message that the manual mapping of stock with DSF is saved.

Once the item is manually mapped the MDSF info screen will look like this.

Manual Mapping in HTML
During the Import process there is a column for MDSF Media ID. You can enter the ID number of an existing
MDSF item in the column and it will be manually mapped during the import. You can only manually map items
that have not been automatically assigned an ID by the system, those cannot be changed. If the item has already
been manually mapped and there is an MDSF ID in the field you can change to a different MDSF ID number.
Note
If you export a csv file from the data base there will be a column named Manually Mapped. That is
for information only and is not used for an import. You do not have to remove that colum n it will just be ignored
during the import.
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Import procedure
Warning
A large catalog from a vendor may take some time to import. For example, 15,000 stocks typically
take about 2 hours to import. Consider doing the import at night.
1.
2.
3.

Make sure you have an import file from a vendor (or have set up an import file yourself).
Select Pricing > Import Stock Catalog. The Import Stock Catalog window opens.
Select the file to be uploaded or you can drag and drop the rile.

Import Settings

•
•
•

Select the Verify each stock check box if you want to be asked – for each stock being imported –
whether you want to create a new stock definition or update an existing stock definition. This can take a
long time if the import file includes many records.
Select the Metric check box to import metric information. This automatically selects the Metric check
box in the stock definition, too.
Select the No Broken Cartons check box to set the Min. Order field in the stock definition to the value
of the lot count when importing stock.

Note
If you select the No Broken Cartons check box, after the stock import, the Charge Customer for
Entire Order check box is automatically selected on the Specification and Pricing tab in the Stock
Definitions window.
•

Select the Full update, not just Prices check box so that all information about existing stock is
updated when you click Update Prices, not just prices. For example, if the name of the stock changed,
it will be updated. If this is unchecked then only the prices are updated.
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Adjust Price Brackets By
•
•

Select Percent if you want to change the bracket price being imported by a percentage or select
Amount if you want to change it by a fixed dollar amount. Increase the price by entering a positive
percentage or amount or decrease the price by entering a negative percentage or amount.
Select the check boxes of the price brackets (Price 1 through Price 6) you want to adjust. If you select
just one bracket, for example, Price 4, the stock cost is placed in the first price column in the stock
definition. If you select two brackets, for example, Price 1 and Price 3, the bracket for price 3 would
also be imported into the price 2 column.

Mapping the import file
After selecting the file to import and the settings for the import select NEXT. This will take you to the Stock
Catalog Mapping screen. The mapping will automatically be done for any fields in the data base with the same
name as those in the csv file. Any that do not match will remain in the Drag to Target to map column and will
need to be manually mapped if they are to be used.

Once that is done you will see a sample of the data in the source csv. After mapping the file, you can save it by
entering the name in the field under Import Rule and then selecting SAVE. You can then use that mapping for
future uploads. If you have previously saved mapping rules you can select it from the dropdown.
You can un-map the entire import rule by using the un-map button or you can un-map individual items by
selecting the X for that target item. Selecting the three lines next to the X and dragging will allow you to move
that target to a different map location.
Note
The three source items identified with an asterisk * are mandatory and must be mapped in order for
the csv file to be properly imported.
Important
If you do not map a source item but there is data in that field in the data base the data for that item
will not be changed.
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Managing the Import Rules
Selecting Manage will give you a list of the saved mapping rules.

Edit
Name

Delete

Selecting NEXT will take you to the Stock Catalog Preview. This preview will display all of the mapped columns
and the data.
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Selecting Import All will start the importing process. Next you will see the Stock Import Results form. This report
only displays some of the basic information and not all of the column data.

You will be notified when the process is complete. If you have other imports you can select Start Over and you
will be taken back to the first screen.
Any changes made in the HTML version can also be seen in the Legacy version. To view the changes in Legacy
go to Pricing > Stock Definitions.

Export Report
There is a new report on the HTML side named EFI_Stock Definition Export V1.rpt which includes all the fields.
You can export the appropriate report, make changes and then use that report to upload your changes. It is
important that you use the Stock Definition Export V1 report only for updating the HTML version and the EFI
Stock Definition Export report for the Legacy version. Using the wrong format will corrupt your data.

If the report is not visible in the Custom list
1.

Go to Reports > Report Manager > Custom.
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2.

Select Add and you will see a list of available custom reports

3.
4.

Select the report you want
Click on the Select button and the report will be added to the list
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Stock Definition
You manage the information about your stocks and substrates in the Stock Definitions window. To open this
window, click Stock Definitions in the QuickAccess panel (or select Pricing > Stock Definitions.) The Stock
List window opens first. When you select a specific stock the Stock Definitions window will open.

Stock List Window
Selecting Stock Definition will take you to the Stock List. The first time you open Stock Definition the column
headers displayed will be the same as you found in the Legacy version. Those can be found in the Legacy
version > Preferences > Estimator > Stock Definitions. Those headers checked in that table will be the ones used
in the HTML version.

You can use the Customize List option to make changes in column headers.

In addition, you can enable or disable the status icons, Inventory, Stock Expiry and Price Expiry.
•

Inventory lets you know if the stock that is kept in inventory. This is identified on the Inventory tab for
each individual stock. There are two colors for this icon. If the Icon is Green then the available status of
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the stock is positive and if it is Red then the available quantity is negative. This mean that while the
stock is an inventory stock there is more stock allocated to jobs than there is stock on hand in inventory.

•

Stock Expiry is the date that the stock will expire. It is also identified on the Inventory tab.

•

Price Expiry is the date the price for the stock will expire. It is set up on the Pricing tab.

If the icon is grayed out then hovering over it will display a message that it is not applicable for this stock.

A fourth icon will show when the stock is registered with MDSF.

All of the standard filtering and sorting is available on the stock list. In addition, you also have advanced search.
You can also use the toggle buttons to view only inventory stock, MDSF Registered or MDSF Non Registered
stock.
Create stock will take you to the Stock Definition tabs. You must enter a stock name before saving the new entry.
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Advanced Search is used to find a list of stocks based on the entered criteria. You can search by size, weight,
CWT, price, Quantity on hand or Roll width. Enter the information for the range of stocks you want to display and
then select the Apply & Search button. Select Clear All to start a new search. You can use the check boxes to
select “Show Shell Account: All”
Or Show Special Stocks not on the list.

You can also sort by Stock Method using the dropdown.

The three-dot ellipsis allows you to Edit Stock, Duplicate Stock, Sync with MDSF or Delete Stock. When you
duplicate stock the new stock name will be as the original but with the word COPY appended to the end of the
name. You can save as is or you can edit the new stock and then save.
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You can check the box to the left of the ellipsis of multiple stocks if you need to perform the same function on
multiple stocks. The options available or Sync with MDSF, Unregister with MDSF or Delete Stocks.

For more information on Sync or unregister with MDSF see page 220
Note

After sync with MDSF you will need to manually refresh the screen.

Clicking on the stock name will take you to the stock definition page where you can view and edit the information
about that stock.

Stock Definition Window
The Stock Definitions window has general information about the stock and then four standard tabs
(Specification and Pricing, Pricing, Definition and Inventory).
Note
If PrintSmith Vision is integrated with the Fiery, a Fiery Paper Catalog tab is available. (For
information, see the PrintSmith Vision - Fiery Integration Guide.) If PrintSmith Vision is integrated with Market
Direct StoreFront, a Web tab is available.

This shows thee basic information about the stock and this is displayed regardless of the tab you are viewing.
First enter the general information about the stock:
1.

In the Name field, enter a description of the stock. Limit the name to a description since there are
separate fields for weight, color, finish, and size.

2.

In the Group field, select a group for the stock, for example, Paper or Envelopes.

3.

Select from the drop down the appropriate Stock Method.

4.

Check the Metric box to use the metric system for measurements. When the Metric check box is
selected, the M weight and basic seize fields are removed from the stock definition and the thickness
measurement is changed to microns (one millionth of a meter).

Note
The items in each drop-down list come from tables in the Legacy version. If you enter something
else in the field you will get a message asking if you want to add the new value to the table.
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Specification Tab

Some of the fields will change depending on if the Metric check box is checked. These changes will be discussed for
each tab.
1.
2.

In the Stock Definitions window, click the Specification tab.
In the Vendor field, select the vendor of the stock. If you purchase the same stock from multiple
vendors, create a stock definition for each vendor. (Use Table Editor to maintain your vendors in the
Vendor table.)
3. In the Stock # field, enter the part number used to order this stock from the vendor.
4. In the Class Field use the dropdown to select the appropriate class.
5. In the Weight field, enter the basic weight of a stock. This field is used to calculate the M Weight and
Carton Weight of the stock (on the Specification and Pricing tab as described below). If the weight is
part of the stock name, EFI recommends removing it from the name and entering it only in this field. If
you are using Metric then this field is labeled GSM and you would enter that information.
6. In the Stock Type field, select a category of paper from the dropdown, for example, Business Papers
or Book Papers. In non-metric stocks, this information is critical because it determines the Basic Size
that is displayed. This size is used to calculate both the M weight and the CWT price. (Stock types are
stored in the Basic Sizes table. Generally, you should not modify this table unless you are certain of the
changes you are making. This table already includes all the common stock types and associated sizes.)
7. For non-metric stock you will see Basic Size. It is not editable but displays the basic size based on the
stock type selected. This field is not visible for Metric stock.
8. In the Parent Size field, enter the size of the stock you purchased from the vendor. You can separate
two numbers by /, for example, 17/28, and this is automatically displayed as 17 x 28.
9. In the Normal Run Size field, specify the most common run size when you create a job using this stock
definition. The number of sheets that can be cut out of the selected parent sheet is then automatically
calculated. If you do not specify a run size, the system assumes it is the same size as the parent size.
10. In the Color field, enter or select the color of the stock. This should be the full “mill” color. For example,
if the mill color of white paper is Avon Brilliant, enter that in the Color field rather than just White. If
you enter a color that is not in the Stock Colors table, you are asked whether you want to add it. (Use
Table Editor to maintain colors in the Stock Colors table.
11. If necessary, select a color in the Generic Color field. (For more information about generic colors.
When you enter or select a color in the Color field, PrintSmith Vision looks for a matching generic color
in the Stock Colors table. For example, Avon Brilliant has a generic color of White. If PrintSmith Vision
does not find a generic color, it asks you to select one, and then updates both the Stock Colors table
and the stock definition with your selection.
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12. In the Finish field, select a texture such as Linen or Laid. (Use Table Editor to maintain these finishes
in the Stock Finish table.
13. In the Grade field, select the brightness of the stock, for example, #1 Coated, #1, #2, #3, and so on.
(Use Table Editor to maintain grades in the Stock Grade table.)
14. Enter the Thickness of the stock and select a unit of measurement: Caliper, Points, Mils, Thous,
Plies, Microns, or Millimeters. Microns and millimeters are used for metric stocks while the other types
of units are interchangeable and are used for certain types of stocks as follows:
Caliper

Caliper is the thickness of a paper measured in thousandths
of an inch, traditionally applied to most printing papers which
are between 0.001 and 0.008 inch thick.

Microns

A micron is one millionth of a meter and is a unit of thickness
for metric stocks.

Points

One point is the equivalent of 0.001 inch, traditionally used to
indicate heavy card stock such as coated covers. For
example, 12 point cover is 0.012 inch thick (12 points x
0.001inches).

Thous

One thou is equal to 1/1000th of an inch.

Mils

One mil is equal to one thou.

Plies

Plies are traditionally used to indicate the thickness of card
or chipboard. A sheet of 6-ply board is 0.024 inch thick.
(Multiply the ply value by 3 and add 6 to that result.)

Millimeters

A millimeter is one thousandth of a meter and is a unit of
thickness for metric stocks.

M weight is displayed and calculated from the basic size, parent size and weight.
15. In the Coated field, select None if the stock is not coated and if it is coasted select 1 side or 2 sides.
16. In the Sheets/Carton field, enter the number of sheets of the parent size in a single carton. You can
also use this field to specify the number of parent sheets in a skid.

17. In the Min. Order field, if stock can be ordered in any quantity, enter 1. If the stock has a minimum
order, such as a ream that can only be ordered in sets of 500, enter this quantity. For example, enter
500 for a ream. This ensures that the stock order and job ticket correctly reflect the amount of stock to
be ordered. In addition, it allows you to pass on to your customer the cost for ordering more stock than
needed for a job.
For example, if a job requires 200 sheets and the minimum order for the stock is 250, the customer is
charged for purchasing 250 sheets. Although the number of sheets purchased is greater than needed
for the job, the production charges are based on the number of sheets used in the job, not the full
quantity purchased.
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18. Select the Charge Customer for Entire Order check box to add the cost of the entire stock order to the
stock charge for the job. This cost is marked up in the usual manner, but the additional sheets are not
included in the charge for printing or copying. For example, if the minimum purchase is 250 sheets, the
stock cost reflects this.
19. In the Cut/100 field, enter the cut charge for each 100 parent sheets. This charge is added to the stock
cost and is useful when the vendor charges for cutting parent sheets to the size you entered in the
Parent Size field on the Specification and Pricing tab. The cut charge includes estimated waste and
is added to the cost of the stock after the stock is marked up. The cut charge itself is not marked up.
Tip
For best results, add a pre press cutting charge to the stock definition instead of using the
Cut/100 field; a charge more effectively calculates the number of cuts and lifts that are needed.
20. In the Min. Cut Chg field, enter a minimum charge for cutting. (Use this in conjunction with the Cut/100
field.) If no cutting charge is specified, the minimum is added to the stock for all quantities.
21. In the Forest Management field, select the type of forest management used for this stock: FSC Mixed,
FSC Pure, Green Seal Certified, or SFI Participant. (These selections are defined in the Stock Forest
Management table, which you can edit with Table Editor.)
22. In the PCW Recycled % field, enter the percentage of recycled post consumer waste in the stock.
23. Select the check boxes for the type of certification the stock has received: FSC Certified, SFI Certified,
and/or Green Seal Certified.
Tip
You can set preferences to specify what kind of chain of custody information is included on your job
tickets and invoices.

Pricing Tab
Use the Pricing Options tab in the Stock Definitions window to specify the pricing for the stock when it is used in
jobs. Some fields on the Pricing Options tab apply to all types of stock; others depend on the type of stock you
are adding, for example, sheet stock versus roll stock. The procedures that follow explain what different types of
stock require.
The pricing tab is the same for Metric and non-metric stocks.

1.

Under Pricing for Blank Sheets,
a. Blank sheet pricing is used for jobs based on the Blank method. The pricing is automatically
calculated and is based on the blank stock markup in your Stocks and Sizes preferences and
the cost of the stock as specified on the Specification and Pricing tab (in the Cost row under
Qty. Adjustments). If necessary, change these prices and/or the quantities.
b. Select the Auto Calculate Blank Stock check box to ensure that blank stock pricing is
automatically updated if costs change. If you do not want prices calculated automatically, clear
this check box.
Note
EFI recommends that you select the Auto Calculate Blank Stock check box unless you
have very specific pricing targets for blank stock that do not depend on the stock cost.

2.

Under Qty. Adjustments, provide a “price table” for the substrate with costs and markups for
various quantities:
a.

b.

In the Qty. breaks row in the table, enter the maximum quantity of parent sheets for each
column in the price table. For example, if you enter 1000, 2000, and 3000 in the first three
columns, the first column is used for the stock cost and markup for quantities up to and
including 1000. The second column is used for quantities from 1001 to 2000. The third column
is used for quantities greater than 2000. If a column does not include a quantity, the system
assumes you are not using that column.
In the Cost row, enter your costs for a particular quantity in the Qty. Breaks row, taking into
account the costing unit you specified in step 5a.
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c.

d.

e.

In the CWT (Hundred Weight Price) row, enter the cost for 100 pounds of paper regardless of
size. CWT pricing is a convenient way to compare paper prices for different stocks in different
sizes. Although there is some variation within a given stock family for different size stocks, the
CWT price is generally similar. You can enter a cost in either a CWT field or a Cost field, and
the other field is calculated provided there is sufficient information available in the stock
definition to make the calculation. (In order to calculate the CWT price, the Basic Size and
Weight must be entered and be correct. The Basic Size is controlled by the Stock Type you
selected.)
In the Markup row, enter the amount to mark up the stock above your cost. If the markup in
the first column is not overridden (overrides are shown in underlined italic), this is the standard
stock markup defined in your Stocks and Sizes preferences.
Normally you do not need to alter the standard stock markup in the first column. Only change it
if you want a particular stock to be marked up differently from the standard stock markup you
specified in your Stocks and Sizes preferences. Enter a markup rate in columns 2 through 6
when the markup you want to use is different from that in the first column. Leave the markup
fields empty across the row unless the rates in columns 2 through 6 are different from the first.

Note If you change the standard stock markup in your Stocks and Sizes preferences, you will change the
markup for all stock definitions except those which you overrode.
f.

In the List/M row, enter an additional price per thousand sheets to use with the list job pricing
method because list pricing does not factor in the stock cost when generating a price. The
amount (plus or minus) entered in this field is divided by 1000 and multiplied by the quantity
ordered and added to the price of the job. For information about jobs based on the list price
method, see page 68.
For example, a price schedule is used for a stock that costs $10.00 per thousand. You want to
use it for a stock that costs $11.00 per thousand. If you enter 1.00 in the List/M field, $1.00 is
added to each thousand ordered.

3.

4.

In the # Sheets/Set field, enter the number of sheets that make up a “set” of the stock. For
example, if you have a 3-part carbonless stock, enter 3 in this field. The system can then
automatically make the correct calculations based on the number of sheets in a set.
In the Price Expires field, enter an expiration date for the price if necessary. This information may
be automatically provided when you import stock prices from a stock vendor. The date tells you
whether the price shown in the stock definition is valid. If the price has expired, you receive a
warning message that the price has expired, but you can still use the stock.

Definition Tab
The definition tab is the same for both metric and non-metric stocks.
1.
2.

In the field Select Press for Printing, select the press you want to use with the stock. If you do not
want a preset press for the stock, select <use default press>.
When you select a stock for a job, and the stock has a preset press, the press is assigned to the job,
along with any charges that are part of the press definition. If you select a stock definition without a
preset press, the default press definition is used for the job.

Note
PrintSmith Vision is designed so that you can use press definitions to define your production
environments. If you know a stock is always used in a particular production environment, you can create a
press definition and preset the press for each stock definition to which it applies. Envelopes are a good
example of stock that requires a particular production environment.
3.

Use the dropdown Select Schedule to choose the list price schedule you want to use for the stock. List
price schedules apply only to jobs based on the List method. You create the schedules using Pricing >
List Price Schedules. (For information about list price schedules and jobs based on them, see
“Creating a list-based job” on page 68.)
When a price schedule is assigned to a stock, its name is displayed to the right of the Select Schedule
button. To remove an assigned schedule, click Select Schedule and then click Clear when the
schedule list is displayed.
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4.

Under Adjust Digital Matrix and Select Default,
a. In the field to the right of B&W, enter the amount to add to the digital matrix price of the
selected stock if the Stock Price is field in the Digital Definitions window is set to from Copier 1
in Stock Definition. To preset a B&W digital definition for the stock, select it instead of <use
default digital>.
b. In the field to the right of Color, enter the amount to add to the digital matrix price of the
selected stock if the Stock Price is field in the Digital Definitions window is set to from Copier 2
in Stock Definition. To preset a color digital definition for the stock, select it instead of <use
default digital>.
c. In the field to the right of Large Format, enter the amount to add to the square area of the
digital matrix unit price for the selected stock if the Stock Price is field in the Digital Definitions
window is set to from Copier 3 in Stock Definition. To preset a large format digital definition for
the stock, select it instead of <use default digital>.

Note
When a stock with a preset digital definition is selected for a job, this digital definition is used for the
job, along with any charges that are attached to the digital definition.
To remove a preset digital definition, select <use default digital>.
5.

In the Comment field, enter any other notes about the stock.

Inventory Tab
The inventory tab is the same for both metric and not-metric stocks.
1.
2.
3.

Select the Stock is Standard Inventory Item check box to activate the fields on the Inventory tab.
In the Stock on Hand field, enter the amount of stock that is currently in inventory. (For large format
stock, this is the length, not the total area.)
If some stock is already committed to current jobs, enter the amount in the Committed field. Normally,
committed stock is automatically calculated. As stock is selected and assigned to a job, the number in
the Committed field increases.

Note
Stock that was selected for a job before the stock was defined as a standard inventory item is not
included in the committed inventory count.
As the system tracks committed stock, it shows the difference between what is on hand and what is
committed in the Available field. You cannot edit this field. You can also see inventory activity under
Inventory History.
4.

If you are just starting out, in the On Order field, enter the amount of stock that is currently ordered.
After that, as you record your orders with PrintSmith Vision with Admin > Order Stock the amount is
entered for you automatically.
5. In the Target Level field, enter the amount of stock you always want to keep in inventory.
6. In the Reorder Point field, enter the “trigger-point” at which new stock should be ordered.
7. In the Min. Order Qty. field, enter the minimum amount that can be ordered at one time. If the amount
that is ordered should always be in even quantities, select the Even increments, like ream size check
box.
8. In the Stock Expires field, enter the expiration date of the stock, if applicable. When the field is blank,
the stock never expires.
9. If applicable, in the Bin Location field, enter an identifier for the place where the stock is stored.
10. If the stock is a shell item (for example, business card masters that are imprinted at a later date), select
the Shell Item check box.
11. If the stock is for a specific customer, click Assign Customer Account and select an account.

Defining rigid substrates on the Specification and Pricing tab
In addition to completing the fields on the Specification and Pricing tab described previously, for rigid
substrates do the following:
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1. In the Stock Type field, select a category of substrate, typically, Business Papers.
2. In the Parent Size field, enter the size of the substrate you purchased from the vendor. You can separate
two numbers by /, for example, 48/96, and this is automatically displayed as 48 x 96.
3. In the Min. Order (area) field, if the substrate can be ordered in any size, enter 1. Otherwise, enter the
minimum size in square units that you will sell at one time, for example, 864 for a 24 x 36 sheet.
4. Under Qty. Adjustments, provide a “price table” for the substrate with costs and markups for various
quantities:
a. In the Costing Units field, enter the square area by which you are costing, for example, 864
inches for a substrate that is 24 inches by 36 inches.
b. In the Qty. Breaks row in the table, enter the maximum amounts for costing and markup
purposes. For example, if you enter 1000, 2000, and 3000 in the first three columns, the first
column is used for the stock cost and markup for quantities up to and including 1000. The second
column is used for quantities from 1001 to 2000. The third column is used for quantities greater
than 2000. If a column does not include a quantity, the system assumes you are not using that
column.
c. In the Cost row, enter your costs for a particular quantity in the Qty. Breaks row, taking into
account the costing unit you specified in step 3a.
d. In the Markup row, enter the amount to mark up the substrate above your cost.
e. In the Price Expires field, enter an expiration date. as described in step 4 under the Pricing tab
on page 251.

Defining roll stock on the Specification and Pricing tab
In addition to completing the fields on the Specification and Pricing tab described previously, for roll stock do
the following:
1. In the Roll Width field, enter the width of the entire roll you purchased from the vendor.
2. In the Roll Weight field, enter the weight of an entire roll. After you enter the minimum weight of a roll you
will sell in the Min. Order (weight) field, PrintSmith Vision calculates the minimum number of rolls this
represents and displays it in the Rolls/Order field.
3. In the Min. Order (weight) field, if stock can be ordered in any quantity, enter 1. Otherwise, enter the
minimum weight of the roll stock that you will sell at one time.
4. Under Qty. Adjustments, provide a “price table” for the roll stock with costs and markups for various
quantities:
a. In the Costing Units field, enter the weight by which the roll stock is priced, for example, 100
pounds.
b. In the Weight Breaks row in the table, enter maximum weights for costing and markup
purposes. PrintSmith Vision uses this information for the stock cost and markup for weights up to
and including the weight you specify in each column.
c. In the Cost row, enter your costs for a particular quantity in the Weight Breaks row taking into
account the costing unit you specified in step 4a.
d. In the CWT (Hundred Weight Price) row, enter the cost for 100 pounds of paper regardless of
size. When you enter a cost in a CWT field, the corresponding Cost field is calculated for you
provided there is sufficient information available in the stock definition to make the calculation. (In
order to calculate the CWT price, the Basic Size and Weight must be entered and be correct. The
Basic Size is controlled by the Stock Type you selected.)
e. In the Markup row, enter the amount to mark up the stock above your cost. as
described previously.
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f. In the Price Expires field, enter an expiration date as described previously.

Defining large format stock on the Specification and Pricing tab
In addition to completing the fields on the Specification and Pricing tab described previously.
1. In the Roll Width field, enter the width of the entire roll you purchased from the vendor.
2. In the Min. Order (length) field, if the stock can be ordered in any length, enter 1. Otherwise, enter the
minimum length of the stock that you will sell.
3. Under Qty. Adjustments, provide a “price table” for the stock with costs and markups for various
quantities:
a. In the Costing Units field, enter the square area by which the stock is priced, for example, 144
inches.
b. In the Area Breaks row of the table, enter the maximum areas of the large format stock for costing and
markup purposes. PrintSmith Vision uses this information for the stock cost and markup for areas up to and
including the area you specify in each column.
c. In the Cost row, enter your costs for a particular area in the Area Breaks row, taking into account the
costing unit you specified in step 3a.
d. In the Markup row, enter the amount to mark up the stock above your cost. as described previously.
e. In the Price Expires field, enter an expiration date as described previously.

Fiery Paper Catalog Tab
The Fiery Paper Catalog tab is the same for both metric and non-metric stocks.
In addition to the automatic media mapping that the system performs when you add a Fiery device, individual
stocks in PrintSmith can be mapped to a media in the paper catalog on a particular Fiery device. If you have
multiple Fiery devices, you can quickly map the same stock to more than one Fiery.
1.

Click Stock Definitions in the QuickAccess panel (or select Pricing > Stock Definitions).

2.

In the Stock List window, select the stock you want to map to media in a Fiery catalog.

3.

Click the Fiery Paper Catalog tab.

Remove
mapping from
this device

View all
mapped
items

Remove
Mapping from
all devices

4.

From the dropdown select the Fiery Device on which you plan to use this stock. (This is the physical
equipment itself as defined in the Production Copiers table in PrintSmith Vision

5.

Under Paper Catalog, select the media to which you want to map the PrintSmith Vision stock by
clicking on the radio button.
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The stock name will show next to the Fiery Device and you can also hover over the mapped item area
and the mapped stock will be displayed.
Note

You can use all of the column headers to filter the list of displayed items.

6.

If you have multiple Fiery devices, repeat steps 5 and 6 to map the current stock definition to a stock in
the paper catalog on a different Fiery device. (You can have different mappings on different devices.)

7.

Click Save on the toolbar of the Stock Definitions window.

To remove the mapping from the selected Fiery device use the remove mapping button to the left of the fiery
device that also shows the mapped material.
If you have mapped to multiple Fiery devices and want to remove the mapping from all of the devices use
the Remove All Mapping button on the right of the screen.

Tip
Always click Synchronize Media after you make a
change in PrintSmith Vision that may affect mapping.

The Show All button on the right of the screen is turned off by default. When it is off only unmapped stocks will
be displayed. If you slide it on then all stocks for that device will be displayed, mapped and unmapped.
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Web Tab
Register Stocks in Market Direct StoreFront
You can fully control the stocks that are available to buyers when they are placing orders in Market Direct
StoreFront. You should always define stocks in PrintSmith Vision and send information about them to Market
Direct StoreFront. As with accounts and contacts, this process is known as registering stocks. In Market Direct
StoreFront, stocks are known as media.
Note

Market Direct StoreFront comes with some pre-defined media. Typically, you should delete the media
before registering the stocks from PrintSmith Vision so the only media in Market Direct StoreFront are
mapped to stocks in PrintSmith Vision.

The registered stocks must then be priced in Market Direct StoreFront – which always controls the pricing. (You
should still price stocks in PrintSmith for non-Market Direct StoreFront orders, but this pricing is ignored for
Market Direct StoreFront orders.)
With the exception of pricing, information about stocks is always controlled from PrintSmith Vision – the
information is sent from PrintSmith Vision to Market Direct StoreFront. Information about stocks (known as media
in Market Direct StoreFront) is never sent from Market Direct StoreFront to PrintSmith Vision. For example, if you
create media in Market Direct StoreFront, no corresponding stock is created in PrintSmith Vision. Likewise if you
update media in Market Direct StoreFront, the corresponding stock definition is not updated in PrintSmith Vision.
As a result, avoid creating or updating media in Market Direct StoreFront.
When stocks are registered, PrintSmith Vision sends the name, size, and color of the stock to Market Direct
StoreFront.
When a Market Direct StoreFront order comes into PrintSmith Vision and includes a registered stock, the stock is
“recognized.” For example, costing information is available. In addition, with the exception of stock for special
pages, if the stock is inventoried, inventory is adjusted.
You can register (send) stocks in two ways:
Register multiple stocks at the same time.
Register stocks individually.
Important

For stock to be registered in Market Direct StoreFront, the stock definition must include a
Thickness (on the Specification and Pricing tab) and a Normal Run Size (on the Pricing tab) in
the Stock Definitions window.

Method 1: Register multiple stocks at a time
You can register multiple stocks at a time from the Stock List window.
1.

In PrintSmith Vision, click Stock Definitions in the QuickAccess panel (or select Pricing > Stock
Definitions).

2.

Select the check boxes of the stocks you want to register.

3.

If you select a stock with a needed missing detail you will get an error message. Edit the stock to
include the missing information. (You cannot register the stock without this.)
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Hovering the mouse over the orange exclamation point will show you the information that is missing and
required.

Note
When you are using Metric stock and enter the weight in the Specification tab you enter it as gsm
and the weight will be shown as gsm in the Web tab. But if you are not using Metric you enter weight in the
Specification tab as pounds but it will not display as pounds in the Web tab. You have to manually enter the
weight for non-metric stock on the Web tab. That field accepts both gsm and pounds.

4.

Click Sync with MDSF.

5.

A message informs you that registration has started.

A New icon will also indicate that the registration is in process.

After the stocks are registered, a green check mark is displayed in the MDSF column in the Stock List
window.
The Registered icon will be displayed when the registration is complete.

6.
Note

In Market Direct StoreFront, the stocks are now listed in the Media Catalog. Price the media in Market
Direct StoreFront and add it to ticket templates. See page 223.
Very occasionally a stock may not be registered (perhaps due to a network issue). For information
about resetting the item so you can re-send it, see “Error! Reference source not found.” on page
Error! Bookmark not defined.

Method 2: Register one stock at a time
You can also register stocks as media in Market Direct StoreFront one at a time from the Stock List or the Stock
Definitions window.
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From the Stock Definition Window
1.

In PrintSmith Vision, click Stock Definitions in the QuickAccess panel (or select Pricing > Stock
Definitions).

2.

In the Stock List window, find and select the stock you want to register in Market Direct StoreFront, and
click that stock. The stock definition window for that stock will open.

3.

In the Stock Definitions window, click the Web tab.

4.

Under MDSF Info, click Register Stock.

5.

A message informs you that registration has started. Click OK.

After the stock is registered, the Last Registration Date is updated and the Register Stock button
changes to Update Stock.

In addition, the Registered stock icon will be displayed next to the Stock List window.
6.
Note

In Market Direct StoreFront, the stock is now listed in the media catalog. Price the media in Market
Direct StoreFront and add it to ticket templates. See below.
Very occasionally a stock may not be registered (perhaps due to a network issue). For information
about resetting the item so you can re-send it, see “Error! Reference source not found.” on page
Error! Bookmark not defined..
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From the Stock List select Sync with MDSF

The rest of the process follows the same as in the Stock Definition window.

Price media and add to ticket templates
After you register stocks as media in Market Direct StoreFront, they are listed in the Market Direct StoreFront
media catalog. (PrintSmith Vision sends the name of the stock, its size, and its color to Market Direct
StoreFront.)
Note

If you did not delete the pre-supplied media in Market Direct StoreFront, you can recognize your
registered stocks in the Market Direct StoreFront media catalog by their ID – they will all have an ID
numbered in the hundred thousands, for example, 100009 or 100014.

You must now price the media in Market Direct StoreFront and add media to ticket templates.
The price you set for the media is what buyers pay, and this price overrides the price of the associated stock
defined in PrintSmith Vision.
In Market Direct StoreFront, the recommended way to price media is by editing a price sheet (although you can
price media individually). Go to Administration > Pricing, open a price sheet, select Media in the View By
field, and then edit a group of related media to add prices. For information about price sheets in Market Direct
StoreFront, see the online Help in Market Direct StoreFront when on the Administration tab.
Tip

Click

to open Help in Market Direct StoreFront.

After your media is priced, you can add selected media to your ticket templates. When a ticket template is
associated with a product in Market Direct StoreFront, buyers ordering that product will be able to choose the
media specified in the ticket template. For information about creating ticket templates and products, see the
online Help in Market Direct StoreFront when on the Administration tab.

Updating stocks
If you change some information about a stock in PrintSmith Vision, you can update the corresponding media in
Market Direct StoreFront.
Important

With the exception of pricing, never edit mapped media in Market Direct StoreFront because that
information is not sent to PrintSmith Vision. Stocks must always be managed from PrintSmith
Vision.

1.

After you make changes to a stock in PrintSmith Vision, click the Web tab in the Stock Definitions
window.

2.

Under MDSF Info, click Update Stock.
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Unregistering stocks
If you want to delete a particular media in Market Direct StoreFront, you must unregister the stock definition in
PrintSmith Vision. The stock definition will still exist in PrintSmith Vision, but the corresponding media will be
deleted in Market Direct StoreFront.
When you unregister stock, it is no longer available as a selection to buyers placing orders in Market Direct
StoreFront.
Important

Never delete a mapped media in Market Direct StoreFront (one that you registered from PrintSmith
Vision) because that information is not sent to PrintSmith Vision. Media (meaning stocks) must
always be unregistered in PrintSmith Vision so they are deleted in Market Direct StoreFront.

You can unregister stocks either from the Stock List window or the Stock Definitions window.

To unregister stocks from the Stock List window
1.

In PrintSmith Vision, click Stock Definitions in the QuickAccess panel.

2.

In the Stock List window, select the check boxes of registered stocks (ones with green icon next to the
stock.

3.

Click Unregister Stock from MDSF.

To unregister a stock from the Stock Definitions window
1.

In PrintSmith Vision, click Stock Definitions in the QuickAccess panel.

2.

From the Stock List window, open the registered stock definition you want to unregister. (These stock
definitions have a green icon next to the stock).

3.

In the Stock Definitions window, click the Web tab.

4.

Under MDSF Info, click Unregister Stock.

